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Welcome!
If you’ve made it this far, you’re 

clearly among the growing 

number of people who are curious 

about Linux. I’m not sure what has 

led you here – perhaps you’re sick 

of installing security updates every 

other day, perhaps you’re tired of 

rebooting when your computer runs 

slowly, or maybe you’ve just had 

enough of the Blue Screen of Death 

– but whatever it was that brought 

you here, I’m glad to welcome you to 

the family of Linux users, and hope 

you’ll fi nd that there’s a whole new world of computing here that can really 

put the fun back into it all again.

This magazine is a one-off publication aimed at newcomers to Linux. 

That’s you, which means you’ve come to the right place! But Linux is a 

big world of software, and, while some of it looks and works just like the 

Windows or Mac software you’re used to, a lot of it will also be new, and 

that’s where this guide comes in – we’ve written it to be a comprehensive 

pack for new starters to Linux, with the goal of helping you to get the 

most from your computer with the least reading. You’ll also fi nd a DVD 

bundled with this magazine that includes a complete, installable version 

of Linux for you to use. Yes, it’s true that there are lots of versions of Linux 

out there, but we’ve written this guide to accompany the software on that 

DVD, so if you want to get the most from all the tutorials we’ve provided 

for you, we recommend you use that disc to get started.

Now it’s time for the adventure to begin. If you want to dive in straight 

away, turn to p10 for our install guide. If you’d like to read a bit more about 

Linux fi rst – and I’d recommend it! – turn to p6.

Have fun!

Paul Hudson Editor
  paul.hudson@futurenet.co.uk
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Welcome to Linux

Welcome to Linux!
Step 1: Buy this magazine. Step 2: ??? Step 3: Profit! Now, let’s see if I can give 
you a little more detail about step 2…

S
witching to Linux doesn’t 

have to be hard. In fact, we 

want to make sure it’s as 

easy for you as possible, and 

you’ll be glad to hear that you’ve 

already completed one of the hardest 

steps just by obtaining this magazine.

I’m sure you have lots of questions, 

but before we get to them I first want to 

tell you a little bit about Linux.

1  Linux is free!
That’s right – Linux is completely free! You 

can take the DVD that came with this 

magazine, copy it a thousand times, and 

give it to everyone you meet if you want to. 

You can even pop your own logo on the 

front and sell it if you really want to, because everything really is 

completely free.

2  Linux looks and works a lot like 
Windows
Scaremongers like to say that Linux is really hard, that your 

Windows skills will be useless, that you’ll get stuck and won’t be 

able to find any help or that Linux just doesn’t have the same 

features as something like Windows Vista. But I can assure you 

they are wrong: while Microsoft Windows certainly has the lead in 

terms of market share by a large margin, it certainly isn’t the best 

operating system out there. After all, if popularity alone made 

something good, McDonalds would be the best food on the planet! 

Not only does Linux match Windows feature for feature, it also 

has much lower system requirements. As anyone who has run 

Vista on 1GB of RAM or less will tell you, Windows can be pretty 

memory-intensive. Linux, on the other hand, runs comfortably on 

512MB or even less – there are even special versions of Linux 

designed to run on 32MB of RAM using CPUs that haven’t been 

considered top of the line since the late 90s! 

Of course, if you want the very best that Linux has to offer, you 

should consider 512MB of RAM and an 800MHz CPU the 

minimum. With that, you should be able to enable all the features 

and have a great computing experience.

3  Linux has lots of software ready for 
you to try
Sometimes the hardest part of switching to a different operating 

system is figuring out which programs to use. For example, 

Microsoft Office runs just fine on Windows, but Microsoft doesn’t 

make a version for Linux – hardly a surprise, as you can imagine! 

The same goes for Microsoft’s Internet Explorer web browser. 

When you switch to Linux, you can choose either to leave those 

programs behind and use their Linux equivalents, or you can try 

to run them using a special Windows compatibility layer known 

as ‘Wine’.

If I were you, I wouldn’t worry too much about Wine for now, 

because there are tens of thousands of programs available on 

Linux, and nearly all of them are completely free just like the rest of 

Linux! What’s more, you may be familiar with some of them 

already because they run on Windows as well as Linux – Firefox, 

OpenOffice.org, Thunderbird, Gimp and many more run on 

Windows and Linux, and if you’ve used them before you’ll find that 

they work just the same on Linux.

The best bit about all this is that all this software lives in a 

software repository that you can access from your Linux desktop. 

It will show you all the software you can install, and you just choose 

the applications and packages you want to have them 

automatically downloaded for you.

Linux is designed to have security at the very centre of the 

system, which is why it’s so popular for servers.

 Looking for 

special effects? 

Linux is just what 

you’re after.
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4  Linux is secure by default
Unlike on Windows, where installing programs can lead to ‘DLL 

Hell’ and it’s easy for your five-year-old to delete important system 

files just using Explorer, Linux was designed from the beginning for 

security. As a result, no one can install software if they don’t have 

the administrator password. No one can delete files that don’t 

belong to them. No one can spread spyware across the system 

just by surfing the web. In fact, unless you switch to the 

administrator account and go crazy, it’s pretty darn hard to break 

a Linux machine!

5  Linux is smart by default
If you get hit by a power cut and your computer shuts down 

unexpectedly, Linux is smart enough to auto-recover your files 

just where you left off – there’s no need to run checkdsk on Linux. 

Similarly, Linux is clever enough to re-arrange the files on your 

hard disk as you use them so that file fragmentation is a thing of 

the past.

The open nature of Linux also means that anyone, anywhere 

can join the development effort and help make things better for 

everyone, which means that you’ll find your software has been 

translated into hundreds upon hundreds of different languages, 

most of which aren’t supported by Microsoft simply because it 

isn’t commercially viable.

6  Linux is growing
Every year, more and more people are realising there’s no point 

paying for software when there are free programs that are just as 

good (and often better). This is particularly noticeable in big 

companies, where converting 1,000 computers from Windows to 

Linux saves a huge amount of money, but it’s also important for 

home users who would rather save their money and buy a new 

computer or are perhaps just sick of Microsoft software.

7  Linux has something for everyone
Whether you’re a programmer, a writer, a designer, a parent 

looking for something for their children or just someone looking to 

get the most from their computer, you’ll find Linux has lots of 

software ready for you to use. Forget ‘shareware’: if you want to do 

DTP, if you want to burn DVDs, if you want to scan for viruses, if 

you want to touch up your photos, if you want to rip music to MP3, 

or if you want to do any number of other things, you’ll find that 

Linux already has some great software ready to try. Don’t be afraid 

to click through the various programs that come installed by 

default – they are all safe to try, and it’s a great way to find your feet.

8  Linux looks great
If you think Vista looks hot, Linux is about to blow you away. As 

with Windows, you can customise the look and feel of your 

desktop – changing fonts, colours, screensavers and the like. But if 

you have the right hardware (and it doesn’t take much) you can 

also enable a true 3D environment that puts your desktop on a 

 You can download and install new software over the web using 

the Add/Remove Applications window.

 Games! Yes, 

Linux isn’t just for 

serious people: 

there’s lots to do 

when you want 

to relax…

Most people refer to ‘Linux’ to mean their 

entire computing desktop – the word 

processors, the games, the MP3 players 

and, well, everything! But technically, 

‘Linux’ is actually just the core part of the 

system: it looks after your hardware, runs 

programs, but generally stays out of the 

way. This is known as the kernel, because it 

really does sit at the centre of everything. 

Now, above Linux is just about 

everything else you’ll be using: OpenOffice.

org, Firefox, and such. But remember: the 

principle of Free Software is that anyone 

can take some programming code, modify 

it as they see fit, and release their own 

version. In fact, it’s very rare for Linux to 

have just one program for a particular 

need. For example, OpenOffice.org is a 

great office suite, but you could also use 

AbiWord, Gnumeric, KWord or any number 

of other similar products. And yes, they are 

all free, so you can try them and find which 

one solves your problem the best.

This need to be able to choose exactly 

what you run extends even further with the 

concept of a ‘distribution’, usually 

abbreviated to ‘distro’. There are hundreds 

– perhaps even thousands – of different 

Linux distros, and each one has something 

unique or unusual about it. For example, 

Ubuntu is designed to be very easy to use; 

Fedora is designed for power users; Gentoo 

is designed for people who want maximum 

speed; and so on. Each one will come with 

a different selection of software, so when 

you choose your distro you will usually pick 

the one that has the software you want as 

standard – although, of course, you can 

always change the software selection after 

installation!

Please don’t think that all this choice 

leads to a very fragmented Linux desktop, 

because it doesn’t: they all share the same 

Linux kernel, the same programming tools, 

the same desktop choices, and the same 

filesystem structure. As a result, much of 

what you learn about one distro applies to 

any other distro out there, because they 

are all building from the same common 

ground.

What is Linux? What is a distro?
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cube – windows can wobble, you can zoom in to get a closer look 

at things, switching programs will give you a live preview of what 

each window displays, and much more. In short, it looks absolutely 

fabulous, and is compatible with nearly all modern video cards

What’s in this magazine
This is a magazine aimed at helping you get things done with your 

computer. Yes, we’re focusing on Linux, but we don’t think you 

really care what you use, because what you really want is a 

computer that’s fast, featureful and full of cool things to try – the 

fact that it’s Linux that provides all those things and more is 

probably secondary! As a result, we’ve tried to focus on helping 

you get more from your computer. 

So, in this magazine you’ll find:

1  How to install Linux
2  How to find your way around
3   How to customise system settings to get things just the 

way you want them
4   How to find common programs such as web browsers, 

email clients and more
5   How to create brochures, spreadsheets and simple 

databases
6   How to touch up your photos and create original artwork
7   How to play games and chat to your friends

And there’s even a special troubleshooting section starting on 

p110, which can guide you through all the most common problems 

newcomers experience on Linux. In short, this is magazine 

dedicated to helping you succeed with Linux – we’ve written it to 

help you learn, to help you avoid problems, and to help you get the 

most from your computer.

What isn’t in this magazine
Now you know what is in this magazine, let me tell you what isn’t 

in here:

1  Boring theory
2  Useless facts
3  Geeky jargon

 Evolution is the standard email and calendaring system for Linux - turn to 

p26 to learn how to use it.

 Everyone has to work with digital photos on their computer sometimes, 

so you might as well use the best - p50 gets you started with The Gimp.

 By buying this 

magazine, you’ve 

actually already 

done the hardest 

thing when 

switching to Linux  Why pay for a DVD burner when you get one free with Linux?
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Linux is free of charge, which is more than enough to convince a 

lot of people to switch. But Linux is also “free” in the meaning of 

“freedom” – that’s why you can see the computer programming 

code behind it, modify it, and even sell it if you want to. We call this 

Free Software (note those capital letters!), and many Linux users 

consider it even more important than Linux’s lack of a price tag.

The Philosophy of Free

I’m a big believer in empowering people to do new 

things, not weighing them down with history. After 

all, you don’t need to know where Linux came from 

to get the most from it! But for the curious, here’s a 

little bit of background.

A long, long time ago, in a galaxy not too 

dissimilar from our own, most people who used 

computers were geeks. And they didn’t have their 

own computers, either – they shared one, known as 

a ‘mainframe’, because back then computers were 

far too expensive, bulky and unreliable to actually 

be personal. Back then, the primary operating 

system was known as Unix, and people passed 

around the source code freely, because it hadn’t 

even occurred to them that selling such software 

might be big business. 

But sooner or later the inevitable happened: some 

suits came along and decided to ‘monetise’ Unix. It 

split into various different brands (known as ‘forks’, 

because they all forked off the main Unix road), all 

competing with each other on features and price. 

Soon the various different Unixes (Unices? Unixen?) 

became incompatible in different places, and the 

whole software community became  fragmented.

Into this software melee stepped Microsoft, 

bringing with it the promise of one platform 

(Windows) from one vendor (Microsoft) for one 

price (not cheap). The fragmented Unixes never 

really stood a chance, because each of the vendors 

tried to fight Microsoft in their own way rather than 

banding together. Eventually, Windows was 

dominant, and things settled down again.

Linux started life as the pet project of Linus 

Torvalds, a university student in Helsinki. It was 

designed to copy the fundamentals of Unix, but had 

one special difference: it was licensed under the 

GNU General Public License. This is a special 

software licence that says, “if you take this software, 

you’re welcome to redistribute it, change it and sell 

it if you want to – as long as you give the changes 

back to the creator.” As a result, big computer 

companies such as IBM, Intel, HP and SGI were able 

to band together around a common platform – they 

could contribute features to the common pool 

without having to compete with each other.

Linux today is worked on by thousands of people 

from around the world, and is finding its way into 

everything from mobile phones to billion-dollar 

server rooms. Google, Amazon, Yahoo and many 

other big internet companies rely on Linux every 

day, and if it can handle their computing needs then 

your desktop ought to be a cinch!

The history bit

4  Scary programming
5  Command line horrors

You see, all those things work to confuse and misdirect first-timers 

with Linux, so we want to steer well clear of them. In fact, you’ll 

barely see any mention at all of the command line that Linux is so 

famous for, because we’re less interested in explaining what things 

are than actually explaining what you can do with them.

Where to go from here
This is the end of my short introduction, so the next step for you is 

to dive on into Linux by turning over the page and following our 

step-by-step install guide. If you have more questions, relax: we’ll 

try to answer them as you go. The important thing is that in your 

hands is all you need to get started – and have fun! – with Linux. 

Enjoy!  LXF

 Have fun with Linux - there are hundreds of games to install for free, 

many of which are suitable for young children.

 The Brasero CD burner is an advanced disc creation system - great for 

people who want more power!

 Linus Torvalds, creator of Linux. What a guy!
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Linux installing instructions

 Ubuntu Linux is 

simple to install – 

just follow our 

step-by-step guide, 

and you’ll be 

Linuxing in no time 

at all.

Y
ou’re just minutes away from a new journey in the 

world of computing. You’ve probably heard of Linux 

before picking up this magazine – and you may 

have heard some naysayers describe it as difficult 

to use. Far from it. Linux is simply a different operating system 

to Microsoft Windows and Mac OS X, with its own way of doing 

things, and enormous benefits:

1  Linux is free You don’t have to pay any money for it, and 

you can download it free of charge from the internet in various 

flavours (called distributions). You can share it with friends, 

family and colleagues.
2  Linux is reliable Google uses Linux on thousands of 

computers, a testament to its rock-solid foundations. It won’t 

randomly crash on you or get confused with bugs and glitches.
3  Linux is secure Forget spyware, viruses and pop-up adverts 

– your Linux PC will be safe from hackers. This is one of the 

reasons why it powers millions of server computers around 

the globe.

Accompanying this magazine you’ll find a DVD containing 

Ubuntu Linux 7.10, the most popular version of Linux. Let’s get 

ready to install it!

Preparation
Chances are that your PC is currently running Microsoft 

Windows. (If it isn’t, or you’re happy to devote your entire PC 

to Linux, you can skip this bit.) Fortunately, Linux will happily 

co-exist with Windows on your machine, so you can choose 

which operating system to boot when you start your PC. 

However, there’s one vital step before we get going: BACK UP 

YOUR DATA 

FIRST! It’s 

unlikely that you’ll 

encounter any 

problems, but it’s 

better to be safe than sorry!

Linux needs some space on your hard drive, so if your drive 

is currently full (or heading towards that point), you’ll need to 

clear some room. At a minimum, we recommend giving Linux 

10GB – but the more the merrier, especially when you start 

using it to store videos and music. So if your drive is nearly at 

bursting point, remove old applications and files to free up at 

least 10GB of space. We also recommend running the 

Windows Disk Defragmenter tool, to ensure that your hard 

drive is neatly organised.

Partitioning
Your hard drive is split into sections called partitions. If you’re 

running Windows, it will most likely reside in a single, large 

partition occupying the entire hard drive. Linux needs its 

own chunk of the drive – its own partition – to run in, and the 

installer helps us out with this. When you’re installing, you 

can choose to resize your Windows partition and make room 

for Linux, or (if you don’t want Linux at all), let Linux occupy 

the entire hard drive.

You’ll see this during the installation process (step 6). If 

you want to keep Windows, you can drag the slider across 

to free up room, and then the installer will create Linux 

partitions in the free space. Again, it’s best to give Linux at 

least 10GB of free space. If your hard drive is almost full, you 

won’t be able to drag the slider very far, so make 

space in Windows first!

Right, with those two things covered, we’re ready 

to go. Follow the steps and get ready to become a 

Linux user!

Start here
Your voyage to the land of Linux begins here: we’ll show you 
how to install it on to your PC and take your first steps. System requirements

At a minimum, your PC needs:

800MHz Pentium-compatible CPU

300MB of RAM

10GB hard drive space

Problems booting?
The DVD supplied with this magazine is bootable – 

that is, you can start your PC with the disc in your 

drive, and Linux will load up. Don’t worry, it won’t touch 

your hard drive until you choose to install it, so you can 

play around with Linux freely. However, if your PC 

doesn’t boot Linux but instead starts Windows as per 

usual, you will need to change some settings.

Restart your PC and, at the very first screen that 

comes up (the BIOS screen), look for a message that 

tells you which key to press for the ‘Setup’ or ‘BIOS’ 

screen. Normally this is Del, Esc, F1 or F2 – try pressing 

them if you don’t see a message. If nothing happens, 

consult your PC’s manual. When you reach the BIOS 

settings screen, look for the option to change the ‘boot 

order’, so that you can tell your PC to start from the 

DVD drive rather than the hard drive. Then save your 

settings and restart.
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Insert the DVD supplied with this magazine into your DVD drive, then 

restart your PC. You should see the screen shown above. If not, see the 

Problems Booting? box on the opposite page.

1

Step by step: Install Ubuntu Linux

 Linux will boot up, and you will see the desktop. You can now try out the 

supplied programs – it’s all running from the DVD. Double-click on 

‘Install’ on the desktop to start the installation process

2

The installer window will appear. Make sure you read the text at every 

step! You can select your language via the panel on the left-hand side, 

then click Forward to continue.

3
Next you’ll be asked to set your time zone. Click on the appropriate area 

of the world map to zoom in, then click on the dot for your nearest city. 

When you’re done,  click on Forward.

4

Now you can choose your keyboard layout. Select the language on the 

left, and then the exact layout on the right. You can test your selection in 

the box at the bottom before you click on Forward.

5
Next up is hard drive partitioning – making room for Linux. You can use 

your whole drive, or resize an existing Windows partition and skip to 

step 8. If you choose to partition manually, see step 7.

6
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If you choose to partition your hard drive manually (we recommend this 

for advanced users only), create a minimum 10GB root (/) partition 

with ext3 format, and a swap (virtual memory) partition of around 512MB.

7
Now create a login account for Linux. Enter your full name, then a 

username and password. Do not forget these, as you’ll need them very 

soon! Click on Forward when you’re fi nished here.

8

If you’re installing on a PC that already has Windows, you’ll be given the 

option of transferring some settings over to Linux. Otherwise you’ll go 

straight to this screen – check the settings and click on Install.

9
Ubuntu Linux will be copied to your hard drive. Depending on the speed 

of your machine, this can take between 10 minutes and an hour, so grab 

a cuppa while the installer does its job!

10

When the installer has fi nished, you’ll be prompted to reboot. Click on 

the Restart button and eject the DVD – otherwise your PC will boot back 

up from the DVD again.

11
After your PC has rebooted, Ubuntu will load (or give you the choice to 

start Windows if you also have that installed). Log in with the username 

and password you provided in step 8, and start exploring!

12
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I
f everything went swimmingly, by now you should be 

exploring the Linux desktop, trying out the included 

programs and getting familiar with the new environment. 

It’s very much self-explanatory – you can click on Applications 

at the top-left to start programs, click on System to change 

preferences and set up your hardware, and click the red 

button in the top-right to reboot or shut down your computer.

If you’ve encountered a problem, however, don’t panic. One 

of the most common problems relates to video card 

recognition: the operating system tries to detect the hardware 

in your machine, can’t recognise it, and leaves you in text 

mode. If this happens to you, reset your PC and choose the 

second option from the Ubuntu Linux boot menu (the one 

that says ‘safe graphics mode’). Now the operating system will 

use a failsafe video driver – one that isn’t as powerful as the 

normal drivers, but will still get you up and running.

Getting help
If you’re unsure about anything during the installation 

process, or if you’ve come across a problem that you’re not 

sure how to solve, you can get help at various places online. 

Because of the millions of combinations of PC hardware out 

there, it’s impossible to provide a definitive list of fixes for any 

operating system – so you need to state your problem clearly. 

www.ubuntuforums.org is one of the busiest Linux forums 

on the internet, with over 500,000 users helping one another 

out when problems arise. These forums are separated into 

distinct sections; at this stage you should post your message 

in the Installation & Upgrades section.

Ubuntu’s forums are very friendly and you’re likely to get 

a quick response, but there are a few guidelines to take note of 

before you post anything:

How to get help
Hopefully the installation process went smoothly, but if not, 
there’s plenty of help to hand if you know where to look. 

 www.ubuntu

forums.org is 

the best place 

to get help on 

Ubuntu Linux, 

with thousands of 

fellow users ready 

to assist.

Extras on your DVD
As you’ve seen, the DVD accompanying this magazine boots and 

installs Ubuntu Linux, and this is ideal for taking your first steps 

with Linux. We’ve included a couple of extras, though, so as you 

become more familiar with the operating system you can make 

use of them.

The first of these, found in the Extras folder on the DVD, is a 

64-bit ISO image of Ubuntu Linux 7.10. You can burn this to a 

CD-R and use it to install on 64-bit machines (ie PCs with 

AMD64 or Intel Core 2 processors) if you want a small 

performance boost. Note that there’s not a huge gain, though, 

and for most users we recommend sticking with the standard 

32-bit version, as bootable from our DVD, which runs happily on 

64-bit PCs. Also, the bootable version includes software such as 

Inkscape and Scribus – covered in later tutorials – which you’d 

otherwise have to download separately.

Our second distro is called SuperUbuntu, which is also in the 

Extras section. This is a special version of Ubuntu Linux 7.10 that 

includes a vast range of additional software, such as the KDE 

desktop and development tools. It’s overkill for your first forays 

into Linux, but later on, when you want to install Linux on other 

machines and minimise the amount of downloading required, 

burn it to a DVD-R and boot from it to install.

 Our special beefed-up version of Ubuntu, with extra 

programs and development tools, will be useful when you’re 

more familiar with Linux and want to take it further.

1  Be specific The more information, the better, but stay on 

topic. Just saying “It won’t boot” gets you nowhere – people 

need to know what error messages you see, what you’ve tried, 

what hardware you have etc.

2  Consider all options Even if someone suggests a fix that 

sounds unusual, it’s worth trying. For instance, someone may 

recommend unplugging your printer before booting, which will 

actually help if Linux is having trouble recognising it.

3  Be patient It’s frustrating when things don’t work, but bear 

in mind that the users on these forums are all doing it for the 

love of Linux and the community. They’re not being paid to 

help, so if you don’t get an immediate response (or someone 

asks questions), don’t get into flame wars.  LXF
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T
he first thing you’ll notice about your new Linux 

desktop is that it looks almost identical to the 

one you were able to use when the whole thing 

ran from CD. In fact, the only real difference 

between the two is that things will run much faster once 

Ubuntu is installed, because your hard drive is a lot faster 

than your DVD drive!

The best way to find your feet in Linux is just to use 

your mouse and have a click around. Don’t worry – Linux 

won’t let you damage your system by accident. In fact, 

Linux won’t let you do anything even remotely dangerous 

without first asking you to re-enter your password as a 

security measure. Use the big annotation below to help 

you get started.

Welcome to your 
Linux desktop!
Linux can be scary at first simply because it’s different. Let’s look around…

Get to know your Ubuntu desktop

The Applications menu 

stores links to all the 

programs you have 

installed, and will 

automatically be updated 

as you add new programs.

These are quick start menu icons for Firefox, Evolution and 

the system help. See our guide on p18) to add your own.

The Places and System 

menus help you navigate 

and configure your system. 

You’ll be asked to enter 

your password for some 

tasks, because they are for 

administrators only.

This is the window list panel, which 

shows all the windows that you have 

open. If you click on a window here, it will 

be brought to the front of the display.

At the top-right is the system tray, where all sorts of helpful 

icons live along with the clock – which, if you click it, folds 

out to show a calendar and any upcoming events too.

This is Nautilus, the file browser 

for Ubuntu Linux. You can learn 

more about Nautilus on p20.

This panel controls virtual desktops, 

which are akin to Spaces on Mac OS 

X Leopard. Your computer can have 

multiple virtual desktops, meaning 

that apps running on one desktop 

won’t be shown on the others.

This is the trash can – drag files 

here to delete them, but the files 

can be recovered from the trash 

can later if you change your mind.
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What’s on your desktop?
As with Windows and OS X, your desktop is a directory on your 

filesystem just like any other. By default it starts nice and clean 

– if the Ubuntu install disc is still in your drive, you’ll see it 

ready to use on the desktop. Otherwise, your desktop will be 

completely clean. If you’re like us, your nice clean desktop will 

soon get really messy, and end up being swept into a single 

‘Old’ folder, before the process repeats itself and you end up 

with files strewn everywhere!

A better solution is to be tidier, and if you look at the 

bottom-right of your screen you’ll see a little rubbish bin where 

you can drag files you no longer want. These aren’t deleted just 

yet, which means you can pull them back out if you change 

your mind later. Of course, if you’re particularly short on disk 

space you’ll want to delete them straight away – right click on 

the icon and choose ‘Empty The Deleted Items Folder’.

As with the Ubuntu install disc, any other media that gets 

plugged into your computer will appear as an icon on your 

desktop – that includes audio CDs, DVDs, or camera flash 

cards with photos on. In fact, you can plug your camera 

directly into your computer and import images into a photo 

album – it’s much more convenient than copying files across 

by hand!

Restarting and shutting down
Before you dive into the rest of the desktop, it’s important that 

you know how to turn the computer off – particularly if you’re 

on a train or if your dinner is ready! To see the various options, 

go to System > Quit from the menu at the top, and you’ll see 

seven options: 

 Log Out This logs you out of the system, but leaves the 

computer switched on. If you have multiple users in your 

household and the computer is left on all the time, this is 

the one you’ll use.

 Lock Screen This leaves you logged in, but stops anyone 

else from using the computer without first typing your 

password.

 Switch User This leaves you logged in, but allows another 

user to log into their account at the same time. Once they are 

done, they can log out and you can log back in to your account 

and pick up where you left off.

 Suspend This is like a sleep mode for your computer. All the 

work you were doing is saved, and the computer shuts most of 

its internal systems off to save power – including the hard 

drive, the screen, the CPU, the networking, etc. To come out of 

suspend mode, press any key on the keyboard.

 Hibernate This is like a deep sleep mode for your computer 

that actually switches it off completely – you can even pull out 

the power cable if you want to. When your computer 

hibernates, it saves all its RAM to the hard disk so that when it 

starts up next time it can reload the RAM as if nothing had 

happened to it.

 Restart This reboots your computer. You may need to do 

this if you have run a system update.

 Shut down This is the only option that actually turns off 

your computer the traditional way!
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 Along with 

themes, 

backgrounds and 

screensavers, you 

can also enable 

Ubuntu’s visual 

effects system for 

some seriously 

cool-looking 

graphics – see 

page 68 for more 

information.

Look and feel
Part of the fun of using a computer is making it work just as you want 
it to – whether that means neutral earth tones or garish neon pinks…

H
ow do you feel about brown? Doubtless you’ll have 

noticed by now that Ubuntu has discovered more 

shades of brown than Dulux, going from dark 

chocolate through to creamy orange, and if you like this 

sort of thing, then this is the sort of thing you’ll thing you’ll 

like. Faint praise? Well, yes, but don’t worry: if the brown 

looks a little too drab for your tastes, it’s easy to change – 

and while changing that, we’ll also show you how to change 

all sorts of other things to get Linux your way.

Bye-bye, brown!
Choose System > Preferences > Appearance, and a new 

window will appear that lets you customise the theme, 

background, fonts and more all from one place. The Theme tab 

is the best place to start, because your Theme controls lots of 

things – how buttons, scrollbars and such (these are known as 

‘controls’) are drawn , what colours are used for windows and 

other objects, how the window is drawn (the colouring as well 

as the buttons used for minimising, maximising and closing), 

and which icons are used for folders and other things on your 

filesystem. There are several theme packs installed for you, and 

choosing any one of them will set all the theme options at once 

so that they go together nicely. The default theme is known as 

Human, but a popular alternative is called Clearlooks – click on 

it to give it a try. As soon as you click any theme, it will take 

effect, so if you find you don’t like it, just click back to Human to 

revert to the original settings. 

If you find you like some bits of one theme and some bits of 

another, you need to click on the Customise button. This lets 

you take one theme as a base, then change individual parts of 

it to suit your own tastes. So if you like the Human colours but 

prefer the Clearlooks icons, just start with Human, click on 

Customise, then choose the Clearlooks icons from the list of 

available icon types. We think you’ll agree that it’s very easy to 

make Linux look just how you want it to!

Background and screensaver
If you’ve gone with a non-brown theme, you may find that 

Ubuntu’s default brown wallpaper suddenly starts to clash 

quite badly. Fortunately, it couldn’t be easier to change your 

desktop background to something a bit nicer. To do this, either 

right-click on the desktop and choose Change Desktop 

Background, or you can go to System > Preferences > 

Sounds right
Apart from the rather grating default login and logout sounds, 

the default Linux desktop is a pretty quiet affair – but it doesn’t 

have to be! You can add sounds to message boxes, button clicks, 

menu items and more, all from the Sound Preferences window 

under System > Preferences > Sound. The other cool thing 

under this dialog is the System Beep tab, because here you can 

enable the Visual System Beep. If you’re working in a quiet 

environment (or generally prefer having your system sounds 

turned off), the visual system beep option means that a window 

will flash if it needs your attention or if you try to do something 

that the program can’t do.
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Getting your keyboard to work
If you find that “ appears when you wanted @, Linux probably 

thinks you have a different keyboard to the one you actually 

have. This is easily solved, and at the same time you get a whole 

raft of new options to play with. To change your keyboard 

settings, go to System > Preferences > Keyboard. You can 

change your keyboard type under the Layouts tab, but this is 

generally used for major changes such as the country or style 

(such as Qwerty or Dvorak) – minor changes, such as getting 

the Euro key to work correctly, are made under the Layout 

Options tab. 

The last tab in the keyboard preferences window is great for 

people who get sore wrists when they type, because it enforces 

a typing break at intervals you can set. The default is to allow you 

to work for 60 minutes then have a three-minute break – this 

ought to be fine unless you have very serious RSI, in which case 

you should knock down the work period as needed. Make sure 

you enable the ‘Allow postponing of breaks’ option, otherwise 

you may have computer access cut off at a critical point!

 You can change the repeat rate, choose a new keyboard 

layout, and even enforce typing breaks – the keyboard 

preferences window has it all.

Appearance, then choose the Background tab from the 

window that appears.

The default selection of desktop backgrounds is quite thin, 

but that’s easily fixed – if you download another picture from 

the internet or from a camera, you can add it to the list by 

dragging it directly on to the window. Alternatively, if you have 

a whole directory of pictures you’d like to choose from, click 

the Add button. The screensavers are far more plentiful than 

the desktop backgrounds, but they are found in a different 

window – look under System > Preferences > Screensaver. 

Here you change which screensaver will be used, how long the 

system should wait until activating it, and whether the screen 

should be locked as soon as the screensaver is active. That 

last option is particularly useful, because it means that you 

can walk away from your desk and the system will be locked 

down as soon as the screensaver activates – anyone returning 

will have to enter your password to unlock the computer.

If you’re a real tweaker, the promise of setting your own 

keyboard shortcuts is hard to resist – and Linux won’t fail you 

here! For example, if you have a laptop or special keyboard 

with shortcut keys, you can tell Linux what you want to happen 

when the volume keys are pressed, or Play/Pause/Stop. There 

are lots of other basic actions that are pre-defined, such as 

Logout (Ctrl+Alt+L) and Show Desktop (Ctrl+Alt+D), and 

many more that have no keys assigned to them by default.

Tweak your keys
To get started customising your keys, go to System > 

Preferences > Keyboard Shortcuts. You can change any 

shortcut by clicking on it, then pressing the keys you want to 

use. If you want to use a letter or number (ie, A–Z or 0–9) you 

need to hold down the modifiers first. That is, if you want 

Ctrl+Shift+M to launch the media player, you can’t press M, 

then Shift, then Control – you need to hold down Control and 

Shift together, then press M while holding down the other two. 

Keep in mind that a fair few key combinations are already 

assigned for you; if you try using the same keys for a different 

shortcut, the old one will stop working!
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Managing your programs
If you took the opportunity to click around earlier, you’ll have noticed 
there are lots of apps to try. It’s best to keep them arranged neatly…

Y
our Linux desktop is split into three parts: the main 

menu lives at the top, the task pane (often called 

the panel) lives at the bottom, and all the programs 

you run live between the two. The task pane is very simple: 

it just tracks the programs you’re running so that you can 

switch between them, and also hosts the trash can icon so 

you can delete files easily. And of course the big gap in the 

middle for your own programs is also easy to understand, 

because you choose what goes there! The menu bar is a 

little more complicated, however, because it’s split into 

several subsections of its own.

Finding your applications
The most important entry on the menu bar is Applications, 

because this stores a link to all the programs you have 

installed, as well as an option to add more. When you click it, 

you’ll notice that Linux groups its programs into categories 

based on what they do rather than the Windows method of 

who made them. The default categories are likely to be 

Accessories, Games, Graphics, Internet, Office and Sound & 

Video – each will contain several programs that you can run. 

As you install more programs, they will automatically be 

placed into the right categories for you, and new categories 

will be created as needed, such as Education and 

Programming.

If this default menu layout doesn’t work for you, right-click 

on the Applications menu and choose Edit Menus. On this 

window you’ll see the menu list down the left-hand side and 

the programs list down the right. To show or hide a program, 

just deselect it in the appropriate menu. You can also add a link 

to an unlisted program by clicking the New Item button and 

giving it a name and a command to run. To change the icon 

for the new item, click on the picture button to the left of the 

Type field.

If you want edit or delete an existing item, you need to right-

click on it and choose the appropriate 

option. But beware: once it’s gone, the 

only way to retrieve a menu item is to 

click the Revert button at the bottom of 

the editing window, and that undoes all 

your changes!

Going places
Adjacent to the Applications menu is the 

Places menu, which contains a series of 

shortcuts to common directories on 

your computer; network connections; 

file search; and a list of recently opened 

documents. As with the desktop, any 

removable media that gets plugged into 

your computer will be listed here for 

easy access, but you’ll also find any 

active network connections here.

Speaking of connections, you can 

connect to another computer by 

choosing Places > Connect To Server. It 

doesn’t matter whether you want to use 

Windows Networking, FTP, WebDAV or even super-secure SSH 

– the Connect To Server dialog can do it all. You will need to 

provide the address of the server (eg www.example.com or an 

IP address like 192.168.0.1) and may also need to provide a 

username and password if the connection is secure, but 

otherwise this is very easy.

Extending the panel
At the top-right of the screen is the Panel, which by default 

contains a quick logout button, a clock and other helpful little 

things. On the left of the panel you’ll see your username; that’s 

the fast user switching system – if you have more than one 

user, you can click there and it’ll log them in straight away. 

But if you right-click just to the left of that username, a 

menu will appear that starts with Add To Panel. This is where 

you get to add all sorts of weird and wonderful things to your 

panel, for example:

 Address Book Search Need to look up contacts regularly? 

Don’t bother opening up a dedicated program, because this 

lets you search for someone right from your desktop!

 Fish Puts an animated fish into your panel. As if that weren’t 

great enough(!), you can click the fish to get some sage words 

of advice and occasional random comedy: (“What’s the 

difference between a dead dog in the middle of the road and a 

dead lawyer in the middle of the road? There are skid marks in 

front of the dog!”).

 Eyes People who occasionally manage to lose their mouse 

on the screen need never worry again: this pair of eyes will 

follow your every move!

 Weather report This will download the latest weather 

predictions for your approximate area. To make it more 

 Right-click on a spare part of a panel, then choose Add To Panel – there are lots of 

things you can try here, but don’t go overboard!
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Tomboy and you
One of the coolest panel apps is called Tomboy – it’s like having 

your own personal wiki, because you can create links out of any 

text, which in turn become their own sticky notes that you can 

write to. Tomboy also understands basic formatting, emails, 

pictures and other rich media – give it a try!

precise, right-click on the icon, choose Preferences, then go to 

the Location tab and find the nearest city to you.

You’ll also find lots of little utilities in there that are 

particularly helpful for laptop users, including a battery charge 

monitor, volume controls, screen brightness and more. These 

little panel apps are great, because they nearly always solve 

just one task, they solve it really well, and they take up hardly 

any screen space when you aren’t using them.

Application launchers
At the top of the Add To Panel window are two buttons that are 

particularly useful: Application Launcher and Custom 

Application Launcher. Ubuntu creates three application 

launchers for you by default – they sit just next to the System 

menu, and link to Firefox, Evolution and the system help. You 

can create more by using these two special panel items – the 

Application Launcher option creates a shortcut to a program 

that already exists in your Applications menu, and the Custom 

Application Launcher lets you create a shortcut to anything 

you want on your system.

As an example, let’s take the Gimp image editing app:
1  Right-click on the panel and choose Add To Panel.
2   When the Add To Panel window appears, click on Application 

Launcher.
3   You’ll be shown a list of available programs. Open up the 

Graphics category.

4  Now choose Gimp Image Editor and click Add.

You can actually add whole submenus as launchers if you 

want to – just choose the category you want then click Add. 

When you click that launcher, the list of programs in that 

category will be shown for you to choose from.

The task panel
So far we’ve only looked at the top panel, but the bottom panel 

works in much the same way – you can add whatever you 

want there, and you can even merge the two panels together if 

you’re desperate to save space!

By default, the bottom panel contains three things: a Show 

Desktop icon, the window list, and the trash can for deleted 

files. The window list is really just a holding area rather than a 

specific thing on the panel, because windows will be added to 

it automatically when they are opened. As in Microsoft 

Windows, you can then click on a window in the window list to 

have it brought to the foreground.

If you’re the kind of person who likes to conserve space at 

all costs, you should right-click on the bottom panel (or indeed 

any panel you create), and choose Properties. This brings up 

the Panel Properties window shown above, which has several 

cool options:

1  Orientation This is set to Bottom for the task panel, but 

you can make it stick to any of the four edges of your screen.
2  Size The height of the panel. Most things will scale neatly 

if you increase this, so feel free to make it as large as you need 

it to be.
3  Expand This causes the panel to stretch to fit the size of the 

screen even if there is nothing there to fill it. Turning this off 

can save a lot of screen real estate.
4  Autohide With this turned on, the panel will automatically 

duck off the screen when you’re not using it.
5  Show/Hide Buttons This allows you to get the panel off the 

screen when you don’t need it, just by clicking one of the hide 

button directions.
6  Background The default background is plain grey, but you 

can go for a transparent colour or even a background image if 

you want to!

 By adjust their properties, you can force panels to autohide, orient themselves to a 

different edge of the screen, or use an image for their background.

 Tomboy lets you write notes using text and pictures, then link 

them together just like you have your own wiki!

LXFS13.desktop   19 15/4/08   11:57:53



20     Linux starter pack

Linux desktop

Your filesystem
Ready to delve right into the core of your new Linux system? 
The Nautilus file explorer is here to help!

N
autilus is the Linux equivalent of Explorer on 

Windows or Finder on Mac OS X – it lets you 

browse your filesystem, create new files and 

directories, and work with all your files. Before you jump in, 

first you need to know a little bit about how the Linux 

filesystem is laid out:

1   The root of the filesystem (the equivalent of C:\ on 

Windows) is called ‘/’. All files, folders and devices come off 

that /.
2  Normal user programs are in /bin and /usr/bin.
3  Administrator programs are in /sbin and /usr/sbin.
4  Software settings live in /etc.
5  Log files are stored in /var/log.
6   System devices are represented as files in /dev (you can

usually ignore these!).
7  User home directories are in /home.
8   Your desktop is actually a subdirectory of your home 

directory, eg /home/bob/Desktop.
9   Most users can only write files to their home directory – this 

is what makes Linux so secure!

Your home directory is the best place to start, as that’s 

where you’ll be storing your files, and the easiest way to bring 

it up in Nautilus is to use the Places menu. Each of the 

shortcuts in the Places menu will launch in Nautilus, so click 

the first one: Home Folder.

Navigating around
The default Nautilus window is split into three parts: along the 

top are the menu and toolbars; along the left is the task pane, 

and the rest of the window is there to show the list of files and 

folders in the current location. You probably won’t use the 

menu bar too much, so instead focus on the two toolbars: one 

contains Back, Forward, Up, Stop and Refresh buttons, just like 

a web browser – and they work just like a web browser too, 

meaning that you can navigate between your most commonly 

used folders using just these buttons. The Home and 

Computer toolbar buttons are quick links, with the former 

bringing you back to where you are now and the latter taking 

you to a Windows ‘My Computer’-style location, from where 

you can navigate to your hard drive or any devices attached to 

your computer.

Get to know the Nautilus file browser

These buttons work in just 

the same way as the web 

browsers they’re inherited 

from – use Back and 

Forward to navigate to 

previous directories, and 

Up to go to the parent 

directory.

This location bar provides little ‘breadcrumbs’ leading from 

your current location to the root of the filesystem – click 

any of the buttons to move to that directory.

Click on this button to 

bring up the path as 

editable text that you 

can easily modify.

These buttons adjust the magnification level – a higher 

zoom means more detail will be shown about files.

This is the task pane, 

currently set to the Places 

view so that it’s easy to 

navigate to all the most 

important places on my 

filesystem.

All the files and folders 

held by the current 

directory will be shown 

here, along with some 

summary information in 

the bottom-left corner  of 

the window.
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Disabling file
previews
One common criticism of Nautilus is 

that it isn’t very fast, and that’s true – 

but only because it’s providing lots of 

features behind the scenes! For 

example, whenever you open a directory 

in Nautilus, it will scan all the directories 

and count how many files they contain, 

then scan all the files to generate 

previews for the icons. If, for instance, a 

file is a picture, Nautilus will generate a 

thumbnail of that picture for the icon so 

that you can see exactly what it is. All 

this work can chew up a lot of CPU time, 

so if you want to streamline Nautilus, 

go to Edit > Preferences > Preview then 

change all the ‘Local Files Only’ options 

to ‘Never’.

 Don’t like how Nautilus works? Change it until you’re happy!

The second toolbar is a bit more interesting, because it 

contains a location bar and viewing options. The location bar is 

mostly hidden by default – in fact, you’ll probably only see a 

pencil and paper icon, a button with a ‘left’ arrow on, and 

another button with your username on it. This location bar is 

designed to make it easy to browse to directories above the 

current one, because as you move around, the directories will 

all be listed there. 

To get started, click on the left-facing arrow button to make 

it show all the parent directories: the first one will be a picture 

of a hard disk (symbolising the root directory), the second one 

will be ‘home’ (which is where all user directories live), and the 

last one will remain as your username, to show that you’re 

currently looking at your home directory. If you want to see the 

location bar as a real path, press Ctrl+L – the buttons will 

disappear and be replaced with /home/yourusername. You 

can then type directly into there to change directory. Or if 

you’re particularly lazy, just typing / will bring up that path 

information, allowing you type a full path.

On the right of the location bar are buttons to adjust the 

zoom level (great if you have a small screen or if you prefer 

your icons nice and chunky) and a drop-down selection box 

that alters the way the files are shown. The default is ‘View As 

Icons’, but you can change that to ‘View As List’ to get a tree 

view of your files, showing size information and more.

Going places
On the left of the Nautilus window is the task pane, which is set 

to show the most popular places by default. This is just like the 

Places menu, but if you look carefully you’ll see a small arrow 

next to the word ‘Places’ at the top of the pane – if you click 

that, you’ll see that you can change what that area shows, so 

it’s a bit more useful than just repeating the Places menu!

1   Information Shows information for selected items. 
2   Tree Shows the directory structure for your computer, 

similar to Windows Explorer.
3   History Remembers the directories you’ve visited recently 

so you can snap back to them quickly.

4   Notes Allows you type text to associate with a particular 

directory.
5   Emblems Shows a list of icons you can attach to files and 

folders to visually mark them as private, important, etc

We think you’ll find the emblems system particularly useful, 

as you can drag and drop icons wherever you need to so that 

you can see at a glance what each folder does.

Tweaking to your tastes
Nautilus is designed to be quick and clean by default, but it’s 

ripe for customisation if you want to get a little more out of it. 

To take a look for yourself, go to the Edit > Preferences menu – 

the particularly relevant parts of this are the second and third 

tabs (Behaviour and Display), because these affect the core 

parts of Nautilus.

For example, the Behaviour tab has at least three 

interesting items:

1  Double Click To Open Items This is set to be the default, 

but if you hate double-clicking everything, just set it to single-

click mode.
2  Always Open In Browser Windows The Nautilus view 

you’re used to (menu bar, two toolbars and location bar) is 

known as the browser view because of the up, back and 

forward buttons. Disabling this option will give you an even 

slimmer, less-cluttered Nautilus view – give it a try and see 

what you think!
3  Include A Delete Command By default, deleted items go 

into the trash can where they can be recovered later, but 

enabling this option means you can force an item to be 

permanently deleted immediately, which is a smart move if 

the document is confidential.

Over in the Display tab, you can choose what information is 

shown about your files. By default, Nautilus will only show the 

file size, and only then if you zoom in enough; but using these 

options you can have it show the file type, modification date, 

owner, permissions and more!  LXF
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 Firefox is a simple 

and fast web 

browser at its core, 

but those who 

want more features 

have a lot to 

explore in Firefox's 

add-ons – see p24.

A 
lot of people take the world wide web for granted, 

but then a lot of people haven't tried Firefox – it's a 

relatively young project that aims to revolutionise 

the way we use the internet, and has already 

attracted millions of users. There are lots of things you could 

attribute Firefox's success to: 

1  It supports web standards very well – much better than 

Internet Explorer, for example.
2  It was built for strong security, so problems are not often 

found, and major problems (ie, ones that can be exploited 

remotely) are very rare indeed.
3  It comes with lots of powerful functionality as standard, 

including tabbed browsing, an integrated search box, and even 

search predictions.
4  It has a powerful add-ons system that can build in some 

impressive extra functionality.
5  It was designed with ease of use in mind, which means it's 

very easy for first-time users to find their way around.

Of course, it's more likely that Firefox is popular for all those 

reasons and more, but while it's easy to master the basics 

yourself, with a few minutes of learning you can get a lot more 

out of the world's most popular web browser…

Keyboard shortcuts
There's lots to read on the web, and any serious web user 

wants to make most of the time they have to surf. So, here are 

a few sneaky little keyboard shortcuts that you can use to 

streamline your Firefox experience:

Shortcut   

Ctrl+H Opens the History sidebar.

Ctrl+J Opens the Download Manager so you can see how     

your downloads are doing.

Ctrl+K Focuses the search box so you can type a query.

Ctrl+L Focuses the location bar so you can type a URL.

Ctrl+R Reloads the current page. 

Ctrl+T Opens a new tab.

Ctrl+Z Copy URL from previous tab (use it when you've just 

pressed Ctrl+T for a new tab).

Ctrl++ Increases the font size.

Ctrl+- Decreases 

the font size.

Ctrl+0 Returns 

font size to default.

Ctrl+Enter Adds 

‘www.’ and ‘.com’ to a 

URL, so typing ‘intel’ 

then pressing 

Ctrl+Enter will load the 

page www.intel.com.

Alt+Left Goes to the previous 

page you were looking at (equivalent to the ‘Back’ button).

Alt+Right Goes to the next page in your history (equivalent to 

the ‘Forward’ button).

Alt+Home Goes to your home page.

Alt+Enter Opens a URL in a new tab (use it rather than 

pressing Enter when typing a URL).

Of those, Ctrl+L, Ctrl+K and Ctrl+T are easily the most 

useful, so give them a try and watch them speed your 

browsing!

Another little shortcut is the / key, which enables quick find 

mode. For example, if you type /hello, Firefox will find the first 

instance of the word “hello” on the current page. If you are 

specifically looking for link text, try using ‘ instead, eg 'hello’ – 

that will find the first link with the text “hello”.

The search is on
Firefox has a search box in the top right-hand corner of its user 

interface, meaning that you can get access to your favourite 

search engine very easily. By default, Google is used as the 

search engine, but you can change that very easily by clicking 

the small G button next to the search box – Firefox will bring 

up a list of alternative search providers, including Amazon, 

eBay, Creative Commons, Yahoo and even Microsoft Live 

Search. If you particularly want one of these providers then 

feel free to choose them, but using Google has one big 

advantage: search suggestions.

Sometimes searching for things can be frustrating – you 

have only a vague idea of what you're looking for, you need to 

try several times to get it right, and sometimes you don't find it 

at all. Well, when Firefox uses Google as its search engine, it 

can help suggest search terms as you type, based on what 

other people have searched for. All you have to do is make sure 

suggestions are enabled by right-clicking on the search box 

and ensuring ‘Show Suggestions’ is selected, then just type a 

few letters into the search box and wait a microsecond or two 

for your suggestions to appear. If one of the suggestions 

match what you wanted, just use the Up and Down keys to 

select it, then press Enter.

The bookmark bar
With the web being so big, it's no surprise that bookmarks (or 

‘favourites’ in Internet Explorer parlance) have been around 

since its inception. But while other browsers have a menu for 

your bookmarks, Firefox also has a toolbar so that you can 

Get on the web!
More speed, more features and more safety than any other 
web browser around – get started using Firefox!
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 Sometimes Google won't have the best results for a search, so 

try changing the search provider to something more suitable.

 Firefox springs into action when it spots sites trying to open 

strange windows (left) or impersonating other sites (right).

Hidden configuration options

Are you the kind of person who loves to fiddle with things just to see what happens? If so, 

Firefox will provide hours of tweaking through its special about:config configuration 

screen. All the major user-facing options for Firefox can be changed using the 

Preferences dialog, but if you type about:config into the Location bar you'll see a huge 

list of Firefox options, many of which can't be set in the preferences dialog because most 

people don't care about them. For example, HTTP pipelining is a technology that can 

drastically boost the speed that web pages download, but is traditionally left disabled by 

many web browsers because a tiny minority of web servers have issues with it – and by 

“tiny” we mean “we can almost guarantee you will never find one.” Using about:config, 

you can enable HTTP pipelining and enjoy a free speed boost!

In fact, there are lots of settings like this that you might want to change:

reach your favourites in a single click. You can even right-click 

on a blank space in the toolbar and open all your bookmarks 

at once – easily the fastest way to get up to speed in the 

morning!

To get started, visit any page that you want to bookmark, 

and look to the left of the URL – you'll see a small icon there. 

Many websites have a custom logo there, but if your site hasn't 

chosen one then you'll see a blank page of paper next to the 

URL. Now, click that icon, and drag it over the bookmark 

toolbar – that's the one with ‘Getting Started’ on. Let go of 

your mouse, and a new button will appear on the toolbar using 

the title of the web page. That probably isn't too good, because 

a page's title is rarely short enough to fit onto the button, and 

often doesn't even say what the site is! To fix that, right-click 

on your new bookmark button and choose Properties, enter 

some more descriptive text in the Name field, then click OK to 

save your changes.

Firefox pushes the idea of bookmarks even further using its 

Live Bookmarks system, which is a blend of RSS feeds and 

bookmarks – you can put them into the bookmarks toolbar, 

and they will appear as a menu that can be clicked to show 

more information. But the magic of Live Bookmarks is that the 

‘more information’ part is an RSS feed of news from any 

source you want, and clicking on any of the headlines will load 

the full story in the browser. To give this feature a try, first find 

an RSS feed that interests you. If you haven't tried RSS before, 

go to http://news.bbc.co.uk, then look down the left-hand 

menu bar until you see “News Feeds”. When the page loads, 

you'll see a long list of available news feeds down the right – 

choose any one of them, and another page will load that looks 

quite different to the normal BBC News home page. At the top, 

you'll see a message saying “Subscribe To This Feed Using” 

and a selection box where “Live Bookmarks” is the default. 

Click “Subscribe Now”, and you'll be asked where you want to 

create the bookmark. Leave the default selected and click OK, 

and you're done!

Blocking malware
One of the core things that Firefox does very well is protect you 

from web nasties – aggressive advertising, ‘phishing’ websites 

that masquerade as sites you trust, and cookies that store 

unwanted information about you.

On the advertising front, it used to be common practice to 

be swamped by adverts when visiting certain websites. Worse, 

these adverts were usually ‘pop up’ style, which means they 

appeared over what you were trying to do. Some were even 

‘pop under’, which meant they would appear below your 

browser, and you would only see them when you were done. 

These unrequested web irritants used to plague the web, but 

Firefox took the lead and started blocking them and other 

similar aggressive advertising. In fact, Firefox’s blocking 

system is so powerful that it may occasionally block windows 

that you want, so by default Firefox will notify you when it 

blocks a popup window so that you can choose to show it if 

you want to. When this happens, a small yellow bar will appear 

at the top of the page to notify you that the site's action was 

blocked – clicking the Preferences button on the top right 

gives you an “Allow popups for this site” option, which allows 

you to selectively trust sites.

Setting Set it to 
this What it does

browser.startup.page 3
When you open Firefox, it will pick up 

where you left off

browser.tabs.tabMinWidth 75

Allows Firefox to make tabs smaller 

when you have lots of them open, 

rather than making you scroll around 

to fi nd them.

browser.urlbar.autoFill true

Forces Firefox to auto-complete 

URLs from your history as you type 

them, rather than you having to push 

Down to select one.

browser.urlbar.hideGoButton true

Hides the green arrow at the end of 

the Location bar – let's face it, no 

one uses it!

layout.spellcheckDefault 2

Forces Firefox to spellcheck text 

in single-line text boxes as well as 

multi-line text boxes.

network.http.max-persistent-

connections-per-server
4

Allows your client to connect to 

the same server multiple times for 

maximum performance.

network.http.pipelining true
Enables multiple fi les to be sent 

down one HTTP connection.
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 AdBlock Plus lets you build your own advertiser filters, or 

subscribe to someone else’s (which is much simpler).

 IRC is full of people to talk to, but make sure you keep your 

identity private – not everyone can be trusted.

 Firefox's status bar doesn't do much, so put it to good use 

with ForecastFox – never get caught out by the weather again!

 The about:config screen is full of options to change, so type 

something in the filter box to slim down the list a little!

Add-ons
Without a doubt, add-ons are the most impressive thing about 

Firefox, because it has been designed to be open to its very 

core – the add-ons that people create can modify any part of 

the browser, and there are some incredibly powerful ones 

around.

To help get you started, here's our list of the best add-ons 

out there. But be warned: you should only install these from 

the Firefox homepage, because the fact that the add-ons can 

modify Firefox means that it's possible to install malicious add-

ons if you don't get them from a trusted source. Firefox does 

take this very seriously, so if you try to install an add-on from 

an untrusted source, expect to be warned again!

To install an add-on, go to Tools > Add-Ons, then choose 

Get Extensions. Note that the ‘Get Ubuntu Add-Ons’ link is very 

similar, but offers a much smaller selection of add-ons 

because it only allows you to install add-ons that Ubuntu 

supports, as opposed to everything available to Firefox users. 

When you're on the Firefox Add-Ons site, you can search for 

add-ons by name, then click on the Add To Firefox button to 

install the ones that interest you. Before the add-on is installed, 

you'll be asked to confirm you want it – just click Install Now, 

then restart Firefox when installation has finished so that the 

add-on can be initialised.

AdBlock Plus
Designed to block every advert under the sun to leave the web 

a content-only place, AdBlock Plus (ABP) is both a blessing 

and a curse. It's a blessing because – let's face it – some of the 

adverts out there are downright annoying, with flashing 

colours, silly animations, and worse. But it's a curse because 

the vast majority of websites out there are funded through 

advertising, so if everyone blocked all their adverts then they 

would simply cease to exist. When you install ABP, you'll be 

prompted to choose a set of advertiser filters – either choose 

the one nearest to you, or if you're not sure just choose the 

first item on the list, then click Subscribe. And that's it: you're 

safe from adverts, and can go on browsing the web – now with 

a little less bandwidth wastage.

ChatZilla
Before the web, there was Internet Relay Chat – an interactive 

text system where people joined channels based on common 

interests, and discuss/argue/flame long evenings away. 

Despite the invention and ultimate rise to supremacy of the 

web, IRC lives on, and ChatZilla is an excellent add-on for 

extension that builds IRC support directly into your web 

browser. Once installed, start ChatZilla by going to Tools > 

ChatZilla. When it loads, some text will appear saying 

“Available networks are [dalnet, efnet..... webbnet]”. Click on 

the “freenode” link to connect to that server network, then 

when the connection is complete type /join #ubuntu to join 

the official Ubuntu support channel. Have fun chatting!

ForecastFox
British people have a natural obsession with the weather, 

which is strange, really, given how little of it we have. So if 

you're feeling the need to check just how much rain we're 

going to get tomorrow, ForecastFox is for you: tell it where you 

live, and it will tell you the latest weather forecasts for your 

area. When it's first installed it will say you're in Forecast 

Location 00000 – ignore that, and click Find Code. When the 

Location Search dialog appears, enter the name of your town 

or city and click Search, then choose the best match from the 

list that appears and click OK then Apply – your weather 

forecasts will now appear at the bottom of the Firefox window, 

and will update automatically. Magic!
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 Writing your own Greasemonkey scripts is tedious, so do the 

smart thing: take what other people have made!

 Foxy Tunes: streams music from last.fm so you can let other 

people do the DJing while you get busy surfing the web.

 The more you tell StumbleUpon about your interests, the 

more likely it is to be able to serve up pages of interest.

 One of the fancier add-ons for Firefox, ThumbStrips makes it 

even easier to find your way to your favourite sites.

 Wizz RSS tells 

you when news 

happens, rather 

than you having 

to check every 

hour. That means 

more time for 

games, right?

FoxyTunes
Running a separate program for music is so 2004 – all the 

cool kids are using last.fm, and so it's natural that Firefox has 

an extension for connecting to last.fm and playing music: it's 

called FoxyTunes. Of course, if last.fm isn't your thing, then 

FoxyTunes can connect to a wide variety of traditional media 

players or other online services, and can even stream music 

from your Xbox if you have one. 

Greasemonkey
Have you ever been to a web page that was excellent, but held 

back by one or two niggles that actually drive you away? If so, 

Greasemonkey is the perfect extension for you, because it 

allows you to run little scripts that modify pages to your liking, 

so that whenever you visit them Greasemonkey makes them 

work just as you want. Making your own scripts isn't for the 

faint-hearted, but that's OK because when you search for 

“greasemonkey” on the Firefox add-ons site, it will also return 

lots of prewritten scripts for Greasemonkey that spiff up 

common sites – look out for titles like “Better Gmail” or 

“Better YouTube”, and install them to Firefox to power up your 

web experience!

StumbleUpon
Whether you have five minutes or five hours to kill, the web 

seems like the ideal place to while away your time. But 

surprisingly it can be rather hard to find cool or unique content 

to spark your interest, and that's where StumbleUpon comes 

to the rescue – you tell SU what you're interested in, and when 

enough users on the SU network mark a page in that category 

as cool or interesting it will be added to the list of things that 

might interest you. Then, when you're bored, just click “Start 

Stumbling”, and it will take you to the first site that fits your 

criteria. Get ready to watch the hours fly by…

ThumbStrips
As the web becomes increasingly media rich, add-ons like 

ThumbStrips likewise become popular. As you surf the web, 

ThumbStrips takes a graphical snapshot of the pages you visit 

and shows them to you in a line across the bottom of your 

screen. When you want to go back to a previous page, it's easy 

to spot it among all the pictures, and a single click sends you 

back. If pictures don't work for you quite so well, try searching 

for any word in the search box – if the site contained that word 

anywhere on the page, it will appear in the filter results.

Wizz RSS
Wizz RSS brings the news to life in a Firefox sidebar that can 

hook up to live news feeds from across the globe to deliver 

breaking headlines to your desktop. To get the best view, make 

sure you click the “Open/Close Wizz RSS Sidebar” button so 

that the sidebar is visible. You can add your own feeds to the 

list by browsing to the site that has a news feed, clicking “Feed 

Search”, then dragging any discovered feeds into the sidebar 

under whichever category you want. Easy!  LXF

When writing this 

piece, we started with 

a clean Firefox and 

ended with eight 

extensions installed. 

As you can see in the 

final screenshot (Wizz 

RSS), there's not 

much room left to see 

what's going on in the 

web page, which 

rather loses site of 

Firefox's main goal! 

Don't let the same 

happen to you: 

choose a few 

extensions, but be 

warned that they use 

up screen space and 

slow down your 

browsing experience.

Add-ons 
warning!
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Email

T
he web is only one small part of your digital life. If 

you’re like most people, you will have at least one 

email account (often more), you’ll have a list of 

contacts for people you want to keep in touch 

with, you’ll have a calendar to keep track of special events, 

and you may even keep a to-do list to help stay organised in 

an increasingly hectic world. Rather than adding to your 

already-complex daily life, Linux makes things easy by 

bundling all these tasks into a single program called 

Evolution. In the Windows world you might say that 

Evolution is roughly equivalent to Microsoft Outlook, 

but if you’ve never used that before then your best bet 

is to follow the annotated picture below and just dive 

on in!

Email and more 
with Evolution
You’re all installed and you’re on the web, so what next? Email, of course! It’s 
time to use Linux to stay in touch…

Exploring the Evolution interface

Click here to create a new item in 

the program – clicking the New 

button directly will create a new 

item for whatever view you’re in 

currently (mail, calendar, etc), but 

if you click the arrow next to it then 

you’ll see a list of all the items you 

can create.

This is the list of emails in the selected folder. You can sort 

by any one of the fields by clicking the field name at the top 

of the list.

In the Mail view, this shows the 

different mailboxes you have 

configured. Evolution can check 

and manage multiple mail boxes all 

at once; each box is treated 

separately in this pane.

Evolution is split into five views, 

selectable using these buttons on the 

left. Changing the view here changes 

what is shown in the panes on the right.

This is a live search system – as you type, 

Evolution will filter your messages to show 

only those that match your text.

When you select an email, Evolution 

will show message header information 

here. This includes who the message 

is from, who it was sent to, when it 

was sent, and more.

This is the email preview window, 

shown when you select a message in 

the message list pane above. If you 

double-click a message, it will be 

shown in its own separate window.
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 Make an 

appointment (left) 

and have it appear 

in the Gnome clock 

automatically 

(right).

Managing your emails – virtually
The first time you run Evolution you have to follow a fairly long 

wizard process to configure your initial email account. This has 

a lot of options to set and might put you off, so we suggest you 

follow our step-by-step walkthrough over the page. Once you 

finish the configuration, you may need to start Evolution again 

so that it takes your settings on board, but when it’s all done 

you should be sitting in front of your inbox ready to start work.

We’re not going to spend any time explaining how 

Evolution’s email system works, because it’s just the same as 

every other email client out there with two exceptions: the first 

is Evolution’s system known as ‘search folders’ that let you 

save searches as virtual mail folders. When you click on one of 

these virtual folders, Evolution runs the search on all your mail, 

and places any matching messages into the folder so you can 

browse through them. The messages haven’t really moved, of 

course – that’s why this is a virtual folder rather than a real 

folder! But having multiple saved search folders enables you to 

create custom views of your inbox without having to move 

things by hand; Evolution takes care of all the work for you.

To create a saved search folder, go to Search > Create 

Search Folder From Scratch, then add all the criteria you want 

to search by. Give it a descriptive name, like “Messages from 

clients that I haven’t replied to”, and set it going! Alternatively, 

select a message that fits a criterion you want to filter on, then 

choose Message > Create Rule and choose one of the ‘Search 

Folder From…’ options.

The second helpful feature in Evolution is its ability to group 

emails by thread so that you can see entire conversations 

grouped together rather than having to scroll through dates to 

find replies to messages. To enable threaded mode, press 

Ctrl+T; pressing it again exits threaded mode.

Tracking your life
If you want to keep track of daily meetings as well as special 

events, Evolution’s calendar will surely come in handy. To try it 

out, click the Calendars button near the bottom-left corner of 

the window, then choose View > Current View > Month View to 

get a better overview of the days ahead. Now, to create a new 

event, double-click on a date – try choosing today – and a 

window will appear prompting you to enter a summary of the 

event as well as what time it’s at. Enter whatever you want 

here, because we’re only testing it right now. When you’re 

done, click Save, and the event will appear in your calendar. 

Now, part of the magic of Linux is that this event has been 

shared with the rest of your desktop, so if you click the clock in 

the top-right corner of your desktop, you’ll see a little 

‘Appointments’ area has appeared, and if you click the arrow 

next to it you’ll see your appointment in there as a reminder.

This same functionality is also available for to-do list items, 

known in Evolution as Tasks. Again, this is a view all of its own 

just like Mail and Calendars, so click Tasks from the bottom-

left corner of the Evolution window. To create a new task, click 

New, give it a brief summary, then click Save to dismiss the 

window. This will immediately appear in the reminder list for 

the Ubuntu clock – you can even mark it as done by clicking 

the small checkbox next to its name, and you don’t even have 

to run Evolution!

Free or busy?
Once you start using Evolution to store your calendar events, 

it’s a small step to go from there to sharing your calendar with 

your colleagues so that everyone can see whether you are 

Time-saving tips

 If you have lots of emails and struggle to remember what 

you've dealt with and what you haven't, go to the View menu and 

enable Hide Read Messages.

 If you're more used to an Outlook 2003-style layout for your 

mail, go to View > Preview and choose Vertical View.

 If someone sends you an email that you need to act on at 

a later date, right-click on the message and choose Convert 

To Task.

 Evolution's spam filters try to learn what is and what is not 

spam based on what you tell them. For example, if a message 

arrives and is junk mail, right-click on it and choose Mark As > 

Junk so that the spam filter will learn. Similarly, if the spam filter 

incorrectly identifies a message as being spam, make sure you 

go to Mark As > Not Junk, otherwise it might learn to throw away 

legitimate emails!

 If you want to work offline, right-click on your remote mail 

folder, choose Properties, then check the box marked ‘Copy 

Folder Content Locally’ and click OK.

 If you have an event that recurs (eg weekly, every third 

Tuesday, etc), then bring the event up in Evolution and click the 

Recurrence button to define exactly when it recurs.

 If you need to assign more detail to asks other than done/not 

done, click the Status Details toolbar button while a task is open. 

This lets you set a custom status, complete percentage, priority, 

and even attach a URL with more information.
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free or busy on a particular date. To try this out, go to Edit > 

Preferences > Calendar And Tasks, then choose the Calendar 

Publishing tab and click on Add to create a new publishing 

location. In the new window that appears, choose Publishing 

Location. Here’s where it gets a bit more complicated: in order 

for everyone to be able to read your calendar information, you 

need to send it to a shared location. If you have an FTP server, 

a Windows server with a shared folder, a Linux server with SSH 

enabled, or (for more advanced users) a web server with 

WebDAV enabled, Evolution can help you share your calendar. 

If you haven’t got any of them, then you’re rather stuck!

If you just want a quick calendar sharing system, public FTP 

is the easiest to use: specify the name of the server and the 

filename you want to give your calendar (including the 

When Evolution fi rst runs, you need to fi ll in its setup assistant wizard. 

As with all these wizards, you can go forward and back as you please 

until you get it right.

1

Step by step: Set up an email account

If you've used Evolution before and have a backup of your settings, 

here's your chance to use them. The rest of us should just click Next.2

On this screen you need to enter the name and email address you are 

setting up the account for. These will be used when sending emails so 

people can see where they have come from.

3
There are lots of options for receiving emails; it's really down to what 

your ISP/sys admin has told you! Chances are it's either POP or IMAP, 

but you need to fi nd out for sure.

4

directory), and you’re done. Back in the Calendar tab, you 

need to choose which calendar you want to synchronise to the 

server, then click OK when you have finished. The default is to 

synchronise calendars once a day, but you can override that as 

needed by going to Actions > Publish Calendar Information.

If you want to collect other people’s calendar information, 

it’s even easier. Click the arrow next to the New button and 

choose Calendar, then change the Type option to be ‘On The 

Web’. Give it a name (eg, whose calendar is this?) and a unique 

colour, then type the full path to the calendar in the URL box. 

Unless it’s stored in a secure location you won’t need a 

username, and a 30-minute refresh time ought to be more 

than enough, so just click OK to have the calendar downloaded 

in Evolution immediately.  

LXFS13.email   28 14/4/08   20:03:07



  Linux starter pack      29

Email

Once you choose, you'll be asked to enter the name of the server and 

your account on that server. Leave the authentication type as Password, 

as that's nearly always the right choice.

5
On this screen you can tell Evolution how to handle your email. Chances 

are you want to check the box asking it to check for emails 

automatically, but the rest is pretty forgettable.

6

Now you need to tell Evolution how to send email. Our server required 

authentication to send emails, but that's quite rare – try clicking Check 

For Supported Types before continuing.

7
Now that your account has almost been created, you need to give it a 

memorable name. Of course, if you have no other email accounts, you 

can call this one what you like!

8

The last step is to choose the time zone you live in. The map is small, but 

when you click it you’ll get a zoomed-in view and can click again.  LXF9
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Vive La Différence!
But there are differences. And you’re likely to come up against 

these whenever you want to try something slightly more 

interesting. You will see that the menu system feels totally 

unfamiliar, with a mass of options hidden away behind each 

menu. This is the most intimidating part of Writer and 

OpenOffi ce.org in general – the layout of the various menus and 

options windows take a little learning. But don’t let that put you 

off. It just means that Writer and its companions are capable of 

almost anything you might expect of the best commercial offi ce 

applications, even if it takes a little effort to fi nd the function 

you’re looking for. This is a good moment to mention the online 

help for Writer, as this is often the easiest way to fi nd what you’re 

looking for. Press either the F1 key, or select Openoffi ce.org Help 

from the Help menu, and the well-written user manual will 

appear. The best way to use this is to type something you’re 

interested in into the Search Term box. Try ‘dictionary’ for 

example, and the subject list is automatically populated with 

pages that can help you use the function you’re looking for. You 

can also use the What’s This? option in the help menu to switch 

to the info cursor. If you now hold your pointer over any of the 

buttons in Writer, a small yellow panel will provide further 

information on the functions behind the cursor. 

Options
The fi rst place to start is with a few simple user options that you 

will need for every document you work with. Open the Options 

window by selecting it from the bottom of the Tools menu. This 

Options windows is used across the entire suite of OpenOffi ce.

org applications, so don’t be too scared by the number of 

options. A good thing to do is add your name to the User Data 

panel under the top option. This information will then be 

embedded into every application you work with, making your 

changes easier to trace. The next thing you should check is the 

default language. This can be found under the Language 

Settings menu on the right side of the Options window. The 

Language Settings panel is where, as you might expect, you can 

The word processor is where most users spend much of their 
time; luckily, this important application is also the easiest to use. 

 Getting started 
with Writer

W
ord processors haven’t changed that much in the last 

ten years or so. At least not on the surface. 

OpenOffi ce.org’s word processor, snappily dubbed 

Writer, is no exception, and that is defi nitely a good thing. It 

means that if you’ve used a mainstream word processor in the 

last decade, you’re going to feel right at home with Writer. Just 

launch the application to see what we mean. 

You get a text editing window taking up the main part of the 

window, a ruler down the left and a scroll bar down the right, and 

in the ancient tradition of computerised word processing, a 

series of buttons, toolbars and font selector crowning the editing 

area at the top. From the visual point of view, Writer could be 

almost any word processor – and that’s the idea. If something 

works, there’s no point messing around with the formula and if 

you’ve worked with virtually any modern word processors before, 

you will already be able to rustle up  most documents with 

Writer. Just click on various parts of the user-interface exactly as 

you would with an alternative. 

 If you find that Writer is changing the meaning of your words, then the AutoCorrect 

function is the most likely culprit – change the options to better suit your way of working.

When Writer fi lls in a word you’re typing, press Enter to leave 

the word intact.

Quick tip
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change the default language used by Writer and all the other 

applications. You can also change the language used by the user 

interface, and for the text content in documents, and it’s Writer 

where the effect of this setting will be felt the most, as the 

dictionaries and word replacements you use while editing 

documents are all affected by the dictionary you’re using. But 

the most obvious place where you’ll see the effects of the 

language you choose is in spell-checking,

Essential information
Like nearly all word processors of the last 10 years, as well as 

presenting your text in a WYSIWYG (What You See Is What You 

Get) fashion, Writer uses a toolbar to provide quick access to all 

the most common options – for a quick reference to what action 

each item on the tool bar represents, see the Writer: the toolbar 

at a glance box at the bottom of this page . The small toolbar 

icons might not look familiar, but the functions behind them will 

be. For example,  the fi rst four icons on the top left of the display 

will let you create a new document (the image shows a letter), 

open an existing one (an arrow shooting out of a folder), save 

your current document or email it to a contact. Two of the most 

common special elements you may want to include in a 

document are tables and lists. It’s for this reason they both 

feature prominently in the main toolbars, but you don’t even 

need to resort to the user-interface to create lists. Starting a new 

line with an alphanumeric character followed by a full stop, or 

starting a line with a hyphen, and helpful Writer guesses you’re 

creating a list and switches mode accordingly. Not only will the 

Bullets and Numbering toolbar open, but your text will be 

reformatted and tabbed further into the document. Welcome to 

Writer’s auto-correcting function. 

Auto correction
You will fi nd Auto correction either incredibly useful or a real pain 

to deal with: it all depends on how you like to format your 

documents. If you’d rather just type and let the word processor 

correct spelling mistakes, create lists and bullets, hyphenate 

words and swap certain keywords with one another, then the 

default settings will suit your style. If you’d rather leave 

formatting and word replacement to a later read through of the 

text, or if you’d rather format your lists differently, then auto 

correction is going to drive you mad. Fortunately, there’s also a 

fi ne degree of control over which elements you want to be auto 

corrected, and which you’d rather leave. These settings, along 

with hundreds of others, can be found in the AutoCorrect 

window. This is opened from the Tools menu, and when fi rst 

opened it will default to the replace window. This lists a series of 

characters on a panel on the left, with a series of longer words or 

special characters that will replace them on the right. For 

example, the fi rst entry replaces (C) with the copyright symbol 

©, and there are hundreds of other predefi ned replacements, 

including common typographical errors like ‘yoiu’ for ‘you’ and 

correcting ‘insurence’ with ‘insurance’. For corrections that are 

most likely to annoy, simply switch to the Options page to stop 

automatic list formatting or hyphen replacement.

Writer: The toolbar at a glance

1  New document
2  Open document
3  Save current document
4  Email document using default email client
5  Edit read-only documents 
6  Export document as a PDF
7  Send to printer
8  Preview the printed pages
9  Manual spellcheck
10 Automatic spellcheck
11  12  13  Cut, Copy and Paste

14 Copy and Paste text formatting
15  16  Undo and Redo
17  Insert a web link
18  Create a table
19  Show drawing toolbar
20  Find and replace words
21  Jump to parts of your document
22  Insert clip art into your document
23  Merge other data sources
24  Show non-printing characters
25  Set zoom level

26  Open Help documentation
27  28  Style and Formatting list
29  Font selection
30  Font size
31  32  33  Bold, Italics and Underline
34  35  36  37  Text justifi cation options
38  39  Enable bulleted and numbered lists 
40  41  Decrease and increase indentation 
42  Font colour
43  Section highlighting
44  Background colour

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26

444342414039383736353433323130292827

Select a section of text and drag it around by left-clicking with 

your mouse.

Quick tip

“Writer and its OpenOffice.org companions are able to 
produce documents comparable to commercial office 
apps, and are compatible with Microsoft Office too.”
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Writer: Create a List

1  Enter the data 
Writer can create bullet lists and numeric lists 

automatically. First type each list item onto a 

separate line in the main document window. Each 

line will be used as a separate list item when Writer 

is instructed to format your list.

2  Select relevant text 
The next step is to select the exact section of the 

document that you want to be used as a list. You 

can do this either by dragging the mouse cursor 

over the text, or by jumping to the start of the list 

text, pressing Shift and jumping to the end.

3  Numbers or bullets 
Finally, select either the Bullet List icon or the 

Number List icon from the main toolbar (the latter 

has Roman numerals). Your highlighted text will be 

indented and either a number or a bullet is placed 

at the beginning of each line.

Writer: Create a Table

1  Size IS important 
Click and hold down the mouse button on the table 

icon to open a small matrix representing the size of 

the table you want to create; eg if you want a 3x3 

sized table, drag the cursor until the size you want 

is highlighted, and then let go of the mouse button.

2  Enter the information 
The table will be inserted into wherever the cursor 

is positioned in the current document. Select each 

cell and enter the information you need, pressing 

tab to move from one cell to the next. Select the 

entire table by clicking on its border.

3  Cell formatting 
Select a cell, row or column and then use one of the 

text formatting tools. Try and add foreground and 

background colours using their icons in the toolbar. 

You can also drag the cell borders to stretch the 

size of the cells to the size you need.

Writer: Format your table

1  Advanced options 
An advanced range of options for formatting your 

table can be accessed from the table toolbar, which 

is opened from the View menu. This, and other 

toolbars, will also open automatically when you 

select a table you’re already working on.

2  Automatic formatting 
The AutoFormat icon lets you scan through a list of 

predefi ned table formats you can apply to your 

own table, as well as add your own modifi cations. 

Clicking on the More button will let you limit the 

parts of the table affected by the AutoFormat style.

3  Appearance tweaks 
After changing the colours and text styles, you can 

change the borders that separate the cells. Holding 

the mouse button down on the Borders toolbar 

icon lets you choose between several Border styles. 

Experiment with the other icons for other styles.
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Writer: Microsoft Offi ce and PDF Output

1  Compatibility 
You can save your documents in a format that can 

be opened by Microsoft’s Offi ce apps. All your 

formatting, tables and lists are preserved. You can 

also load most Offi ce documents. Select Save As 

from the File menu to get to the Save requester.

2  Microsoft Word compatible 
By default, OOo uses an open format: ‘ODT’. For 

best MS compatibility, choose Microsoft Word 

97/2000/XP (.doc) for your document in the Save 

As Type drop-down list. You can then send this fi le 

to people using Word without any problems.

3  Adobe PDF creation 
Writer can export a document as a PDF – Adobe’s 

widely used format. Either use the PDF button on 

the toolbar, or select Export from the fi le menu and 

‘PDF’ as the fi le format. You can check the quality of 

the output using Adobe Acrobat Reader.

Writer: Insert images

1  Adding graphics 
You often need to insert pictures or clip art into 

your documents, and this can be done by selecting 

Picture > From File from the Insert menu. There are 

plenty of other formats that you can insert too, but 

images are the most common.

2  Size and position 
After the image has loaded and been inserted into 

your document, resize it by dragging the edges of 

the image. You can also drag the image through 

your document. The image toolbar will appear too, 

and this can be used to fi ne-tune the image.

3  Attractive layout 
To get text to fl ow around images, right-click on the 

image and select Optimal Page Wrap from the 

Wrap menu to position text. If the image uses a 

white background, try the Contour option to wrap 

the text around the details within the image. 

Writer: Create labels

1  Label it! 
Sticky labels save labour and make things more 

legible generally. Writer has hundreds of label 

templates built-in for things like envelopes and CD 

cases; just start a new document of the type Labels 

by holding down the New button in the toolbar.

2  Select a type 
It’s an address above, but it could be anything you 

want labels for. Select the type of label that you 

want to make from the drop-down Type list in the 

bottom right of the Labels window, then enter the 

text for the label in the area on the top right.

3  Generate automatically 
Click New Document: the template governs how 

many labels are created – useful if you want to print 

a few pages of return addresses. You can even use a 

database of addresses and merge those into the 

document from the previous window. LXF
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N
umbers make the world go round. Quite literally actually, 

if you think in terms of the Keppler equations. But no 

matter who you are and what your interest in offi ce 

software, it is almost a certainty that you will have some use for 

Calc. Whether it is for keeping track of club fi nances, exactly 

what types of beer you spent your student loan on, sales of your 

widgets or just the local football team’s chances of promotion at 

the end of the season, numbers – and things to crunch them – 

are always useful.

OOo Calc should be pretty easy to use if you are familiar 

with any sort of spreadsheet, and you can probably skip the 

fi rst part of this section, which covers dealing with cells and 

simple functions. Those of you who have not worked with a 

spreadsheet before shouldn’t worry – although the world of 

OOo Calc can get very, very complicated if you have large 

amounts of data to deal with, it can also be very, very simple. 

A spreadsheet is a versatile tool that helps you do things with 

numbers and data, from the very simple to the very complex.

The spreadsheet is also like some sort of modern day forge, 

where the raw materials of information (say the results from an 

Working with numbers has never been easier! OOo Calc has 
all the tools you need to make sense of all kinds of figures.

Getting started with 
OpenOffice.org Calc

experiment or your monthly sales fi gures) are transformed into 

something more useful, like a pie chart or a short summary of 

profi t and loss. The beauty of it is, you can change the machinery 

in this particular workshop without too much effort.

If you’ve ever used 

Microsoft Excel before, 

you’ll have no problems

getting to grips with 

OpenOffice.org Calc.

Keyboard shortcuts

On the face of it, OOo Calc is functionally identical to MS 

Office. But that is not quite the full story. For example, 

Excel has many more defined functions than OOo Calc. 

This is not really a limitation, as pretty much all of the 

functions can be made by stringing together several of the 

existing ones, but it obviously does have an impact on 

compatibility if you try to import an Office spreadsheet 

that uses them. Fortunately, the functions in question are 

usually related to very niche uses of a spreadsheet, so the 

chances that they will cause a problem to you are slim.

The other problem is embedded macros. As a rule, you 

can’t expect Excel macros to run properly under OOo, 

because they use VisualBasic, which obviously isn’t a part 

of the OOo suite. You can make a lot of them run with 

some modifications though, and SUSE’s reworking of 

OpenOffice.org has much better support for this.

“As a rule, you can’t expect Excel 
macros to run properly under OOo 
without some modifications.”
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OpenOffice.org Calc: guide to the interface

1  Menus typical function locations.

2  File operations: Load, Save and Save As.

3  Export as PDF see p94 for more details.

4   Spellcheck activates a spell-check or the 

Check As You Type feature.

5   Cut, Copy and Paste applied to cells or ranges 

of cells.

6   Undo and Redo buttons for when you make 

mistakes.

7   Sort text or numerical ranges in ascending or 

descending order.

8   Navigation common OOo tools , including 

Zoom and Help.

9   Text Formatting choose a font and style for 

selected text.

10  Justifi cation numbers and text can be 

justifi ed in common ways.

11  Number formats common formats for your 

numbers – currency, decimal...

12  Range Selection type in a range or use the 

menu for previous selections.

13  Function wizard guides you through creating a 

function.

14  Cell contents the cell on the main sheet 

shows values, but this area will show you the 

function entered in that cell, and you can edit it 

directly here.

15  Columns labels start at A and go on to IV

16  Rows are numbered. Drag the dividers to get 

larger row heights!

17  Cells on the grid show their value and may 

have different styles depending on their 

properties (eg could be formatted to turn red 

when negative).

18  Charts can be embedded or standalone, and 

can refresh to show current values.

19  Notes individual cells can have non-printing 

notes attached, indicated by a small dot in the 

top right corner of the cell. Hold the mouse 

over them to see the note.

20   Hyperlink all sorts of objects can be 

embedded into a spreadsheet. This is a 

working hyperlink, which will also work when 

exported to PDF.

21   Embedded graphic an imported OLE object, 

in this case a graphic that was created in Ooo 

Draw.

22   Sheet tabs by default there are three sheets to 

each document. Right-click to add more or 

rename existing sheets to something more 

meaningful.

23  Status bar includes a handy timesaver, the 

right hand area contains a current sum and 

average for the selected area of cells.

1

2 3 4 5 6 7 8

9 10 11
12 13 14

15

16
17

18

19

20
21

22 23
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Calc: Common spreadsheet elements

All about cells
A cell is the smallest element in a spreadsheet document, the 

smallest building block if you like. The purpose of a cell is to hold 

one specifi c piece of information, a single blob of data. Now, in 

the world of spreadsheets, that could be a simple, literal value, 

such as a number or a piece of text. These are the simplest 

pieces of data managed by a spreadsheet because they do not 

depend on anything else, anywhere else. They are unchangeable, 

except of course, if you want to edit them to say something 

different.

It is not quite true to say that numbers and text are the same 

things either. A number has a value, and if you enter a number, 

Calc knows deep inside that something can be done with this 

number – it can be added, multiplied or subjected to all sorts of 

other things. By default, it will also be formatted as a number – 

there will be no leading 0s for example. Usually, if you enter a 

number, it is because ultimately you may want to actually do 

something with it, and so this is a good behaviour for Calc. But 

sometimes numbers are just text. A membership number, for 

example, might be 000013. In this case, you would want to keep 

the number with the leading 0s. You probably wouldn’t want to 

be able to add it or multiply it with another number, you wouldn’t 

want it to be counted as part of a summing function, and indeed, 

you may want to manipulate it as text. To force a cell value to be 

text rather than a number, you simply start it with a single quote 

mark ‘. Alternatively, you can change the format of the cell 

beforehand to be text. If you have already entered numbers, you 

can’t later convert them to text fi elds, so be careful.

Functions
One step up from a literal value is a function (often also called a 

formula). There are hundreds of built-in functions, covering 

everything from generating random numbers to calculating the 

compound interest on a loan. A function may depend on a single 

value, several discrete values, a range of values or any 

combination of these – it is in effect a tiny program all on its own. 

When you enter a function into a cell, the cell displays the result 

of that function, not the function itself. To edit the function, when 

you select the cell, you need to edit the function defi nition in the 

text area just above the main window.

To begin with, let’s consider a simple function fi rst. Suppose 

we were to function:

=2*6

into a cell. The cell would display the value 12, but if we select the 

cell, we will see the text 2*6 in the edit area just above the 

spreadsheet itself. Note that a function always begins with ‘=’, so 

that Calc knows there is something to calculate! This is a very 

simple function, because it is also a literal value – sure, Calc has 

to do some maths to work out the answer, but once it is done, the 

value will never change.

That’s all very well, but a load of functions that just calculate 

static results isn’t going to achieve much. Spreadsheets really 

come in handy when the results of one calculation are passed 

into another one. This is done by referring to a different cell, and 

the text you use to do that is called a reference. As you have 

probably noticed by now, the spreadsheet is arranged in rows 

and columns of cells, so each cell can easily be identifi ed by its 

coordinates on that grid – by referring to the column and row 

that it is in, quite similar to grid references on a map. Columns 

are labelled with letters, and the rows with numbers, and it has 

become the standard to use the column reference fi rst. So, the 

reference for the fi rst cell in the spreadsheet is A1. Now, assume 

that we have the value 6 already entered into cell A1. We can now 

enter the following function in cell A2:

=A1 * 2

When the spreadsheet comes to evaluate this function, it sees 

the reference, and goes off to calculate whatever is in cell A1, 

then substitutes that result into the function, and in this case, 

would come up with the answer 12.

The real power of this is that now if you change the value 

entered into A1, say to the number 5, then without doing 

anything else, the value in A2 will change to be 10. The 

spreadsheet is like a very customiseable calculator, and with a 

combination of functions and references, you can build up a very 

complicated computing engine.

Circular references are something you need to beware of, 

because they can be rather tricky to track down. What is a 

circular reference? Well, say you assigned the value of 3 to cell 

A1. Now you assign B1 to be A1. Then you assign C1 to be B1*2. 

Now you go back to A1 and assign it to be equal to C1-1.  What 

happens? All the cells you entered will now show the text #name 

 Functions that 

reference other cells 

are the key to making 

the spreadsheet 

display complicated 

and useful calculations.

 You can use the text formatting controls to make the 

spreadsheet easier to read, or just to look nicer.
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?, which is shorthand for “I don’t know what’s going on, but I 

can’t resolve the contents of this cell”. Whenever you enter data 

on the spreadsheet, and it references another cell, that cell is 

recalculated. In this case, when Calc tried to work out the value 

for C1, it eventually worked its way back to A1, whose value was 

indeterminate – the cells are trying to reference each other, so it 

is impossible to calculate a working value. 

Usually this sort of error is just that. In the scheme of things, 

you are unlikely to intentionally create a circular reference, and 

when you do, it’s usually because you are trying to do something 

you didn’t really mean to do, or at least, didn’t really mean to do 

in that particular spot, so fi xing the error, moving the data 

somewhere else, shouldn’t be so hard. In most spreadsheets, 

data fl ows from one part, through loads of functions, to the end, 

possibly a chart. It very rarely fl ows in two directions, just as you 

don’t often see a river fl owing backwards. 

Using ranges 
Some functions require a range of values to work, rather than a 

single cell. For example, the function Average(...) returns the 

average of a list of numbers. This can be a list of literal values 

(1,2,3,4) or cell references, or more usefully, a cell range. A Range 

is defi ned by the start and end cell references, separated by a 

colon. So, A1:A7 is the range of values contained in the seven 

cells at the top of column A. A range doesn’t have to be a single 

column or row, it could include a number of either. So, A1:C3 is a 

range of nine cells: A1,A2,A3,B1,B2,B3,C1,C2,C3.

You should be careful with ranges though, as some functions 

require a range to be in a single column.

You may also sometimes see values in ranges with a dollar 

sign in front  like this: $A$1. This signifi es that the reference is an 

absolute reference and should always link to that cell. What’s the 

point of that? Well, it becomes useful when copying and pasting 

functions or cell references. Say you have a column A with prices 

in, and you want to have another column with prices plus VAT. In 

B1 you would enter the function =A1*1.175. That’s all simple 

enough. But now, say your column in A contains 100 prices! It 

would take ages to manually enter the formulae for each element 

 Cutting and pasting 

functions automatically 

updates relative cell 

references, unless you 

use the $ before the 

column or row or both.

in column B. So, you can simply copy and paste them. select B1 

and then hit Ctrl-C to copy the contents. Now click and drag to 

select all of the range B2 to B100. Now Press Ctrl-V to paste the 

function in. If you click on a cell in the B column, say, B13, you will 

see it contains the function =A13*1.175. By default, in pasting 

operations, Calc will use relative references. So if you copy 

something from B1 and put it in B4, all the cell references are 

adjusted by the same amount. 

Sometimes, you don’t want this to happen, and in those cases 

you should insert the $ symbol before the column or the row or 

both to lock it. When you paste such values, the exact reference 

is always maintained.

Now you know a little bit about how the spreadsheet actually 

works. Over the next few sections we will be looking at more 

advanced features of the spreadsheet, and how to perform 

simple and complex tasks.  LXF

 Some functions need 

a range of values to 

work properly, so get 

used to working with 

them.
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E
very proud parent or intrepid traveller loves 

to share their pictures with their friends, 

family and just about everyone who stands 

still long enough. But the age of the plastic photo 

album is long gone: if people are going to sit 

through 200 slides of your trip to Bognor Regis, 

they at least want to see them in vibrant colour 

with some explanation of what’s going on. This is 

the perfect use for OOo Impress, because it’s a 

presentation tool at heart, and has lots of clever 

ways to make your slides be more exciting.

In this tutorial you’ll learn how to create a photo 

slideshow using Impress, and also how to add text 

and animations to the effects to make them a bit 

more interesting. All you’ll need to follow along are 

some pictures of your own – any will do, even the 

wallpapers you use for your computer’s desktop 

are good enough for testing.

Although we're not about to go 

into the niceties of design, there are a 

few quick tips you should know before 

creating a photo slideshow:

1  Let the pictures do the talking. You don’t need 

lots of words on the screen – restrict it to a place 

name or the names of people in the photograph at 

the most.

2  Use your pictures at the largest size you can. 

They are the most important thing in this 

presentation, after all!

3  Don’t use a garish theme. Darker, more subtle 

tones are less likely to clash with the colours of 

your pictures. The exception to this is if your 

pictures share a common colour tone (eg blue if 

Get started with... 
Impress

they are pictures from a sailing holiday). In this 

situation, a nice blue slide theme would 

complement the pictures.

Finally, if you are already an experienced 

PowerPoint user, don’t just skip over this 

introduction – you might find a few hints and tips 

in here that will help you migrate to OOo Impress! 

The techniques shown here are common to all 

Impress presentations: you’ll learn how to create 

slides, assemble text and pictures, add animations, 

and build up a finished presentation from scratch, 

which are the real fundamentals of OOo Impress.

With that out of the way, let’s get started...

Learn how to make a slideshow of your photos 
using OpenOffice.org’s presentation tool...

1  Create a presentation
When you start OOo Impress for the fi rst time, the 

Presentation Wizard launches. The default option is 

to create an empty presentation, but it’d be 

benefi cial to have Impress do some of the 

groundwork for us at this time. So, change the 

selected option to From Template, then click Next.

2  Appearance choices
On the second screen of the wizard, you can 

choose how you want your slides to appear. The 

selection of themes available is pretty weak by 

default, so just leave it as Dark Blue with Orange. 

However, you should change the output medium 

option to the way you intend to show your 

presentation – we chose screen, because this will 

be shown on a computer. Click Next.

3  Animation effects
If you want to set a default slide animation effect, 

you can do that now. But we’d recommend you 

leave it off – it’s best to add effects as needed, 

rather than as a rule. However, if you ever want to 

create an automated slideshow that moves from 

slide to slide without your input, you can set that 

here. For now, just click Next.

Impress: Create a photo slideshow

LXFS13.impress_started   Sec1:38 15/4/08   11:16:04



  Linux starter pack      39

OpenOffice.org – Impress

4  The opening slide
OOo Impress can create a very basic opening slide 

for us, just as a starting point. To utilise that, enter 

some text in the company name and presentation 

subject fi elds, then click Next. The Further Ideas 

box is rather pointless, so you can safely ignore it.

5  Wizard results
OK, the OOo Impress presentation wizard has 

fi nished, and has magicked up this simple – but 

remarkably ugly – presentation, and inserted some 

basic text for us. It’s a long, long way from looking 

good, but that’s OK – we can fi x that pretty quickly.

6  Colour changing
To change the title colour from salmon to white, 

click on it. A box appears around the text, to show 

it’s selected. Click and drag over the text so it’s 

selected, then look for a toolbar button with an A 

underlined in salmon colour. Click the down arrow 

next to that, and click the white colour palette.

7  Changes to the master slide
If you try deleting the lines at the bottom, you’ll 

notice you can’t modify them. That’s because they 

are in the master slide, so that they automatically 

appear in all the slides you create. To delete them, 

click View > Master > Slide Master, then click the 

lines with your mouse and press the Delete key.

8  Setting defaults
While you’re here, you might as well set the default 

title colour to be white – use the same procedure 

from Step 6. If you want to change the background 

colour, click Format > Page, then choose the 

Background tab and select a colour you prefer. 

When you’re done, click the fl oating Close Master 

View button to go back to the fi rst slide. 

9  Type in your title text
This fi rst slide is going to hold a bit of text about 

this presentation, so click on the default text (it’s 

“Linux Format” for me) and type in some text of 

your own. When you press Enter, Impress creates a 

new bullet point automatically.

10 Add a second slide
There’s only so much you can do with a single slide, 

so let’s add a second one: right-click in the Slides 

pane on the left of the Impress window, and choose 

New Slide from the menu that appears. This will 

have the basic layout from the master slide, so it’ll 

be dark blue with a title and some text.

11 Title tweaking
Change the title to be a one-line description of your 

fi rst picture, then click the Centre button from the 

toolbar. Now, drag a picture from your computer 

into the Impress window, and it will appear in the 

slide. You can drag around the green boxes on the 

edges to resize the picture.

12 Removing text boxes
If you look carefully, you’ll see a thin grey box 

around your picture – that’s the text box behind it. 

As we’re just showing a picture here, that text box 

isn’t needed, so you can either delete it by selecting 

it and hitting the Delete key, or you can just click the 

Title Only slide layout from the right – it’s the fi rst 

one on the third row of layouts.
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13 The more slides, the merrier
Now go ahead and add a few more slides, giving 

each one its own title and its own picture. Don’t be 

afraid to try some of the other layouts from the 

Layout pane, because it adds some variation. For 

example, why not try making every third slide have 

text and a picture on?

14 Transitions
That’s the basic presentation made, so let’s make 

the slides blend together smoothly to result in the 

presentation looking a bit nicer. To do that, click the 

fi rst slide, hold down Shift, then click the last slide – 

this selects them all. Now click the Slide Transition 

arrow on the bottom right of the window.

15 Live preview
Clicking an effect shows a live preview of how it will 

look. Here’s where most people go wrong: once you 

see the list of slide animations, people seem to love 

making every slide have a different transition, 

making ugly presentations. Keep it simple: scroll 

down the list of options and choose Fade Smoothly.

16 Preview your slideshow
As you selected all the slides before applying a 

transition, that transition gets used for all the slides. 

If you press F5, Impress will launch your slideshow 

so you can see how it works – click your mouse to 

advance through slides. This picture was caught 

half-way through the fade transition.

17 Adding animation
Now let’s add some animations to individual 

elements. Again, you need to keep your “Tack Alert” 

set to maximum: no one likes tacky presentations, 

so keep it simple! Select something you want to 

animate, then click the Custom Animation arrow in 

the right pane. Now click Add.

18 The Star Wars-style wipe!
The default option, Appear, is dull in the extreme, so 

change it to Wipe. As with slide transitions, Impress 

automatically previews object animations so you 

can see how they will look – this is how the Wipe 

animation looks part-way through. Click OK to add 

the animation.

19 Wipe direction
The default wipe animation is set to From Bottom, 

meaning that the wipe moves from bottom to top. 

Click the “...” button to the right of that selection 

box, and a new window will appear where you can 

customise the animation.

20 Text animation options
From this window, change the direction to be From 

Left, then go to the Text Animation tab and choose 

By 1st Level Paragraphs for the Group Text option. 

This should make the text appear on screen one 

bullet at a time.

21 Precise adjustment
When you click OK to save the changed effect, you 

should see the single animation break into multiple 

smaller ones in the Custom Animation pane – one 

bullet for each line in your text box. This lets you be 

more precise if you need it.

LXFS13.impress_started   Sec1:40 15/4/08   11:16:16



  Linux starter pack      41

OpenOffice.org – Impress

22 Text preview
Now that your presentation is done, you can 

preview all the text at once by switching to the 

Outline tab. These tabs are just above the slide 

layout, and you’ll be in Normal by default. The 

outline view lets you see your slides at a glance, as 

well as make changes if you want to.

23 Save your presentation
And now, you’re done: it’s time to save your 

presentation so that it’s safe on your hard disk. 

Click File > Save, then enter a fi lename. Remember, 

if you’re using OpenDocument Presentation fi le 

format (.odp fi les), Microsoft PowerPoint users 

won’t be able to view your work!

24 Convert to Adobe Flash
Impress can save your presentation as an Adobe 

Flash fi le; it doesn’t save any of the transitions, but 

it does store all your text and pictures, which makes 

it perfect for distribution to other people. To save as 

Flash, click File > Export, then choose Flash from 

the list of supported formats.

W
e’ve only scratched the surface of OOo 

Impress in this short primer, but you’ve 

managed to make a slide show using a 

master slide, pictures, transitions and animations, 

and even exported it to Flash format! That’s not 

bad going for the work of 30 minutes, but there’s 

lots more you can do with this presentation if you 

want to learn through a little exploration – here are 

some ideas to get you started...

 Edit the master slide to make it more 

interesting. A plain dark-blue background gets no 

one excited – why not try some of the drawing 

shapes (see the toolbar at the bottom) to see if 

you can add a few dark boxes to break up the 

background a little?

 Add some other media to your slides. We’ve 

only looked at pictures here, but Impress can 

handle movies and sounds just as well. In fact, you 

can even add sounds to your animations, but the 

effect is usually quite off-putting!

 Impress gives your slides numbers for their 

names by default; it can be hard to remember 

which slide is which. But if you right-click on a slide 

you can rename it. This is useful when you’re in the 

middle of a presentation – you can right-click on 

the screen and jump to a slide by its name.

 Made a slide you’re particularly happy with? 

See if you can figure out how to duplicate it, then 

modify the duplicate.

 Make your slideshow automated so that it 

changes slide every 10 seconds. In our examples, 

all the transitions and animations happened 

through a mouse click, but if you were looking 

carefully through the options you would have 

noticed that Impress lets you activate transitions 

after a set time passes.

 The Color/Grayscale option under the Edit 

menu lets you preview selected slides in either 

colour (the default), grayscale or plain black and 

white. Can you think of when this would be useful?

 Experiment with style options. As with Writer, 

Impress has its own range of styles to choose from. 

Going further
These affect the way the text appears, but also 

how indented it is on the screen (ie how important 

it is). Choose carefully!

So, that’s you all up to speed with OOo Impress, 

but if you want to push your presentation skills 

further there’s more to come – read on to see how 

Impress can help you with business presentations, 

and also read our top tips for giving the best 

presentations!  LXF

“In the middle of a presentation, 
right-click on the screen and jump 
to the slide of your choice.”
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E
veryone has lots of information to keep 

track of: phone numbers on your mobile 

phone, addresses in a notebook, events in a 

diary, shopping lists on paper stuck to your fridge, 

and so on – wouldn’t it be nice to have all that 

information in one place? Wouldn’t be it be nice to 

make it searchable, so that you can type in a few 

key words and pull up matching information? Well, 

that’s what Base offers to do for you: it’s a 

database program that stores information and 

makes it easy to find. 

In this tutorial you’ll learn how to create a CD 

database using Base, which means you’ll learn 

what databases and tables are, how to create them 

to fi t your needs, and how to enter data. As you 

follow this tutorial, customise it to fi t your needs – if 

you collect DVDs, stamps, spoons, or whatever, just 

change “CDs” for your type of collection!

Before we start, there are a few basic things you 

need to know:

1  Databases have lots of jargon that can be a bit 

confusing at fi rst. If this is your fi rst time using a 

database, don’t worry – it will all make sense!

2  When working with a database, sometimes your 

changes are saved automatically. This is very 

important: think changes through before you make 

them, because the Undo might not help you much!

3  One database in Base can hold many tables, as 

well as user interfaces to read from them and 

reports to make them print nicely. To give all these 

to someone else, you just need to give them one fi le.

4  Base is capable of connecting to bigger, more 

complicated databases that run on servers – 

though this is beyond the scope of this beginners’ 

tutorial.

If you have some experience with Microsoft 

Access, much of Base will look familiar to you, but 

we’d still advise you to take your time when 

following through this tutorial. At the very least, 

take a backup of your database before making any 

changes, just in case Base works a little differently 

to Access!

Storing data is easy, but searching it always used to be hard. 
However, now you’ve got OpenOffice.org Base on your side...

Get started 
with... Base

1  Database wizard 
When you start Base, the database wizard will 

automatically run. This lets you create a new local 

database (the default option), open one you 

created before, or connect to a database. That last 

option is for advanced users who want to connect 

to servers – just click Next for now.

2  Table design 
This screen is pretty superfl uous for beginners: if 

this is your fi rst time running Base, just click Finish. 

However, if you have used Base before and want to 

get straight to designing your tables, click the 

Create Tables Using Table Wizard option fi rst. We’ll 

just go with the fi rst option – click Finish.

Databases are the best way to store, search and sort large amounts of data.
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3  OpenDocument format 
All databases in Base are actually just fi les, so they 

need to be stored somewhere on your computer. In 

common with the other OpenOffi ce.org 

applications, Base uses OpenDocument format by 

default. Save your database as cdcollection in your 

documents folder.

4  Start work 
And now you’re in – Base has created the database 

and you’re ready to start working. Along the side 

are the four main views: Tables, Queries, Forms and 

Reports. Tables are where all your data is stored, so 

click that tab now.

 5  Ignore wizard 
In the Table tab there are three links at the top 

that are important: Create Table In Design View, 

Use Wizard to Create Table, Create View. The 

second option might sound easier, but it’s a bit 

long-winded – just click Create Table In Design 

View for now.

6   Table design views
This is the table design view. It’s split into three 

columns: the name of your fi elds, the type of data 

they hold, and their description (you can ignore 

that last one). Field names are things like First 

Name, Address, etc. 

7  First four fi elds 
Type these names into the fi rst four fi elds: ID, 

Name, Artist and Rating. By default, Base will set 

these to have the TEXT [VARCHAR] data type, 

which means it holds variable-length text. That is, 

Name could hold “Hello” or “Supercalifragilistic-

expialidocious”.

8  Set Integer 
Click the fi eld type for ID and set it to Integer 

[INTEGER]. This holds whole numbers, such as 3, 9 

and 349083439. Change Rating to be Tiny Integer 

[INTEGER]. This holds whole numbers up to 127.

9  Unique numbering 
That ID fi eld will hold a number that’s unique to 

every CD we add to this collection, so we don’t 

really want to be entering it ourselves. So click that 

fi eld, then look at the boxes of the bottom – change 

the AutoValue value from No to Yes.

10 Primary key 
Every table should have a ‘primary key’, which is a 

unique value that identifi es a row. For example, if 

you have two versions of the same album, the 

primary key lets you specify exactly which one you 

mean. Fortunately, our ID value is exactly this, so 

right-click on the green triangle next to the ID fi eld 

and click Primary Key.

11 Name your table
That’s your table design done, so click the little disk 

in the toolbar to save your work. This prompts you 

to give your table a name within the database, so 

enter “CDs”, then click OK. Note: this is not a 

fi lename – it’s just internal to your database.
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12 Save table 
When your table is saved, you can just close the 

design window to get back to the main Impress 

window from earlier. Except now you’ll see your 

CDs table listed under the Tables pane. Double-

click that to open it up for editing.

13 Table editing view 
This is the table editing view, which lets you type 

data into your CDs table. You can resize the 

columns at the top to make them bigger and easier 

to work with, which is particularly helpful if you 

want to type a lot into your fi elds.

14 New row 
Type “Mind Bomb” into the Name fi eld for the fi rst 

row, then “The The” into Artist. Notice that Base 

has <AutoField> in the ID row, because that takes 

care of itself. You’ll also notice that it automatically 

creates a new row for you, so you can add more 

fi elds easily.

15 Save value 
Now try entering “Fizz” for the rating for this CD. 

Once you press Enter to save the value, Base will 

automatically change that “Fizz” to be 0. This is 

because we told Base to accept a Tiny Integer 

value, which means it only accepts numbers -127 to 

127 – not text.

16 Enter more data 
Go ahead and type a few more fi elds in there so 

that we have something to work with. Make sure 

you have at least two CDs with the same rating, 

because we’ll be using that shortly. Remember, the 

ID number takes care of itself – you only need to fi ll 

in the Name, Artist and Rating fi elds.

17 Sort it out! 
Once you’ve added all your data, select the Name 

fi eld (do this by clicking the title “Name” above the 

fi rst row), then click the toolbar button that shows 

an A over a Z with a down-pointing arrow. This sorts 

the table alphabetically by the name of the CD.

18 AutoFilter 
Now try clicking on one of the ratings. For example, 

I gave Moby’s Play album 4/5, so I would click on 

the 4 in his row. Now click the toolbar icon marked 

with a funnel and a magic wand – this is the 

AutoFilter button. This fi lters by the current 

selection, so you’ll only see CDs with a 4/5 rating.

19 Hidden rows 
Don’t worry – the other rows are just hidden, rather 

than being deleted! If you want to get back to the 

original view of your table, which means removing 

any fi lter or sorting, you can click the button that 

shows a picture of a fi lter with a cross over it.

20 Deleting forever… careful!
If there’s a row you don’t want, you can delete it by 

right-clicking on the grey bar on its left and 

choosing Delete Rows. Remember, deleting a row is 

permanent: once it’s deleted, it’s gone forever!
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21 Back to main 
When you’re done editing your table, close the 

window and you’ll be back to the main Base 

window. To the right of the table list, you’ll see the 

word “None” – click the arrow next to it, then 

choose Document. This gives you a quick preview 

of the data in the selected table.

22 Create report 
Now let’s create a way to print off your CD 

collection quickly. This is best done using a report, 

which is a neatly formatted version of your table. So 

click the Reports tab, then look for the button at the 

top marked Use Wizard to Create Report.

23 Rate my CDs 
From the window that appears, choose the Name, 

Artist and Rating fi elds from your CDs table, then 

click the > button. This adds all the fi elds to the 

report, meaning that you want them all be shown. If 

you want to add all the fi elds, just click >>.

24 Now it’s personal! 
The next screen lets you choose how the fi elds are 

named in the report. For example, you might want 

your Rating fi eld to be marked as “My Personal 

Rating”. This is more important if you have fi eld 

names like LineManagerName that look bad when 

printed out.

25 Grouping levels 
When you click Next you can add grouping levels to 

your report, which is helpful if you have categories 

in your table. For example, if we had a “Type” fi eld 

so that we categorised CDs as pop, hip hop, rock, 

etc, that would be a good grouping level. But for 

now, just click Next.

26 Order, order! 
This next screen is important: it lets you choose 

how the CDs in your report should be ordered. As 

with the table sorts, this doesn’t actually change 

the order of your rows, but it makes your report a 

lot more useful! Tell Base to sort by Name, then 

click Next.

27 Grand designs 
Now you get to choose how your report ought to 

look. The default layouts aren’t great, but that’s OK 

– having a complicated design for a report just 

makes the information look cluttered! Choose 

something simple, then click Finish.

28 And fi nally! 
That’s it – your report is done! You’ll see that it pulls 

your data straight from your table, then reformats it 

using your report style so that it looks more 

attractive. You can now print the report out, and 

relax: your CD collection is perfectly organised.  LXF
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I
f you need to create documents for any reason, Linux 

comes with some top-rate applications for you to use. 

Inkscape is a vector illustration package. Because it 

draws objects as shapes rather than pixels, the pictures 

you create with it can be resized and used as big or small as 

you want them with no loss of quality (unlike a raster graphics 

application, such as Gimp or Photoshop). It is a very capable 

drawing package, with features to match some of the very best 

commercial software on any platform, and it uses the Scalable 

Vector Graphics file format, a standard for vector graphics on 

the web.

Scribus is a desktop publishing program – in other words, a 

word processor with plenty of extras! You can use it to produce 

everything from flyers for the school disco to proper 

magazines (see Linux Format issue 96!). Scribus has plenty of 

tools for creating stunning documents, but drawing complex 

graphics is easier in Inkscape. The object of this tutorial is to 

show you how to use them together to create a library of great 

graphics for whatever you need.

First we will create a rubber-stamp effect in Inkscape, then 

import it into Scribus and look at the Scrapbook feature. Open 

up Scribus and Inkscape from the Applications > Graphics 

menu and get ready to create great graphics…

Creating documents with 
Inkscape and Scribus
What’s better than a great design application? Two great design applications!

Fire up Inkscape from the Applications > Graphics menu. To start 

with we want to create a texture for our stamp effect, and all great 

textures start with a rectangle. Use the shape tool to drag out a big black box 

at the top of the page.

Now choose the calligraphy tool (it looks like a pen). In the tool bar, set 

the width to 15 and ‘tremor’ to 0.4. Now squiggle over the rectangle, 

trying to cover it, but not completely. The gaps will give our ‘grungy’ effect.

Step by step: Create a simple document

 Not only does the latest version of Scribus serve as a versatile, professional design 

tool, it’s also a great Linux-based tool for making PDFs.

1 2
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Leave the object for now. Let’s create the text for our stamp. Choose 

the text tool from the left-hand panel, then click on the page and type 

out your word. Select all the text and choose Text > Text And Font from the 

menu. Choose a nice font and size for your object.

With the object selected, choose Object > Fill And Stroke. Under the Fill 

tab, choose the Pattern Fill option. As you have only one pattern, it will 

be automatically selected and applied. If it doesn’t look right, tweak the original 

pattern object and repeat from step 5.

Leaving your scribbles selected, choose Path > Simplify from the menu 

(or use Control+L). This will round off the edges of the scribbles a bit. 

Feel free to do it more than once to get a smoother, more natural effect.

Use Control+A to select all the objects, then choose Path > 

Intersection. This merges the paths of these two shapes together, 

so now you have one object – a black rectangle with bits missing.

Click on the object and drag the corners to resize it. We don’t want huge 

chunks out of our design, and it will probably look better if the holes are 

squashed a little in one direction, so try resizing it to a smaller square shape.

Use the palette along the bottom to select a good colour for your 

texture. Now choose Object > Pattern > Objects to Pattern to create a 

new pattern from this shape.

3 4

5 6

7 8
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Before we go any further, we should save this fi le as an Inkscape SVG 

fi le. Inkscape supports many different formats, but some of them may 

lose data or make the fi le hard to change if we want to edit it later.

Because of the use of patterns, we can’t import the vector illustration 

into Scribus. The next best thing is to export a bitmap. Choose File > 

Export Bitmap. In the window that opens, set the resolution to 350dpi, which 

is good enough for any sort of printing you may want to do.

Now use the Line tool from the left-hand panel and draw a bar across 

the top of the text. Click once to start, then hold down the Control key 

to lock the angle. Draw a straight line over the top of the text.

Open the Object > Fill And Stroke panel again. This time, click on the 

Stroke tab, and again choose a pattern fi ll. Stroke is the name given 

to the edge of an object, and as a line only has edges, this is where we need 

to set its options.

Duplicate the line by pressing the Control and D keys. The new line will 

appear on top of the fi rst. Now just use the Down arrow key to nudge it 

down until it is a suitable distance under the text.

Before we do anything else, delete the original pattern box and press 

Shift+Control+D. Now click on the ‘Fit Page To Selection’ button to re-

scale the document to just the bits we want.

9 10

11 12
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Once your regular objects are set up as you would like, you can save 

them to the Scribus scrapbook. This feature allows you to save 

common graphics and create a handy library. Right-click on an object and 

choose Send To Scrapbook

Now, with the scrapbook open, you can just drag elements from its 

window on to the page you’re working on. Create a big library of 

graphics and you’ll save yourself a lot of time! There’s plenty of fun to be had 

with Inkscape and Scribus!  LXF

Open Scribus and create a picture box (third icon along on the tool bar). 

Select the box and press Control+D to import a graphic. Use the fi le 

requester to fi nd the image fi le we just generated.

The stamp looks a little unrealistic when it’s not a little jiggly. Position the 

box and press F2 to get the Properties window. In the Geometry section, 

apply a small amount of rotation – say, 5 degrees – to get a good angle.

We can create some vectors in Inkscape that we can save in SVG 

format and import directly into Scribus for a better result. You can 

create complex objects, but Scribus will not handle gradients, blur, 

transparency or patterns.

Once you have imported a vector object into Scribus, you can change it. 

Apply shadow effects or gradient colours in Scribus, and you can still 

enjoy the fl exibility of vectors.

15 16
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Y
ou might think that an entire section 

dedicated to the delicate art of 

working with photos is a little 

ambitious. But it’s not. Digital 

photography is booming, and Linux is a great 

choice for working with photos. From sending a 

few images with an email or printing a birthday 

card with your favourite photo, to touching up 

professional images and creating websites, Linux 

is a more than up to the task. Thanks to apps like 

Gimp and F-Spot (application names aren’t 

Linux’s strong point), you don’t need to be an 

expert either. Using a few simple tools, you’ll 

soon be able to import photos from your camera, 

send them to the printers and process them to 

remove red eye and blemishes.

Work with photos
Now that cameras are cheaper than ever, we’ve all become photographers. Linux 
is the perfect partner, but first you need to get your photos on to your machine.

Plug and play Digital camera support in Linux is excellent. This means 

you will be able to simply connect the vast majority of cameras to your 

machine to access your photos. Nearly all will use a USB connection, with a 

small plug on one end (known as mini USB) and a larger one on the other that 

connects to a USB port on your PC. As soon as you’ve made the connection, 

both your Linux desktop and the camera should spring into life. If all has gone 

well, a small window will appear to tell you that your camera has been 

detected. Click on ‘Import’ to launch the ‘Import Photos’ window. 

1

Step by step: Get photos off your camera

Learn how to:
Import your photos

Manage your collection
Edit and process images

Join panorama shots
Sharing your photos

Advance to the Gimp

Importing photos Depending on how much space you have on your 

camera, you might not always want to import every image. This window 

lets you pick and choose the images that you want to import. To select photos 

individually, hold down the left Ctrl key and click on the thumbnails of the 

images you want to import. You can also press Ctrl and A together to select 

everything. When you’re happy with your selection, give this collection a name 

in the ‘Film’ fi eld. You should also click on the small button to the right of the 

‘Categories’ fi eld. From here you can add ‘tags’ to your images, making them 

much easier to search through when your collection grows. 

2

View as thumbnails Depending on the number of photos you’re 

importing and the speed of your USB connection, you may need to wait 

a few minutes for your photos to copy over to your machine. When this has 

completed, your photos will be displayed in a program called GThumb. 

GThumb is Ubuntu’s default photo browser, and you should be able to see 

your entire album as a series of thumbnails. Double-clicking on any of these 

will open a single window containing the image, and you can skip from one 

photo to another using the Page Up and Page Down keys. Photos are saved 

into the Pictures directory, which you can open directly from the ‘Places’ 

menu. Each folder will be given the name of the roll you used when you 

imported the photos, and it’s easy to copy the photos from these folders on to 

a USB stick, or even on to a blank  CD – just click on CD/DVD creator from the 

same Places menu, and drag the albums you want to burn into the new 

window, insert a blank disc and click on ‘Write To Disc’.

3
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Collection 
management
Don’t get bogged down in photos – get yourself organised!

F-Spot There’s nothing wrong with GThumb but it just so happens that 

there’s a better application in Ubuntu for managing your photos. It’s 

called F-Spot and it’s better suited to larger collections. This is because you 

can organise your photos into albums, send them to the printers, or export 

them as a website from within a single application. F-Spot can be started from 

the Applications > Graphics menu, and the fi rst window you see will ask you 

for the location of any photos you might already have. If you’ve just imported 

photos from your camera, click twice on the ‘Select Folder’ button. This will 

open another window from where you can point F-Spot at the folder that 

contains your images. You should then click on the ‘Pictures’ folder and click 

on ‘Open’. F-Spot will now scan the folder for your images, showing the results 

as thumbnails in the main few. When this has completed, click on ‘Import’ to 

add them to F-Spot. If you need to fi nd your photos in the fi lesystem, F-Spot 

uses Photos by default (this is a different location to the one used by 

GThumb) but this can be changed from the Preferences window.

1

Step by step: Organise a large collection

Comments The fi rst thing you might want to do is add comments for 

the photos you’ve just imported. Comments are the 21st century 

equivalent of writing on the back of the photo, and while it may seem slightly 

tedious to begin with, you’ll soon be grateful you took the time to write a line or 

two about what’s going on in the photo. To add a comment, double-click on the 

thumbnail to open the photo, and use the ‘Comment’ fi eld just below the main 

window. You can quickly skip through the album using the cursor keys, adding 

a comment to each new image. Comments like these are attached directly to 

the photo, so you don’t need to worry about saving your changes to a fi le. 

Similarly, you can add tags by dragging their icons from the left-hand panel on 

to the photos you want to label. Right-click in the label panel to create your 

own, and don’t forget your photos can have more than one comment!

2

Organising If you’ve ever used Apple’s iPhoto, you’ll feel right at home 

with the way F-Spot manages photos. By default, every image in your 

collection is listed in the large thumbnail view. A date strip at the top of the 

window draws small bars that represent the number of photos you have from 

a certain time frame, and you can scroll through the time frame by dragging 

the cursor across the date strip. The key to organising your collection in F-Spot 

is the tag system. At any point, you can double-click on the icon in the tag 

panel to fi lter your collection into photos that only have that tag marked 

against them. This makes it easy to see all photos of your family, for example, 

or those you’ve taken on holiday. As long as you’ve gone to the trouble of 

tagging your photos as you import them, this added tag dimension makes 

your collection much easier to manage. If you double-click on a tag, you can 

change the icon it uses. Tags also have a hierarchy where they inherit the same 

tag as their parent – for example, you might want to create a Family tag and 

make the ‘People’ tag its parent. You will then see Family photos whenever you 

click on either the ‘People’ tag (as Family is a member of this group), or the 

‘Family’ tag.

3

You can import your photos into F-Spot without going 

through GThumb first. Connect your camera, and 

select ‘Import’ from F-Spot’s File menu. Click on the 

‘Select Folder’ icon, and you will see your camera in 

the drop-down list. Choose this, and you’ll be able to 

add your photos directly.

Quick tip
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Image 
processing
It’s great fun to mess around with your images after you’ve taken them…

Crop and rotate Two of the more common problems with photos can 

be easily solved with F-Spot. The fi rst is the need to crop an image, 

cutting the edges around a photo to make some detail larger. In F-Spot, 

double-click on the image you want to edit so that it now occupies the whole 

window. Now use the mouse to drag a selection square across the image that 

includes the area of the photo you want to keep. You might have noticed a 

small toolbar at the bottom – we need the one that looks a little like a scalpel. 

Clicking on this will remove everything in the image except the area you 

selected. If you need to straighten up your photo, you can use another icon on 

the toolbar – the one that looks like a red arrow coming out of an envelope. 

Click on this and a smaller window appears with a single draggable slider. This 

slider changes the angle of the image, which will update in real time as you 

drag it from one side to the other. When you’re happy with the new angle, click 

on Apply to make the change permanent. 

1

Step by step: Basic image editing

Colour adjustment Compensating for under or over exposed 

photographs taken in less than ideal conditions can be complicated. But 

there are a few simple adjustments you can make that can make a world of 

difference, and these can be accomplished from the ‘Adjust Colour’ window. 

Open the Adjust Colour window from the Edit Image view, either from the Edit 

menu or by clicking on the three colour circles in the toolbar. The array of 

sliders laid out beneath a colourful histogram may look technical, but it’s really 

quite straightforward. The histogram is a graph that illustrates the dynamic 

range of each colour within the image. For best results, your image’s histogram 

should touch all four sides of this window, maximising the dynamic range of 

the image. Increase the contrast slightly, and you’ll see your image become 

more polarised, and the histogram stretches slightly. If your image is a little 

dull, try adding more saturation, and if it was taken under electric light, you can 

correct an artifi cial hue by altering the ‘Temp’ and ‘Tint’ sliders. 

2

Red eye Red eye is the blight of many fl ash photographs involving 

people. It’s caused by the fl ash being too close to the lens, and the light 

from the fl ash is refl ected directly off the retina back into the lens. The red 

colour is a result of the light being fi ltered by a blood-rich part of the inner eye, 

and while this often adds a demonic appearance to the photo, the saturated 

red colour helps to make the red eye effect easy to remove. F-Spot even has a 

built in function. In the Image Edit window, use the mouse to select the area 

directly around the eye (this is so that other areas of red within the photograph 

aren’t processed). With the area selected, click on the ‘Red Eye Removal’ 

button in the toolbar. This looks something like a blue arrow hitting a red circle. 

The result should be that the redness in the eye dissolves, leaving a far less 

supernatural pose. You can repeat the process to remove more and more of 

the red colour. If this isn’t successful, or the process leaves too many side 

effects, then you’ll have to use a more serious image editing tool, such as Gimp.

3

If you make a mistake and want to revert to the 

original image, you can select the photo and click on 

File > Version > Original. You can also make your own 

versions of snapshots (for editing later, for example) 

by clicking on File > Create New Version. 

Quick tip
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 Hugin’s preview window lets you make a few changes and 

check that the alignment is correct.

 You can choose 

to edit the anchor 

points manually if 

you wish, but most 

of the time Hugin’s 

automatic settings 

can’t be beaten.

Join panoramic photos
Stitch a sweeping view together to create a large panoramic view from multiple 

Hugin can also be 

used to alter and 

remove perspective 

from photos – perfect 

for cityscapes and 

buildings.

Quick tip

Many digital cameras come with a panorama function. This is 

normally used to take several panoramic shots of the horizon, 

sweeping the camera from left to right, for example. With 

panoramic mode enabled, each photo will have the same 

image settings, making it easier to stitch each one together 

again on a computer. Many cameras even come with software 

to help, but stitching the images together can still be an 

arduous process. You need to find sections of each adjoining 

image that are common to both before lining them up 

manually and moving on to the next image. Over the last year 

or two, the software that can help find these points within an 

image has improved dramatically, making the process almost 

automatic. Hugin is one of those pieces of software. It’s so 

successful at attaching panoramic images together, that the 

process has become largely automatic. 

Hugin quickstart
Hugin is launched from the Applications > Graphics menu, and 

uses a wizard-based interface to step you through the 

stitching process. The first step is to click on the ‘Load Images’ 

button. This will open a file requester, from which you will need 

to select every photo that’s part of the panorama. Don’t worry 

about the order – Hugin can work this out for itself. After 

you’ve clicked on ‘Open’, Hugin will try to determine the field of 

view from the first image. This can normally be extracted from 

the metadata that your camera embeds in the photo, but if 

Hugin can’t find the data, you’ll need to enter it manually. Don’t 

worry. For most cameras, just enter a number for the focal 

length multiplier that brings the HFOV to somewhere around 

50 degrees. After this, a text window will appear, and Hugin will 

begin processing each image to see if it can find any anchor 

points to pinpoint the same location in two or more images. 

Depending on the complexity, size and number of images, this 

could take anything from a few seconds to a few minutes. 

Stitch that
When the analysis has completed, Hugin will display a rough 

approximation of what it’s calculated the panorama to be. This 

is nearly always correct, but you can edit the centre point of 

the image as well as flatten the horizon using the buttons in 

the toolbar. Clicking on ‘Auto’ will update the display with your 

changes. The sliders at the bottom and side of the image will 

crop the edges, removing the distortion introduced as Hugin 

flattens the effect of the camera lens on each shot. 

If you close the preview window, you can see that the main 

Hugin interface is now full of useful information derived from 

the analysis. Click on the Control Points icon, for instance, and 

you can see exactly which features in each image Hugin is 

using to anchor one image to the next. If there are any errors, 

you can drag and move any of these points manually. When 

you’ve finished messing around, you need to generate the final 

image. Open the ‘Stitcher’ tab, and click on ‘Stitch Now’, a file 

requester will open asking where you’d like to save the final 

photo. Like the analysis, the stitching can take some time, 

running through a progress bar before opening another text 

window. But when it’s finished, you’ll find yourself with a 

perfect rendering of the stitched panorama. 

 The end result is a 

seamless panorama.
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Sharing your photos
Now that you’ve got your photos organised and edited, it’s time to share them.

 You can export 

your photos 

directly from 

F-Spot to many of 

the more popular 

online photo 

repositories.

 Many internet providers give you web space as part of an 

online package, and you can use this to host your web albums.

There’s no point going to all this trouble with your photo 

collection if you’re never going to let other people see them. 

And in the age of the internet, that means sharing your photos 

with people online. There are as many different methods for 

uploading as there are websites, from sharing a few images 

privately with family and friends, to turning your camera lens 

into a window on your life for the whole internet to see – it’s up 

to you. 

F-Spot, the application we’ve been using for managing and 

editing our photos, can export your images to many of the 

more popular photo websites, as well as your own if you run 

one. You can see which sites are supported by opening the File 

> Export menu. The list includes names like Flickr, Picasa Web 

Albums and SmugMug. Each of these is an online photo 

repository. The first two offer a free hosting service for your 

own photos, while all three offer commercial packages that are 

tuned for the more serious photographer. If you want an 

informal, easy-to-use online photo presence, then choosing 

one of these options is likely to be the best option. You can 

choose to keep photos private, share them with your friends or 

family, as well as making them publicly visible.

Flickr, Picasa and SmugMug
Each service works in roughly the same way. The first step is 

to create an account with the host of your choice. This account 

information is needed by F-Spot so that it can automatically 

communicate with the remote site while sending your photos. 

With Flickr, for example, when you select the export module 

from F-Spot, you need to click on the large Authorise button. 

This will load the Flickr site into a web browser, and from here 

you’ll need to log in to your Flickr account, before heading 

back to F-Spot and clicking on the Continue Authorisation 

button. This will then update both Flickr and F-Spot with the 

details they need to talk to one another. With the export 

windows for both Google Picasa and SmugMug, you need to 

click on the green ‘plus’ symbol in the Export window and add 

your username and password for the remote site. These 

details will be remembered by F-Spot so that you don’t need to 

enter them again. 

But before you export any images, it’s worth spending 

some time writing comments for them and giving them titles. 

All this information is used by the online hosting site. Flickr will 

even use any tags you’ve assigned to the image, making a 

search your own photos (and anyone else’s) much easier. Any 

photos you select will be exported, and you can select 

individual thumbnails by holding down the Ctrl key. If none are 

selected, all the photos in the current view or album will be 

included by default. After choosing your export profile, you 

may want to resize the images before they’re uploaded. Both 

the free user accounts on Flickr and Picasa place a restriction 

on the size of the images you upload, and restricting your 

exported images to a resolution such as 1024x768 is a great 

way to get extra space. This is big enough for most web users, 

and small enough that the file size isn’t prohibitively large. To 

enable this feature, make sure Resize is enabled, and set the 

size to 1024 pixels – this will be the scaled length of the 

longest side.

Host your own
If you’d rather not be limited by the hosting company, you 

might want to consider hosting your own photos. This 

obviously requires a little more technical ability, but exporting 

an album is still an easy task. If you’ve got your own web space 

and you’re using the PHP application Gallery, F-Spot can 

export images and create the necessary web pages 

automatically. For this option, select ‘Export To Web Gallery’ 

from the Export menu. In the window that appears, press the 

large Add button and enter the details for your website, 

including the full URL, a username and password. F-Spot will 

then create a new album each time you export your images. If 

you’d rather do things by hand, you can also export an HTML 
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 If you have a 

Flickr account, you 

need to authorise 

F-Spot to be able 

to use it. With 

other online sites, 

you just need 

to enter your 

username and 

password.

 Sometimes, it’s easier to export the files manually, zip them 

into a single file and attach this to an email.

Many people are scared of the term ‘image resolution’. But 

when you’re trying to publish your photos – either online or 

on to real paper, there’s no avoiding it. 

Digital images are made up of coloured pixels. These are 

the squares you see when you look closely at a digital 

image, or use the zoom feature of a graphics editor. Your 

screen’s display is drawn using pixels with a common 

screen resolution being 1024x768, for example. This means 

there are 1024 pixels across the screen, and 768 down. If 

you want to know the total number of pixels on the screen, 

then you need to multiply those two numbers together – 

1,024x768 = 786,432. Digital camera resolutions are often 

described by counting the total number of pixels, with the 

term ‘megapixel’ used as shorthand for a million pixels. Our 

screen resolution would therefore be 0.78 megapixels 

(MP). If your camera has a resolution of 3MP, an image 

from the camera would be roughly four times the size of 

the screen. Another common way of expressing pixel 

resolution is by pixels per inch, or dots per inch (DPI). 

These both refer to the number of horizontal pixels that fit 

into an inch of length, and they normally apply to printing 

and scanning. If your screen is 17 inches wide, for instance, 

it’s working at 60DPI (1024/17). If you scan a five-inch 

photo at 600DPI, it will be 3,000 pixels wide (6 multiplied 

by 600), and be about three times the width of your 

screen. This means that if you want to send the image to 

someone with a similar screen to your own, you need to 

reduce the image by at least 66%.

 A 5 megapixel camera will generate images that are well over four times the size of a 

1024x768 display.

album that you can just place on a web browser. F-Spot does 

all the hard work for you. Just select ‘Folder’ as the export 

option, and make sure you select ‘Create Standalone Web 

Gallery’. You might also want to resize the images to something 

more manageable. Clicking on ‘OK’ will generate the website 

and place it in your home directory by default. If you navigate 

to this folder and double click on the index.html file, you’ll be 

able to see the website in the Firefox web browser. When 

you’re sure everything is correct, just upload the folder to your 

web space to create an online album.

Sending an email
The easiest way to get photos out into the wide world is to 

attach them to an email. F-Spot can even help with this if you 

use the Evolution email client. Select the photos you want to 

send and click on ‘Send Mail’ in the File menu. A smaller 

window will appear, and from here you should scale the photos 

you want to send – people who still use dial-up modems won’t 

appreciate anything larger than ‘small’. Click on Create Mail 

and Evolution will open, from which you can send the images. 

If you attach more than a couple of images, an email will 

quickly get a little unwieldy, as well as difficult to read. The 

answer is to bundle up your images into a single file, a process 

known as ‘zipping’. Do this by exporting your images to a folder, 

in much the same way we did to generate a website. But this 

time, select ‘Save Files Only’ so that the website isn’t 

generated, and resize to something sensible like 800. When 

the process has completed, you need to navigate to the 

location where the folder was saved. Try clicking on the Home 

folder from the Places menu. When you locate your gallery, 

right-click on the folder and select ‘Create Archive’. From the 

window that appears, choose ‘zip’ from the drop-down format 

list and click on ‘Create’. This will create a zip file you can 

attach to an email.

Understanding resolution
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Advanced photo 
editing with Gimp
If no other tool can do the work you need, it’s time to get acquainted with Gimp. 
It’s the closest Linux users get to a native version of Adobe’s Photoshop.

 Drop shadows and effects make good use of layers in Gimp. 

The shadow is one layer, while the effect is another.

 New text is 

always placed in 

its own layer. This 

means it can move 

freely, and as long 

as you haven’t 

flattened the layer, 

it can even be 

edited.

Linux developers aren’t that good at coming up with good 

names for their work. Gimp is possibly the worst example of 

this, because the functionality that hides behind that 

ridiculous name makes Gimp a serious competitor to the likes 

of Adobe’s Photoshop. On the Linux desktop, Gimp is the last 

word in image editing and photo manipulation. If you need to 

fix something, this is what you need to finish the task. The only 

problem is that, like its Adobe sibling, this amount of flexibility 

brings complexity. Gimp isn’t easy to use, and there’s 

something of a learning curve. This is a consequence of the 

trade-off between flexibility and complexity. For example, with 

even the most straightforward editing functions, you will need 

to get your head around layers and how editing an image in 

one layer will effect the final result. This might seem overly 

complex if all you want to do is add some text to your photos, 

but the addition of layers means you can easily add drop 

shadows and bevel effects.  

What are layers?
Layers are like the onion skin paper that animators used to use 

to create cartoons. Before CGI took over the world , an artist 

would draw an image of a face, perhaps Mickey Mouse, and 

animate a dozen expressions on to that single face by simply 

drawing the expressions on top of a new layer of onion skin. 

The viewer would never know they were really looking at a 

smile drawn on top of a transparent layer, with the static face 

drawn behind. It meant the artist didn’t need to laboriously 

draw a new face each time an expression changed or when the 

character needed to speak. While layers in Gimp aren’t 

primarily designed for animation, they benefit from the same 

advantages as the old artist had drawing on onion skin. Images 

on each layer are entirely independent of those beneath them 

(unless you choose to lock them to a lower layer), and 

transparent areas in higher layers will let image data through 

from the lower layers. For example, you might draw a brick wall 

in a lower layer and a square window in a higher layer. The 

window will be superimposed on the brick wall. Similarly, you 

could take two photos taken from the same location and use 

the best bits of both to construct a new image. You can also 

process the image data in a lower layer with the image data in 

a higher layer, using this to lighten or darken lower pixels 

according to the data in the higher pixels. You could use this 

effect to trace a shadow of a higher image on to the pixel data 

of a lower image. There are more than 20 different layer filters, 

many of which are geared to fixing damaged photographs.

Text with shadows
The best way to get your head around layers is to use them. 

We’re going to show you how to put text on top of a photo, and 

generate a drop shadow from the text using layers. Open Gimp 

and load an image that will suit overlaid text – perhaps a 

design for a birthday or Christmas card. Adding text is as 

simple as clicking on the ‘A’ symbol in the tool palette, and 

clicking on the approximate position in the image you need the 

text. A text editing window will appear, and you can use this to 

enter the text you want to overlay on to the image. As you type, 

the text will show up on the background. You can change the 

size of the font using the window beneath the toolbar palette. 
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 Most effects in Gimp have a real-time preview. In this case, 

you can even warp the preview with your mouse.

The secret tool for magically removing blemishes is the 

Clone Tool. This looks a little like a rubber stamp, and 

that’s because a rubber stamp loosely describes how it 

works. It copies one area of an image to another area. 

But it does this in such a way that you can’t see the 

edges. For the process to be successful, you need to find 

an area within the image (or in another image) that you 

can use to replace the blemish. This usually means 

finding a place where the image is repeated. This could 

be a similar area of sky, grass or wall, for example. After 

selecting the Clone tool, hold the mouse over this 

replacement area, press Ctrl and click on the mouse to 

set the source of the clone operation. When you now 

click on the blemish, the area under the mouse will be 

replaced with the image at the source location. If you 

hold the mouse down, you can copy an entire area – 

useful for windows in a wall, for instance. If the wall is at 

an angle, try the perspective clone tool instead.  We’ve cloned the background 

over the bike’s pedal here.

This window is used to display any options associated with 

your current editing tool. With text entry, those extra options 

include size as well as choice of font, colour and paragraph 

formatting. Close the text editor when you’ve finished adding 

text. If you need to edit the text further, you can always select 

the Text Tool and double-click on the text to open the editor 

again. You may also need to fine-tune its position, which you 

can do with the Move tool.

If you take a look at the Layer window, you will now see two 

layers. The background contains your original image, while an 

additional layer will hold your text. This is why you can move 

the text freely above the image. For example, if you choose one 

of the filter effects while your text layer is selected, only the 

text will be affected. Try the Warp filter, found under Filters > 

Distorts. This effect opens a window from where you can drag 

and distort parts of the current layer. When you click on OK it’s 

only this layer that’s processed. After messing around with the 

filters and your text, try Drop Shadow and Bevel from the 

Filters > Light And Shadow menu. This will generate an extra 

layer that contains a shadow for the text, as well as adding a 

slight bevel to the text area. You can then select the shadow 

layer and move it around. It will keep above your original photo 

and beneath the text because of the ordering of the layers. You 

can change this order from the layer window by dragging each 

layer up and down. Unfortunately, unless you save your image 

using Gimp’s native image format (called XCF), this layer 

information will be lost. Saving your file as a JPEG or BMP, for 

instance, will ‘flatten’ the image. This means that each layer is 

merged into a single layer. It will look exactly the same, but you 

will no longer be able to process each layer separately.  LXF

Selects elliptical regionsSelects rectangular regions

Selects a hand-drawn region

Select regions by colour

Foreground select tool

Colour picker

Measure angles and distances

Align object and layers

Rotate the layer or selection

Shear the layer or selection

Flip axis of layer or selection

Fill area with colour or pattern

Pencil drawing tool (hard edges)

Erase to background colour (edges)

Draw in ink with brush shape

Heal image irregularities

Blur or sharpen

Dodge or burn strokes

Best-guess region selection

Select shapes from image

Create and edit paths

Zoom in and out

Move layers and selections

Crop or resize an image

Resize the layer or selection

Manipulate selection in 3D

Create text for a new layer

Fill with colour gradient

Brush drawing tool (soft edges)

Airbrush drawing tool (v. soft edges)

Clone areas and regions

Perspective clone tool

Smudge tool

Gimp’s toolbar

Removing blemishes

Gimp has all the tools you’d expect from a professional-quality image processing app. Here’s a run-down of what’s on offer…
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What we 
look at: W

e’ll get the bad news out of the way first. If 

you're an ardent PC gamer, you won't be able 

to play many of your favourite AAA titles on 

your new Linux desktop. 

Most games publishers don't feel that there's a big enough 

Linux market to warrant the extra time it would take to convert 

their titles to Linux. As a result, most of the big game releases 

you see on the Windows platform won't make it to Linux. But if 

games are your thing, you shouldn’t be disheartened. There 

are still some commercial game publishers porting their 

games to Linux, but more importantly, there's a thriving 

homebrew/DIY games community. This means that while 

many Linux games won't have quite the same production 

values that you may be used to with a commercial release, 

they more than make up for this with their creativity and 

innovation. It's a little like how gaming used to be before 

consoles made it big business. And the great thing about Linux 

games is that the overwhelming majority of them are free. 

Over the course of the next few pages, we're going to give you 

a brief tour, covering some of the best Linux games. Give 

yourself a couple of hours, then click on the Applications > 

Games menu to start the fun. 

Linux games
Games might not be the main reason why you've tried Linux, but it's likely to be 
one of the main reasons you don't look back.

Solitaire
T

he first game most people want 

to play when they fire up their 

new operating system is a card 

game, and Linux has plenty. You can find 

these without installing anything from 

the Applications > Game menu, and the 

two most popular are Klondike (more 

commonly known as Solitaire) and 

Freecell. Both of these games existed 

before computers, and both could be 

played alone with a pack of cards. 

With Klondike, 28 of the cards are 

laid face down in seven columns of 

increasing numbers. The top card on 

each column is turned over and the rest 

of the pack laid down to the side, a pile 

known as the ‘stock’. The idea of the 

game is to build four piles for each suit, 

starting with the ace and working up to 

the king. You can move cards across the 

columns as long they form a descending 

sequence of alternating colours. The top 

card of each column must always be 

turned over, and when you can do no 

more shuffling around with the columns, 

the top card from the stock is turned 

over, and you can choose to take this. If 

you're more used to the 'three card' deal 

from the stock, you can enable this 

option from the Klondike menu. Of 

course, on the desktop all the 

monotonous card management is done 

automatically, and all you have to worry 

about is building the four columns for 

each suit. 

 Suzanne Vega wrote a song called 

Solitaire about the addiction many people 

suffer for card games such as Klondike. 

Freecell
F

reecell is similar to Solitaire, 

except that all the cards are 

visible at the start of the game 

and are stacked into seven columns. You 

can move cards around these columns 

using the same stacking rules used for 

Solitaire. You have to shuffle the columns 

around to free the cards you need, 

starting with the aces, which need to be 

placed in the four cells top-right – 

building the suits just as you do in 

Solitaire. There’s more strategy involved, 

as you attempt to free the cards you 

need by moving cards across columns 

and into the freecells. 
 Freecell plays like Solitaire but is considered a more skilful game, as success is less 

reliant on the random order in which the cards appear in the shuffled deck.
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G
Compris is a suite of games 

designed to educate children 

between the ages of 2 and 10. 

Each game is a mass of colour, and there 

are over 80 activities for your children to 

play split into various categories. There 

are games that let players assemble 

famous paintings, games that teach 

them how to use a mouse (by playing a 

dot-to-dot) and games that involve 

simple arithmetic, spelling and even 

algebra. All feature beautiful 

presentation, including spoken 

instructions for many, and everything 

should be clear enough that your child 

can play unattended. 

Before you get started with the 

games, you need to create an account 

for your child so that their progress can 

be monitored and the games list tuned 

to their ability. The administration 

window is launched from the Education 

menu. From here you can even configure 

GCompris for classes of children. For 

individual players, just click on the 

‘Profiles’ button followed by ‘Add’. Click 

on OK to make the changes, then switch 

to the Boards view. From here you can 

assign what the child can and cannot 

play. Click on the filter button, and 

restrict the range to your child's ability. 

One, two or three stars should suit 2–6-

year-olds, while games adorned with the 

more complex star patterns are 

designed for those aged 6–10. 

You will be able to come back to the 

administration reports on the following 

page to see how well your child is going 

after they've some time playing games. 

The main application can be found in the 

Games menu, under ‘Educational suite 

GCompris’. A few moments later, you will 

be presented with the Home screen. It's 

from here that you (or your child) can 

launch any games they may want to 

play. Each game can be found under a 

sub category, with symbols representing 

each category listed down the left-hand 

side of the screen. Each game icon 

features one or more of the star icons 

we used to filter difficulty. The categories 

include puzzles, mathematics, strategy, 

reading, discovery, computing, 

amusement and experimentation. 

T
here can be few people who 

haven't discovered the joys 

of Sudoku in the newspaper 

on the train journey home. With Linux, 

it's also possible to play when you get 

home, although that might not always 

be a good thing if you've got a life to get 

on with. 

Sudoko is launched from the Game 

menu, and if you are one of the few who 

have never played it before, the matrix of 

numbers that greets you may seem a 

little intimidating. The idea of the game 

is that you have to work out what 

numbers should be in the blank spaces. 

These need to be a number between 1 

and 9, but you can only have one of each 

digit in each row and column. The other 

rule is that each smaller nine-segment 

square will also contain the numbers 

1–9. Between those two rules, you 

should be able to work out which 

number goes where. The best place to 

start is by looking at the nine square 

segment with the most filled squares. 

Work out which numbers are missing, 

and then work through the blank 

squares to see if any of the numbers will 

fit - remembering to make sure that the 

same number doesn't appear again in 

the row or column attached to the 

square. When you think you've found the 

number, double click on the square to 

select the digit from the pop up menu. 

It's easier than it sounds, at least to 

begin with. 

The game starts in beginner's mode, 

so you should be able to crack it. This 

version of Sudoku also has a couple of 

features that can make your life easier. 

You can make notes in the corners of the 

blank squares by double-clicking in 

either the top or bottom half and typing 

your note. These are commonly used to 

write down numbers that can potentially 

be used within the square. The 

highlighter button can also help to read 

across the current column and row. 

Clicking on Hint will fill the note field with 

a list of possible values for the selected 

square, and as a last resort, you can click 

on 'Fill' to automatically add the correct 

number to the current square. But 

where would be the fun in that? 

 With so many activities to choose from, GCompris should 

keep your children entertained for hours.

 Perhaps Sudoku's popularity is a direct result of the terrible 

train service we endure in the UK. If it weren't for constant 

delays, none of us would have the time to play it.

Sudoku

GCompris

 You can fine-tune 

GCompris to the 

age range of the 

children who are 

going to play.
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“Crack Attack soon 
becomes a manic attempt 
to keep on top of things.”

Fish Fillets NG

A
t first  glance, Fish Fillets NG 

might not look like the average 

puzzle game. For a start, the two 

main characters are fish, and the 

cartoon graphics don't look all that 

challenging. But from the first level, you'll 

be hooked (sorry!). The objective is to 

get both fish out of the level, and you can 

control either the large fish or the small 

fish by switching between them with the 

space bar, using the cursor keys to move 

them around. You spend most of your 

time pushing objects around each level, 

nudging them with your fishy nose. And 

this is where danger lurks. If the object 

falls on either fish, it will perish. 

Both fish have slightly different 

attributes. The larger one can move steel 

objects, for example, where the small 

one would get crushed. The first level is a 

good example. Both fish are located on 

either side of a table and two chairs, with 

a steel bar positioned in the middle of 

the table. The exit for both fish is on the 

far right, but you need to move the right-

hand chair to be able to squeeze through 

the gap. The big fish is too large to be 

able to get into the space to push the 

chair, so you need to use the big fish to 

push the steel bar across the table so 

that the little fish can swim across to the 

other side. You can then use the little fish 

to move the chair, making enough room 

for both of the fish to swim out through 

the exit to the right, and both fish move 

on the next level. 

You can undo any mistakes that you 

might make with the - key, and you can 

restart the level by pressing Escape. 

There are over 70 levels in total, and 

most of these are quite challenging, 

which makes Fish Fillets NG the perfect 

brain trainer when you find yourself with 

ten minutes to spare.

C
rack Attack is an altogether more 

manic game than most. Coloured 

blocks appear at the bottom, 

moving slowly up. You play by swapping 

pairs around using the cursor keys and 

the space bar so that lines of three or 

more blocks of the same colour are 

created. When this happens the blocks 

disappear, while those around them fall 

down to fill the space. If this leads to the 

completion of further coloured lines, you 

get a bonus combination score. The 

more line completions you can string 

together, the higher your score. 

A good strategy is to get five blocks 

together. You can often find two groups 

of two in the same vertical column, and 

working a single block of the same 

colour into the middle section, joining 

the two blocks together, is the best way 

to improve your score as well as giving 

you a good chance of a combo. As time 

passes, you will start to get horizontal 

blocks appearing at the top of coloured 

blocks. To remove these, you need get a 

line of three blocks or more adjacent to 

the horizontal block, which will then turn 

into ordinary pieces that rain on to the 

top of the playing area. The longer you 

play, the more of these blocks appear as 

the game starts to speed up. As a result, 

Crack Attack soon becomes a manic 

attempt to keep on top of things. 

But for the ultimate gameplay 

experience, you have to try it with two 

players. Crack Attack can connect to 

anyone on the local network, or even 

across the internet. One person needs to 

use their machine as the server, with the 

other being the client. The client needs 

to enter the IP address of the server 

machine to be able to connect. On the 

internet, you can find your IP address by 

visiting http://whatsmyip.org, and this 

is the number you'll need to tell the 

client. If you're both on the same 

network, you can find your IP address 

from the System > Administration > 

Network Tools window by selecting 

Ethernet Interface (or wireless) from the 

drop-down Network device list. It's worth 

the trouble, because two-player Crack 

Attack games are about as much fun as 

you can have with your Linux box. The 

gameplay is exactly the same as with 

single player, except that when you get 

more than a single line, those lines are 

added to your rival's screen. This leads 

to a mental tug o’ war as the two players 

try to push the other off the top of the 

screen. Great fun!

 Fish Fillets NG is a re-creation of a puzzle game that was 

popular in the 90s and eventually released as freeware in 2002. 

 Crack Attack only 

really comes alive 

when you can find 

someone to play 

it with.

Crack Attack
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Trackballs
I

f you ever played the arcade classic 

Marble Madness back in the 1980s, 

then you'll understand exactly what 

you have to do in Trackballs. It's a 

modern interpretation of the marble 

rolling game, replacing the two-

dimensional isometric graphics with a 

real three-dimensional environment. 

You have to roll a steel ball bearing 

across varying surfaces and past 

terrifying hazards in a quest to get the 

ball from one end of the map to the 

other. You can use either the mouse or 

the cursor keys, but the mouse gives you 

a finer degree of control. If you do use 

the cursor keys, the Shift key will add 

acceleration. You often find yourself 

having to compensate for too much 

speed, either because you've just rolled 

down a large hill, or accelerated off a 

ramp. To slow down, you need to roll the 

ball in the opposite direction to where 

the ball is travelling – effectively 

reversing the direction of travel. You can 

also jump, by pressing either the left 

mouse button or the space bar, and you 

need to get used to this for traversing 

small gaps, as well as avoiding the 

occasional enemy. Fall off any of the 

edges, and your game is over. 

The game starts relatively easily, with 

a level that features a big drop, some 

spongy surfaces and a section of 

sharpened pencils that try to push you 

off. Later levels feature bowls of acid and 

icy surfaces at strange angles, 

challenging even the most dexterous 

player. Along the way, save position 

markers help make the task a little 

easier, by allowing the player to restart at 

the same position. There are over 70 

levels in total, split by difficulty, though 

only a master will be able to complete 

them all. You can choose which set to 

play at the beginning of the game. If you 

ever get bored with those supplied with 

the game, then you can create your own 

with the level editor, or download dozens 

more from the Trackballs website. 

M
arble Madness, the game that 

Trackballs imitates, was 

successfully converted to the 

Commodore Amiga computer in the 

1980s, and you'll find many similar 

conversions for Linux. One of the better 

ones is Pingus, a game inspired by the 

Amiga classic Lemmings. This being 

Linux, the lemmings have been replaced 

by tiny penguins, but the idea is the 

same. 

To complete each level, you have to 

save a certain number of penguins from 

destruction. You do this by assigning a 

role to certain penguins, and using these 

to help the progress of the remaining 

penguins in some way. The roles appear 

as icons on the left-hand border of the 

screen. Choosing ‘Digger’ for example, 

and clicking on a penguin in the main 

display will cause the selected penguin 

to start digging into the ground directly 

beneath its feet. In the first level, this 

tunnel helps all the other penguins to 

escape to the exit, and it's a similar 

process for the other levels. You can find 

what each role does by holding the 

mouse over the icon. Gameplay always 

involves a bit of trial and error to begin 

with. For instance, in the second tutorial 

level, the penguins jump of a large cliff, 

and it's only when they start dying that 

you realise you need to give each one 

the ability to fly. Fortunately, ‘Floater’ is 

the only role available for that level, and 

applying this to the in-game penguins 

saves the day. 

Progression from one level to the next 

is across a map that outlines the main 

area of the game, and even adds a little 

background story. This element is 

sometimes more like Super Mario World 

than Lemmings, but it adds to the 

enjoyment of a game that's quickly 

approaching its 20th anniversary. 

 Trackballs is a 

little like those old 

wooden marble 

rolling games 

that Victorian 

children used to 

play with. Except 

the landscape is 

3D and you roll the 

ball rather than tilt 

the box.

 Pingus bears more than a passing resemblance to that Amiga 

classic Lemmings, and you can enjoy it for free on your Linux box.

Pingus
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Battle for Wesnoth

A
s befits a title in this genre, Battle 

for Wesnoth is an epic. Its 

colossal size is matched only by 

the quality of its graphics and the quality 

of gameplay. Its developers describe it 

as a turn-based strategy game with a 

fantasy theme, and as soon as you start 

a new campaign, it's easy to see what 

they mean. You can choose from several 

different scenarios, from a quest to 

destroy a troublesome black mage, to a 

Herculean battle across the lands of 

Wesnoth to wrestle control of the evil 

empire from the clutches of the Lich-

Lord Jevyan. Which is nice. 

As gameplay is turn-based, you have 

plenty of time to make each move, and if 

you've played a game like Settlers, you'll 

now how it works. You start each 

campaign with several units. These could 

be simple peasant spearmen, horsemen 

or perhaps knights. Each unit has 

specific abilities, as well as a set range 

across different types of terrain. It's your 

job to survey the local area, and move 

your units strategically so that you're in 

the best possible position for any 

confrontation. Knights are more 

powerful than the other characters, but 

they don't have the range of the 

spearmen, and there's a similar trade-off 

with the other unit types. 

It might sound complicated, but 

thanks to excellent introduction and 

tutorial campaigns, it doesn't take long 

to get up to speed with the game 

mechanics, and it's worth the effort. 

Battle for Wesnoth is a wonderful game 

where you can spend hours tuning your 

strategy and building alliances. There's 

also an excellent multiplayer component, 

where you can either join an official 

server, play with a friend across the 

internet, or even take turns to make 

moves on a single machine. This is really 

where Wesnoth is at its most fun.

T
here's a long tradition of 

adventure games running on 

Linux and Unix systems. This is 

epitomised by a particular game called 

NetHack. NetHack is called a Rogue-like 

game because it is itself based on a 

game called Rogue, which was originally 

released in 1980. 

Rogue-like games share some of the 

same elements. There's usually a degree 

of randomness, and a player's strengths 

and weaknesses are based on random 

attributes. These attributes can be 

improved by gaining experience, either 

by finding objects or by destroying the 

enemy. And all Rogue-like games are set 

in a dungeon. Egoboo is one such game. 

But instead of the text-based graphics of 

NetHack, Egoboo has transformed this 

idea into three dimensions. And you're 

no longer alone in the dungeon. 

Depending on the module you choose to 

play, you will be accompanied by other 

characters. Each module is a separate 

adventure. The quest is different each 

time, but you always play in a dungeon. 

One tasks is to clear the dungeon of 

grub bugs, while in another you need to 

rescue a group of faeries and guide 

them to a faerie ring. 

Control is entirely through the use of 

the mouse and keyboard – you need to 

press the A and S keys to perform 

actions on things while the middle 

mouse button will cause your character 

to jump. Combat is mild, as you use the 

right mouse button to take a swipe at 

any baddies in range. While the graphics 

could never be described as cutting 

edge, the cartoon style and the smooth 

gameplay adds a new dimension to the 

Rogue-like style of play. The game is a 

little rough at the edges, but that's 

because it’s still being actively 

developed. If you enjoy games like 

Neverwinter Nights or old role playing 

games, then you should be able to get a 

lot of enjoyment out of this game, 

despite its silly name.

 Battle for Wesnoth is a turn-based strategy game. It feels a 

little like a cross between Ultima and the Settlers series. 

 Thanks to the 

excellent 3D 

graphics, Egopoo 

look and feels 

much more like 

a modern game 

than those that 

inspired it.

Egoboo
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Alien Arena

T
his isn't exactly the kind of game 

you might want to play at a 

children's party. But get a few 

people together and a few Linux 

machines, and you won't have had as 

much fun since you got that Raleigh 

Chopper for your eighth birthday. 

Alien Arena is a first person shooter. 

That means you see through the eyes of 

the player, and you need to shoot at 

anything that moves. Games are played 

online, either by hosting your own server 

that everybody joins, or by joining a 

public online game where people are 

already playing. There are usually plenty 

of servers running, so you're only ever 

30 seconds away from a game. Each 

level is a confined map, and there are 

various game modes, from deathmatch 

(killing everything), to capture the flag 

(stealing your opponent's flag and 

bringing it back to your base). 

It's very similar to another Linux 

classic – Unreal Tournament. Alien Arena 

even has a similar array of weapons. You 

start with a humble Blaster. This fires a 

bolt of plasma that doesn't harm the 

enemy all that much, which is why it's 

imperative that you quickly move on to 

something a little more destructive, such 

as the Alien Disruptor. This shoots a 

powerful beam that's difficult to target 

but effective if you hit your mark. Right-

clicking the mouse will use the 

alternative fire, and with the Alien 

Disruptor, this is a sniper scope, making 

enemies easier to hit (if you can 

convince them to stay still). If you get 

close, switch weapons to the 

Flamethrower. You can use the middle 

mouse button or the function keys to 

switch weapons. The Flamethrower will 

cover anything in front of you with a wall 

of flame, and the longer you keep them 

burning, the more damage you'll inflict. 

But our favourite weapon is the Rocket 

Launcher. This is because you can use it 

from a distance, and it also destructive 

within a set radius of the explosion. A 

good tip is to fire rockets at the feet of 

your enemies so that even if they jump, 

you'll still inflict a little pain. 

I
f you’ve not played Guitar Hero on 

either the Playstation 2 or Xbox 360 

games consoles, you're missing out 

on something. Fortunately, you can 

redeem your social standing by running 

Frets on Fire on your Linux machine 

instead. 

Like Guitar Hero, Frets on Fire will turn 

your humble computer and keyboard 

into an instrument of rock, and the only 

thing it will cost you is your dignity. To 

play the game, choose a piece of music 

and a difficulty level from the menu 

screen. The next view you see is a 

fretboard stretching into the infinite 

distance. As the music starts, coloured 

squares will start to drift down the 

fretboard indicating which fret you need 

to play. As each square hits the bottom 

of the screen, you need to hold down the 

function key on your keyboard that 

corresponds to the fret you need to play 

(F1 –F6). At the same time, press the 

carriage return key to ‘pluck’ the strings. 

Only then will the notes sound, and only 

then will you have taken your first step 

on the road to rock greatness. 

With a little practice, you learn to 

anticipate the notes you need to play, 

holding down the function keys before 

the notes need to sound, just pressing 

return at the last moment. As you hit the 

notes, the beautiful sound of your guitar 

will sing out over the music. Hit any dud 

notes, however, and the twang of 

embarrassment will be heard by all. And 

the game can get very hard. Pretty soon 

your fretboard will be full of notes as you 

desperately try to work out which key 

combination to press. The instructions 

even recommend holding your 

computer keyboard as you would a real 

guitar, with your left hand over the 

function key frets and your right over the 

carriage return. Frets on Fire is the 

perfect party game, because it involves 

rock music and keyboard posturing – a 

combination that our inner rockers think 

is a real winner.  LXF

 If you miss some 

of the great first-

person shooters 

for the Windows 

platform, Alien 

Arena will bring a 

smile to your face.

 Turn your 

keyboard skills into 

legendary guitar 

axe grinding, and 

embarrass yourself 

in the process.

Frets on Fire

 The maps, gameplay and guns of Alien Arena are all 

reminiscent of that Linux classic, Unreal Tournament.

Frozen Bubble

Fantastic, split-screen 

puzzle game based on 

Puzzle Bobble.

Adonthell

Japanese-style role 

playing game with a 

small intricate plot 

and autonomous 

players.

NetHack

The classic turn-

based adventure 

game that never gets 

tired. Spawned a 

generation of 

imitations.

Enemy Territory

First person online 

shooter based around 

storming the beaches 

of WWII.

LBreakout

The classic pong 

game takes to 

extremes. Use your 

bat to bounce balls 

against a wall.

Neverball

A little like Trackballs, 

only this time you 

control the box the 

ball rolls around in, 

rather than the ball.

Also look 
out for:
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B
ack when you installed Ubuntu you were asked to 

create your first user, and that’s what you’ve been 

using exclusively since then. But Linux was designed 

to mimic the older Unix operating system, which was 

built to run on mainframes where hundreds – if not thousands 

– of users were logged in and working simultaneously. Unless 

you’re running your own internet cafe, it’s unlikely you’ll need 

more than a handful of users on your home computer, but 

Linux is able to handle that just as well.

One thing to remember is that you – as the first user to be 

created – automatically have full rights over the system. You 

can give lower privileges to other users you create if you want 

to, or you can give them the same level as you, but be careful: 

if you give them administrator access to the computer, they 

will be able to install (and remove!) software, change hardware 

configurations, and much more, which may break your Linux 

install! If you give them normal user privileges, this simply 

can’t happen.

Login options
By default, Ubuntu prompts you for your username and 

password when logging in, but you’ll notice there’s a little 

button marked ‘Options’ in the bottom-left corner of the 

screen. This is most commonly used to shut down or suspend 

the computer without you having to log out first, which is a real 

time-saver. There are also two other options of interest here:
1  Select Session This allows you to choose a specific 

desktop environment to be logged into. The standard Ubuntu 

includes just Gnome, but we’ve included a version of Ubuntu 

on your disc that includes other desktops too.

2  Remote Login via XDMCP This is an advanced option that 

lets you log into another machine as if you were actually there 

– you get the remote desktop and all your remote files.

Automatic login
If you’re the only user of your computer, you might prefer to 

have Ubuntu skip past all the login nonsense and log you in 

automatically. But before you enable that option, you need to 

be aware that enabling auto-login is a security risk because 

anyone who gets physical access to your 

computer can read all your files without 

having to authenticate themselves. This is 

particularly important if your computer is a 

laptop!

If you’re sure that automatic login is what 

you want, go to System > Administration > 

Login Window, then enter your password 

when prompted. The Login Window 

Preferences window will appear, and it has 

quite a few options – you need to click the 

fifth tab, ‘Security’. The first item on that tab 

will be a check box labelled ‘Enable Automatic 

Login’. Select that box, then choose your 

username from the list directly beneath it. 

Next time you restart your computer – and 

indeed every time until you disable this 

option – you’ll automatically be signed in as 

this user.

Sharing files
Surprising as this might sound, the default 

setting in Ubuntu allows any user to read the 

files of any other user. This is done because 

most multi-user machines today are shared 

Working with more  
Linux is designed to work just as well whether you have one user on your machine 
or one hundred users – it’s easy!

 Enabling 

automatic login 

is only safe if 

you’re the only 

person using your 

computer, and not 

even then if it’s a 

laptop.

 See and change user permissions for any file that belongs to 

you – make something private, or open for anyone!
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 than one account

Go to admin mode: Click System > 

Administration > Users And Groups from the 

top menu bar. This will ask you for your personal 

password before it lets you go any further, because 

changing user information is for admins only.

1

Step by step: Add a new user

The user setting panel: This shows you 

the list of all accessible users on your 

system. The “root” user is generally not used in 

Ubuntu, but you should also see your normal user 

account in there.

2
Create a new user: From the User Settings 

window, click the Add User button and this 

screen will appear. You need to fi ll in the User 

Name, Real Name and Password fi elds. Don’t click 

OK just yet!

3

User privileges: The second tab in this 

window shows the default settings for user 

privileges; you’ll note that they are allowed to do 

everything except “Administer The System”. If you 

want them to be admins, just select that box too.

4
No place like home: The default home 

directory for a new user starts with /home 

and ends with their username, but you can change 

that in the third tab of this window. 

5
Done: Click OK to save all the changes, and 

your new user will be created. When this is 

done, you’ll be back at the User Settings window, 

which should show the new user.

6

Understanding groups: Click the Manage 

Groups button to see what user groups you 

have. Groups let you grant fi lesystem permissions 

easily. 

7
Log in: If you log out from your current 

account, you’ll be returned to the login 

screen where you can try using your new user. This 

is highly recommended to ensure the password 

and privileges are correct.

8
Check privileges: We didn’t give our test 

user access to system administration tasks, 

and this can be confi rmed by going to System > 

Administration – you should notice that the list has 

got a lot shorter. 

9
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The login screen

Graphical themes: These have attractive 

pictures in the background, often with a 

“face browser”.

1
Text themes: The ‘plain’ theme category 

offers simpler login windows than the 

graphical themes, so the scope for customisation 

is smaller – change the odd colour, show a logo if 

you want to, but generally “plain” means plain.

2
You makes your choice: This is how the 

Circles theme looks in full screen – notice 

how it makes the Language and Session options 

easier to reach on the bottom, and also makes the 

login prompt a little easier to understand.

3

The default login screen is, like the rest of Ubuntu, done in 

shades of brown. But it’s also configurable – you can change 

the theme, choose which users to show and even provide a 

custom welcome message. This is all done under the Login 

Window Preferences dialog, under System > Administration > 

Login Window.

around a family, where it’s quite common to say “oh, you can 

get that file from me – it’s in my home directory under 

Photos.” If users didn’t share permission to read files, it would 

be very hard to copy files between users! Of course, if you 

want your own files to be private from other users, this 

arrangement is no good, so let’s take a look at how you can 

create files and folders that can be read only by you.

First, fire up Nautilus by clicking Places > Home Folder from 

the top menu bar. Right-click somewhere in the window that 

appears and choose Create Folder – name it ‘Secret’. Now, like 

the rest of your home directory, this is visible to everyone else 

on the system, but we don’t want that, do we? So, right-click 

on the new directory and choose Properties, then activate the 

Permissions tab. This has quite a few options on it, but the one 

we’re interested in is about two-thirds of the way down, under 

‘Others’. Here you can set what privileges other users (ie, not 

you) should have for this directory.

The default access permissions for directories like this one 

is ‘Access Files’, which means that users can see all the files in 

the directory and read their contents, but they can’t write back 

any changes they make. Clicking the Folder Access selection 

box will reveal the other options. These are: None (deny all 

access); List Files Only (show the names of files, but don’t 

allow the contents to be read); and Create And Delete Files 

(allows full read and write access). That last option is great for 

making shared folders that everyone can read and save files 

to, but that’s the opposite of what we want here, so choose 

‘None’ and click OK. That’s it: this folder is now accessible only 

to you!

If you want to make all your files private, what you need to 

do is go to Places > Home Folder, then look in the Nautilus 

toolbar for where it says the name of your home directory. To 

the left of that is a small arrow pointing left – click that, and a 

“home” button will appear, and if you click that you’ll see your 

home directory appear as an icon inside Nautilus. Now you 

can right-click on that, go to Properties > Permissions and 

change the permissions as if it were any other folder.

All about you
Once your users all have their own accounts, you should 

quickly show them how to fill in a little bit of information about 

themselves – this is particularly important if they are outside 

of your home and you need to get in touch with them. In 

Ubuntu, user information is all set through the About Me 

window, found under System > Preferences > About Me – this 

lets you enter your email address, phone numbers and instant 

messaging account information, as well as your physical home 

and work address if you want to. More importantly, it also lets 

you change your password (click the button at the top-right of 

the window) and set your own user picture (click the person to 

the left of your username). Incidentally, all the options under 

the System > Preferences menu are individual to each user, 

which means they can have their own themes, sounds, menus, 

screensavers and even their own screen resolution, all without 

affecting other users.

One cool thing about Linux is that it lets multiple users log 

into one machine at the same time, which is a great way to cut 

down on energy use while also ensuring you get the most 

value from your investment. If you want to stay logged in when 

 The About Me 

window lets you 

save user data 

beyond a simple 

username and 

password.
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The Login Window Preferences dialog can also be used to 

enable and configure remote login, which is where another 

Linux computer can graphically log into your machine and 

have access to its files and programs as if it were actually the 

real machine.

Login preferences

Enable remote login: Choose the Remote 

tab from the Login Window Preferences 

dialog, and you’ll see that the Style option is set to 

“Remote login disabled.” Change that option to be 

“Same as local”.

1
Same as local: This option means that 

whatever login theme you chose for local 

logins will be used for remote logins as well, which 

means your system will look nearly identical 

wherever you log in from.

2
Using XDMCP: The remoting system is 

known as “XDMCP”, and you’ll usually fi nd it 

hidden away on your login screen somewhere. 

Clicking this will scan the network for machines 

that can be logged into.

3

 The System Monitor can tell you which programs are taking 

up your CPU time, and makes it easy for you to terminate them.

another person comes to use the computer, just click System 

> Preferences > Quit and choose Switch User. This will put you 

back to the main login screen where the other person can log 

in as normal; when they are done, just log in as yourself again 

and everything will be where you left it.

Of course, the problem with this is that sometimes you 

leave a user logged in, then wonder why things are going a bit 

slow for your own programs – chances are that other user has 

left something running in the background that’s chewing up a 

lot of CPU time! If you find this happens to you, go to System > 

Administration > System Monitor, and choose the Processes 

tab. By default this shows the programs you are running, but if 

you go to View > Active Processes, it will only show you the 

programs that are running right now. For example, if you find 

out that one user is running the a particularly large program 

that’s taking up too much CPU time, you can kill that program 

by selecting it and choosing End Process. Easy!  LXF

 If any of your 

users needs 

helping logging

in, just enable

the accessible 

login option.
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O
ne of the best features on a modern Linux 

installation is the 3D desktop. This incorporates 

the desktop cube effects, wobbly windows, drop-

shadows, and dozens of other effects. The 

technology that drives all of this is called Compiz. This is 

because these type of effects are knows as ‘compositing’, 

using hardware graphics acceleration on a modern graphics 

card to put all the pieces together and render them to the 

desktop. But we before we go any further, a mild warning: 

Compiz is considered cutting edge, and while most of us have 

been using it without problems for over a year, many users 

report a few stability issues. Compiz is a little like an elaborate 

hack still being worked into most Linux distros and it can’t be 

considered stable. If you need to use your Linux machine in a 

production environment, Compiz will be sure to crash at the 

worst possible time. For this reason, we can’t recommend it if 

you rely on your machine to pay the mortgage.  

Installation
Now that we’ve got that out the way, we can concentrate on 

installing some serious eye candy. Compiz effects can easily 

compete with Microsoft Vista’s tame Aero Glass effect, and 

while Apple recently added the desktop cube effect to OS X 

10.5, it didn’t add anything else. Compiz uses plugins to add 

each separate effect, and with over two dozen plugins to 

choose from, it’s a melting pot of ideas, some more successful 

than others. But all require the same thing to be able to work – 

accelerated graphics hardware with a corresponding Linux 

driver. Graphics cards that use chipsets by Intel, Nvidia or ATI 

should work, though the only way to see for sure is to try, and 

the first step is to install the driver. 

If your graphics card is Intel-based, then Ubuntu has already 

installed the best driver for your device. Both ATI and Nvidia 

hardware needs a proprietary driver, as only this will provide 

the necessary grunt. Proprietary drivers are installed by 

selecting the Restricted Drivers Manager from Ubuntu’s 

Administration menu. You’ll need to enter your password, 

which will bring up a window listing all the hardware on your 

machine for which there’s a proprietary driver, with the usual 

suspects being wireless and graphics. If the option list is blank, 

Ubuntu hasn’t been able to find a proprietary driver for your 

device. It’s worth trying Compiz anyway, but you may run into 

problems. Otherwise, enable the accelerated graphics driver for 

your device by clicking on the tick-box and wait for the driver to 

install. You’ll also need to restart your machine, but after which 

your graphics driver will be updated and ready for Compiz. 

Configuration
Now that your graphics hardware is accelerated and working, 

you can easily get a rudimentary Compiz configuration 

working. Open the Preferences > Appearance window and 

switch to the ‘Desktop Effects’ tab. From here, you need to 

enable ‘Extra Effects’. Rudimentary in this sense means that 

you’ll get some drop-shadow on windows and little else. This is 

Compiz: 
The 3D desktop
Chances are that if you’ve seen any Linux screenshots over the last year or two, 
they’ll have shown a really cool spinning cube. Welcome to the world of Compiz…

Step by step: Installing drivers

Driver manager The Restricted Driver 

Manager needs to be launched from the 

Administration menu – you’ll need your password 

handy to be able to run the application. 

1
Enable Driver Each restricted driver is listed 

in the window, and you can enable the one 

you need by clicking the tick box. A confi rmation 

window will open, the drivers will download, and 

you’ll need to restart your machine.

2
Reboot check After a reboot, your 

restricted drivers should be enabled. You’re 

now ready to play 3D games, as well as play with 

Compiz effects. Get them working from the 

Preferences > Appearance menu.

3
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the polite side to Compiz, a seriously crippled version that 

doesn’t look too scary and shouldn’t make your machine 

unstable. It’s also a good indication that everything is working 

as it should. If your graphics hardware isn’t working, for 

example, the only option you’ll have in the window is ‘None’. 

The restricted driver installation may have even taken the 

liberty of enabling the extra effects automatically. But for real 

Compiz power, you need to install the grass-roots Compiz 

configuration tool, and for that we need to open Synaptic from 

the Administration menu. 

After you’ve got Synaptic running, you need to search for a 

package called compizconfig. In the list of packages that 

present themselves, select the top option (compizconfig-

settings-manager). You’ll be asked for permission to install a 

related Python package, after which you should click on Apply. 

Synaptic will then grab the required packages and install them 

on to your system automatically. You will now find an extra 

configuration panel hidden in the ‘Preferences’ menu, labelled 

‘Advanced Desktop Effects Settings’. This is the fabled Compiz 

configuration manager we’ve been after.

Compiz Configuration Manager
The Compiz Configuration Manager is awkward to use. The 

main problem is that there are just too many options. You can 

change almost anything about anything – from which corner 

of the screen you use to launch an effect, to the number of 

virtual desktops you want to use. All settings are broken down 

into categories, which you can see listed on the left of the main 

window. Clicking on a category will list all the available options 

in the main window to the right, with each option accompanied 

by an enabling check box. With the exception of the ‘General’ 

category, every other option represents a separate plugin, 

from the desktop cube to the mouse cursor flames. It also 

means that everything  needs to be enabled explicitly, by 

scrolling through the plugin list and enabling them one at a 

time. To add to the fun, you can also double-click on any of the 

plugins to find a few more pages of configuration options.

You should already find a few plugins enabled. These are 

the rudimentary desktop effects we enabled earlier. But by 

way of a brief introduction into the Compiz configuration 

framework, we’ll step through the procedure for enabling the 

desktop cube. The desktop cube can be used to quickly switch 

between each virtual desktop which are each pasted onto the 

sides of the cube. If you have more than four desktops, the 

effect isn’t actually a cube, as it has as many sides as you have 

desktops. The  main plugin is called ‘Desktop Cube’, and this 

can be found under the Desktop category. When you enable it, 

you’ll see the following warning, “Plugin Desktop Wall provides 

feature largedesktop which is also provided by Desktop Cube.” 

This message means that a feature of the plugin you’re 

attempting to enable is already provided by a currently active 

plugin. And both plugins are mutually exclusive. In this case, 

‘Desktop Wall’ is enabled and this also offers ‘large desktop’ 

functionality – the ability to switch between virtual desktops. 

This causes a conflict with the Desktop Cube, which does 

exactly the same. This is why the warning window is asking 

you to enable one and disable the other, which it will do 

automatically when you select ‘Disable Desktop Wall’.

Desktop cube
Now that the cube is enabled, you might think that’s all there is 

to it. But Compiz has taken plugin modularity to extremes. You 

can’t do anything useful with the cube without enabling the 

Rotate Cube plugin. As its name implies, Rotate Cube is 

responsible for turning the cube around and making it useful. 

Double-clicking on the plugin will let you change the keys or 

shortcuts you  use for switching desktops, but the default 

choices are good. Ctrl+Alt and the left and right arrow keys will 

switch desktops to the left or right. Using cursor down instead 

will flatten the cube so that you can see each desktop in a line, 

and you then use cursor left and right again to choose the 

desktop from that view. You can even use the middle mouse 

button to click and drag on the desktop background to freely 

spin the cube in all three axes. Welcome to Compiz!

 To install 

the Compiz 

configuration 

manager, you 

need to search for 

compizconfig in 

Synaptic.

 Pressing cursor down within the Desktop Cube will lay out 

each virtual desktop horizontally, and you can scroll between 

them using cursor right and left.

 The desktop cube 

looks great, but it’s 

also a useful and 

functional usability 

add-on, letting you 

visualise which 

desktop you’re on. 
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Our favourite
Compiz plugins
With so many plugins to choose from, we thought we’d save you 
some time by highlighting a few  we can’t do without.

T
here are dozens of Compiz plugins, and thanks to 

the rather dubious naming conventions used by the 

Compiz Configuration Manager, it’s not at all easy to 

divine what they’re supposed to do. It’s made worse 

by their inaccurate categorisation, with things like a plugin for 

adding caps onto the desktop cube found in the Utility 

category. But don’t despair. Here’s a selection of the plugins 

we think you should take a look at.

Eye candy
If you wondered why all our screenshots had a subtle 

reflection on the floor of the rotating desktop cube, wonder no 

longer. It’s the Cube Reflection effect, and this can be found 

under the ‘Effects’ category. Opening the configuration window 

for the effect will let you change the colour of the ground, near 

and far, as well as the amount of reflection. There are also 

several different reflection modes you can choose. 

Another effect is ‘Wobbly Windows’. You’re either going to 

love it or hate it, and if you suffer from any kind of motion 

sickness, you’d best avoid the enable button. The Wobbly 

Window effect does just what it says, turning your windows 

into jelly. When you drag them across the desktop, inertia and 

friction play a part in how they’re drawn. It either looks really 

cool or totally unusable, but you can tame the distortion a little 

by increasing the friction and reducing the spring from the 

plugin’s options page. You should also look at the ‘Minimize’ 

plugin. This gives you the option of changing the way a window 

is reduced to the icon in your taskbar, and it features some 

excellent transitions. 

There are several other effects that are fun for a while, but 

you’ll want to turn them off to get some work done. The 

‘Motion Blur’ plugin makes window movement look a little like 

an F1 Grand Prix, and it also takes a serious toll on your 

graphics card. ‘Cube Gears’ places some cogs into the middle 

of the desktop cube. ‘Water Effect’ and ‘Paint Fire on the 

screen’ add a crude approximation of those classical elements 

to your desktop.  

Useful add-ons
Not all Compiz plugins are superficial. There are some that can 

help your productivity. Top of our list is the ‘Enhanced Zoom 

Desktop’ plugin (found under ‘Accessibility’). When enabled, 

this gives you the ability to zoom into and out of any point on 

the screen by holding down a certain key combination. By 

default, you hold down the Windows key on your keyboard, 

and use the mouse wheel to zoom in and out of the screen, 

but this can be changed from the plugin options page. 

This is a plugin that you’ll wonder how you ever managed 

without. ‘Snapping Windows’ is another (found in ‘Window 

Management’). This pulls on the edges of windows slightly to 

make them stick to the side of the screen, or to other window. 

It keeps your windows aligned and makes better use of your 

screen real estate. The ‘Shift Switcher’, found in the same 

category, rotates through the applications you’re running and 

shows you a preview of each window. ‘Ring Switcher’ does a 

similar thing, and they’re both useful if you’ve lost track of 

something on a desktop. If you already know where the 

application is hiding, ‘Window  Previews’ in the Extras category 

will show you what’s in the window when it’s minimised. 

Finally, for plugins that are both functional and look good. Try 

‘ADD Helper’ (Accessibility), which fades windows you’re not 

using into the background; and ‘Opacify’, which lets you alter 

the translucency of entire windows. 

 Many plugins are 

useful, including 

this one – the 

Ring Switcher. It 

lets you switch 

between running 

applications using 

a preview of the 

running window.

 Many plugins have a bewildering array of options, but Rotate 

Cube is the worst offender. 
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Step by step: Install Emerald

Emerald, like everything else in Ubuntu, is 

installed through the Synaptic package 

manager. You need to look for and install the 

following packages: emerald, gnome-compiz-

manager and subversion. The last one is a 

developer’s tool we’re going to use to download 

themes. You also need to make sure the Compiz 

‘Windows Decorations’ plugin is enabled.

1
You will now see a new addition to the 

System > Preferences menu. Click on 

Emerald to launch the application. By default there 

are no themes, and before we can get them, we 

need to add the repositories security certifi cate. 

Open a Terminal and type the command at the 

bottom of the Theme Settings > Repositories page. 

Press P to add the certifi cate permanently.

2
With the connection to the theme repository 

authenticated, we can now download some 

themes. From the Repositories page, click on both 

the ‘Fetch’ buttons to download the latest themes 

into the manager. When this has completed, you 

will fi nd them listed in the ‘Themes’ tab, and you 

can enable them with a double click. After which, 

you should have a shiny new desktop theme! 

3

Emerald theme 
manager
Access dozens of separate themes using Emerald.

I
f you think that Compiz is overburdened with possibility, 

with a wealth of options that make it hard to get your 

desktop you want, then Emerald is the answer. It is a 

simple interface to changing the appearance of your 

desktop. There’s no talk of plugins and categories in Emerald – 

just click on the preview you like, and the display changes 

accordingly. Themes have been created to ape many popular 

desktops, but they’re easy enough to edit and create your own. 

All of this is achieved through the manager. There’s a little 

hoop jumping to get everything installed, and you need to type 

a single line on the command line to be able to install the most 

useful themes, but it’s definitely worth the effort. 

Create your own
After installing the themes (see our walkthrough), you’ll find a 

preview for each listed in the ‘Themes’ tab when you first 

launch the Emerald Theme Manager from the ‘System > 

Preferences’ menu. Clicking on any of them will apply the 

theme to the windows on your desktop. Compiz is being used 

in the background to add transparency, reflections, blur 

effects, refraction and the shadows. These effects are handled 

by something called a frame engine, and you can see which 

one each theme is using by switching to the ‘Edit Themes’ tab. 

Just switching between frame engines can alter the 

appearance of your desktop. The ‘truglass’ engine, for 

instance, gives the impression of a reflective see-through 

desktop, while ‘Oxygen’ is what you should choose if you want 

a theme that looks a little like Microsoft’s Aero theme.  

The options that load 

below the Frame Engine menu 

are particular to each engine, 

but most themes will let you 

change the colour of the 

theme as well as the gradients used to fill in the window 

border. As you move each slider, the effects can be seen on 

your desktop in real time, so you can quickly tell whether you 

like the modification or not. Switch to the ‘Frame/Shadow’ tab 

in the Edit Themes window and you can change some of the 

more general options attached to a theme. The most obvious 

is the shadow. By default, most themes keep the shadow 

effect at a subtle distance. But changing the opacity, as well as 

the radius of the shadow, can make it more obvious in quite a 

pleasing way. You can also alter the X and Y axes to change the 

direction in which the shadow falls relative to the window. 

Save your theme
Most importantly, you need to remember to save your 

changes. You can do this from any of the Edit Themes pages 

by typing a name into the bottom field and clicking the ‘Save’ 

button. This will add your new theme with your own 

modifications to the Themes list on the first page, and change 

the theme description. This is accomplished from the ‘Theme’ 

page, from where you can add yourself as the author, as well 

as give your theme a name and a version number. You can also 

attach a screenshot of your theme that’s used to preview its 

appearance in the Themes page.  LXF

 The combination 

of Compiz 

and Emerald 

gives Linux an 

unbeatable 

desktop.
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 VLC is arguably 

the best media 

player in the world, 

and it handles 

DVDs with ease.

O
ut of the box, Ubuntu Linux provides a fine 

computing experience for general internet and 

office jobs. However, it’s missing a handful of 

features to make it an all-round desktop OS – but 

we can soon fix that. Why is it missing these? Well, Ubuntu 

Linux is a free operating system, built with components that 

anybody can modify and share. Consequently it doesn’t 

include software packages which are non-redistributable or 

commercially limited, such as Adobe Flash Player. This is a bit 

annoying at first, as you’ll have seen if you’ve tried to go 

YouTubing, but it doesn’t take long to rectify.

Another aspect to this is multimedia playback. 

Unfortunately, many of the codecs (file format reading 

programs) which we use on a day-to-day basis are 

encumbered with copyright and software patent issues. To 

avoid getting on the wrong side of media companies, Ubuntu 

Linux (and the DVD with this magazine) doesn’t include MP3 

and DVD playback as standard, but again, these facilities are 

just a few mouse clicks and commands away. Over the next 

few pages we’ll show you how to spruce up your Linux 

machine so that it plays all the media you use every day.

Playing video DVDs
As mentioned before, DVD playback support is hindered on 

Ubuntu Linux straight after installation. There are various 

issues with copyright and software patents surrounding the 

technology to decode encrypted video DVDs (that is, nigh on 

every video DVD around), so the Ubuntu Linux team errs on 

the side of caution and doesn’t include it. However, if you want 

to add support to play back DVDs, here’s what you need to do 

(internet connection required).

First, open a command-line window by clicking 

Applications, Accessories and Terminal. Don’t worry – we’re 

not going to do anything complicated! In fact, it’s easiest this 

way, instead of faffing around in the Synaptic package 

manager. Enter this command exactly (it’s case-sensitive):

sudo apt-get install libdvdread3

You will be prompted to enter your password; then the 

libdvdread3 package, which provides access to encrypted 

DVDs, will be downloaded and installed. The whole process will 

take a minute or two. Next we need to enter a second 

command to activate the decoder:

sudo /usr/share/doc/libdvdread3/install-css.sh

Lastly, we want to install the VLC media 

player, an excellent program that’s much 

better than the default Totem media player 

for watching DVDs. Enter:

sudo apt-get install vlc

This will download about 7MB of files, so 

you’ll have to be patient if you’re on a slow 

connection. When it’s done, you can enter a 

movie DVD, and close Totem if it 

automatically appears. Then click on the 

Applications menu, and go to Sound & Video 

> VLC Media Player. Click the Play button at 

the top, which will open a dialog box to 

choose the movie you want to play. Click on 

the Disc tab at the top of the window, then 

click on OK.

All being well, you’ll now be able to watch 

your film! Any time you want to watch a 

movie in future, follow the same process: 

launch VLC, click the Play button, open the 

disc and you’re off. Also note that VLC is 

capable of playing many other types of video 

file, so if you have problems loading anything 

in Totem, give it a go.

Codecs and extras
Convert your Linux installation into a multimedia powerhouse, and add extras for 
a better internet experience.
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Finish: And you’re done! Start Firefox and hop over to YouTube to 

confi rm that the installation has worked – you should be able to view 

Flash content around the web now. 

4

Search: Click on Search at the top, then look for the package called 

fl ashplayer-nonfree. It will appear in the main window list – click the 

checkbox next to it, then Apply at the top.

2

Step by step: Add Adobe Flash support

Packages: Click the System menu, then Administration and Synaptic 

Package manager. You may be prompted to enter your password. 1

Download: The Adobe Flash Player will be downloaded from the 

internet and installed, the whole process taking around a minute on a 

fast (DSL) connection. 

3
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Java and RealPlayer
These programs are very easy to install. Click Applications > 

Accessories > Terminal, and enter the following command to 

get the Java plugin for Firefox, so you can view Java applets on 

websites:

sudo apt-get install sun-java6-plugin

You may be prompted for your password. This is a fairly hefty 

download (34MB), so if you’re on a dial-up connection you’ll 

need to leave it for a few hours. After the download has 

finished, you’ll be prompted to view the licence, so read 

through it and press Tab then Enter to proceed. You’ll then be 

asked to confirm your choice – press the left cursor key and 

Enter again.

Once the installation has completed, you can purge 

the downloaded packages by entering sudo apt-get clean. 

Now start Firefox and browse to a site with Java (such as 

www.javatester.org) and check that the installation works.

For RealPlayer, open a terminal again and enter:

sudo apt-get install mozilla-helix-player

This download is approximately 4MB. After installation, you 

should be able to restart Firefox and view RealMedia content 

on websites – or you can run a standalone player by clicking 

Applications > Sound & Video > Helix Player. (If you’re 

wondering about the name, Helix is an open source project 

from RealNetworks.)

Tweaking your Ubuntu Linux system
No doubt you’ve already explored the System menu on your 

Ubuntu Linux installation, and have discovered the various 

settings and options you can change. However, there are other 

aspects of the desktop and operating system that you can 

fine-tune – these aren’t accessible to normal users by default, 

but with an extra download they become available.

Open a terminal window and enter:

wget http://ubuntu-tweak.googlecode.com/files/ubuntu-tweak_

0.2.6-1~ppa1_all.deb

This downloads the Ubuntu Tweak program from the project’s 

website. If you receive an error, it means that a newer version 

of the program is available, in which case you should open 

Firefox, browse to http://ubuntu-tweak.googlecode.com 

and grab the latest Deb package for Ubuntu 7.10 (Gutsy). Save 

the Deb file into your home directory.

Then enter:

sudo dpkg -i ubuntu-tweak_0.2.6-1~ppa1_all.deb

(If you downloaded a newer version, change the filename 

accordingly.) Once it is installed, click Applications > System 

Tools > Ubuntu Tweak to start it up. You’ll notice a tree 

structure of icons down the left-hand side, separating the 

customisations you can make into categories. Click on the 

triangles next to the icons to expand these categories into 

sub-categories.

 Helix Player 

lets you view 

RealMedia content, 

either embedded 

into web pages 

or as standalone 

streams.
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Note that many of these options make significant changes 

to the way your operating system work, so if you have any 

doubts or confusion about any of the options, just steer clear 

of them. Here’s a list of things to look at:

1  Computer This just provides information on your machine 

– there’s nothing you can change here. However, it’s useful if 

you’re having problems and want to provide plenty of 

feedback in a forum post.

2  Startup In the Auto Start section you can disable programs 

from running when the GUI starts loading. Some of these are 

essential for the desktop to function correctly, but you can 

disable Print Queue if you don’t use a printer, Power Manager 

if you’re on a desktop machine and have no interest in power 

saving, and Evolution Alarm Notifier if you don’t plan to run the 

Evolution mail client. Disabling these will speed up your boot 

time by a few seconds.

3  Desktop Via the Desktop Icon subcategory, you can add 

Computer, Home and Trash icons to the desktop. You’ll already 

have noticed that Ubuntu Linux’s desktop is empty by default, 

so if you prefer to have these regulars around (as in Windows), 

then you can enable them here. The icons will take a few 

seconds to appear after you’ve clicked the checkboxes.

4  System This is all about power management. If you’re on a 

laptop, you can customise ‘CPU Policy’ – that is, how fast your 

processor runs when you’re on battery or mains power. You 

can also disable Hibernation and Suspend here if they’ve been 

giving you problems.

5  Security These options are for system administrators who 

want to lock down a machine. If you’re installing Linux for 

someone else, and don’t want them to accidentally run random 

programs or print out 999 copies of a web page by mistake, 

you can disable various features here.  LXF

Ubuntu Linux enables you to add 

support for MP3 playback almost 

automatically. Find an MP3 file in 

the file manager and double-click 

it; Totem will open up, explain that 

it can’t find the right codec to play 

it, and offer to search for one. So 

click Search, and Linux will do a 

quick search of the internet for the 

relevant codecs. It will then pop up 

a dialog box offering you a list of 

packages to install – you need the 

one called GStreamer extra 

plugins, but you can install others 

as well (eg the ffmpeg plugin to 

play Windows Media files).

Click the checkboxes next to the 

packages you want, and then the 

Install button. You may be 

prompted to enter your password 

as a security measure. The 

installation process will take 

around a minute, and when it’s 

done, you will now be able to play 

MP3s (and Windows Media files if 

you chose to).

 If you have an internet connection, getting MP3 playback support is just a few mouse clicks away.

Adding MP3/WMV support

 Helix Player 

lets you view 

RealMedia content, 

either embedded 

into web pages 

or as standalone 

streams.
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Rip your CDs

Ripping your
music collection
You’ll learn how to import your CD collection into Ubuntu by following this tutorial.

By default Ubuntu comes with Sound Juicer, a neat GUI tool that allows 

you to quickly rip the music from your CDs. To get started, go to 

Applications > Sound & Video and choose Sound Juicer CD Extractor.

Step by step: Rip your CDs with Sound Juicer

A
re you plagued by a seemingly endless library of 

music CDs? Perhaps that mission to buy every 

single album by U2 has pushed your CD collection 

up into the several hundred mark? Ever stuck for 

what to listen to? If the answer is yes to any of these, it’s 

probably a good idea to spend time ripping all of your CDs into 

a virtual library, one that will help you manage and search 

through your myriad of CDs and albums.

Doing this with Ubuntu is a breeze, mainly thanks to its 

support for audio formats and the tools supplied out of the 

box to get you started. Not only that, but you can even create 

your own compilation CDs for those long car journeys.

It’s likely that you’ve already experimented with extracting 

music from your CDs (more commonly known as ripping) but 

haven’t done much with the end result. We’ll take a look at the 

tools you can use to extract the music from CDs, as well as 

some of the programs that are available to help you manage 

your virtual library of music. We’ll also take a look at creating 

your own CDs from tracks that you’ve ripped, helping you to 

build your own personalised Greatest Hits album.

You’ll also learn a little about the different codecs (audio 

formats) on offer, as well as how to add support for the MP3 

format to Ubuntu.

If you are planning on doing a wholesale rip of all your CDs 

in your collection, you’re going to want to have as much 

hardware resources as possible. First and foremost you should 

have a CD drive with a decent read speed – somewhere in the 

48x-52x area is ideal in order to rip the CD as quickly as 

possible. You’ll never see that speed while you’re ripping with 

Sound Juicer, as it also needs to be able to encode the audio 

information into what ever format you’ve chosen. In order to 

ensure that this happens as quickly and as efficiently as 

possible, it’s best to use a pretty beefy machine. While writing 

this article, we used a Pentium 4 3.4 GHz computer with a 

48x speed CD drive; the fastest we could rip at was 17–18 

times  the speed of the audio track, which takes around 3 

minutes for standard 70-minute audio CD. With a more 

modern computer such as a Core 2 Duo, we’d expect this 

speed to increase slightly in line with the performance 

enhancement gained from the new processor.

1 A quicker way to get to Sound Juicer is to simply insert an audio CD 

into your CD/DVD drive. Ubuntu will start Sound Juicer when it detects 

the presence of a music CD. In any case, Sound Juicer will automatically try to 

retrieve the CD information from MusicBrainz, a free music database.

2
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In order to speed things up a little, you might want to set Sound 

Juicer to automatically eject the disc when it has completed. That 

way you can simply switch the ripped CD for a new one, and click 

on Extract again to carry on ripping. The only boring bit is getting 

all your CDs into your virtual library, which can also include 

assigning the CDs to a genre to aid your music management. It’s 

worthwhile getting it right from the start, otherwise you’re going to 

have to go back and make retrospective changes. Once you’ve 

done it though, your entire CD collection will be on tap via Ubuntu 

and you will be able to master your own music CDs using the 

Serpentine recording software.

Another thing that you can do is to place all your music files on 

a network drive, and allow all your client machines in your home to 

have access to them, meaning that you’ll have music where ever 

you have a computer in your household. Just bear in mind that 

sharing your ripped music files with other people can constitute 

piracy! Why not consider heading on over to www.jamendo.org 

and downloading some music licensed under a sharing-friendly 

license such as the Creative Commons licence. That way you can 

share your music with whoever you like, subject to the terms of the 

specific licence used by the artist. And, of course, if you like the 

music why not donate a small amount of money to say thanks?

The need for speed

 Tweak your setting to make the job much faster

MusicBrainz isn’t perfect, and it may not recognise the CD that you’ve 

inserted. If this is the case, you’ll need to enter the data into Sound 

Juicer. Use the fi elds at the top to provide general information for the album, 

while you can double-click on each of the track titles to edit the name.

3 The next step is to set the options for ripping, including the type of 

audio codec to use, so go to Edit > Preferences to see what’s on offer. If 

you have multiple CD drives, you can select which one you want to use for 

ripping. You can also choose the codec in this screen.

4

Once you’ve set your preferences, click on the Close button to return to 

Sound Juicer. You’re now ready to start extracting the music, so click 

the Extract button to begin this process. Depending on the speed of your 

drive, this can take up to fi fteen minutes to complete. 

5 By default, Sound Juicer saves all your ripped fi les into sub-directories of 

the Music directory. They’re grouped according to artist, and then 

grouped by album name. Don’t worry too much about this, as we’re going to 

be using a program to manage your music based on its metadata.

6
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To start the import of your CD, simply right-click on the CD in the 

devices section of the left-hand pane and select Copy to Library. 

RhythmBox will then start importing your CD into the music directory and will 

automatically add the new tracks to its music database.

By default RhythmBox shows the Browse view, which allows you to 

quickly isolate tracks based on artist and/or album. The number in 

brackets after the each artist or album is the number of tracks that are 

assigned to that specifi c entry. 

The quicker way to fi nd the music you want is to enter keywords in the 

search box. RhythmBox will automatically fi lter the track list according 

to your search terms, making it an easy way to narrow down a long track list to 

what you want to listen to. 

One of the more useful features of RhythmBox is its ability to create 

automatic playlists, found under Music > Playlist > New Automatic 

Playlist. With this, you can specify a number of criteria, and RhythmBox will 

create a playlist that contains all the qualifying tracks. 

When ripping CDs, you will need to edit some of RhythmBox’s 

preferences, so go to Edit > Preferences and click on the Music tab. 

Tick the ‘Watch my library for new fi les’ check box, and select your preferred 

format, clicking close to return to RhythmBox.

The default music player supplied with Ubuntu is RhythmBox, which is 

more than capable of playing back your music. RhythmBox can also 

import your CDs, although it acts as a wrapper to Sound Juicer, meaning that 

it uses Sound Juicer to import the CDs into your library.

1 2

3 4

5 6

Step by step: Manage music with RhythmBox
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To rip your CDs using Banshee, you’ll need to set your encoding 

preferences, by going to Edit > Preferences and choosing your preferred 

codec. Once you’re ready, you can right-click the CD icon in the left-hand pane 

and choose the Import option. 

Ubuntu includes a dedicated Audio CD creator called Serpentine, found 

under Applications > Sound & Video. There are other CD-burning apps, 

but we’d recommend that you use Serpentine mainly because it shows you 

exactly how full your CD will be as you add music fi les.

Click on the Add button to open up the fi le manager and navigate to 

your fi rst music fi le to add to your new CD. Select one or more fi les to 

add, and click the Open button to add them to your track listing. Serpentine 

will show you the amount of time you have remaining on your CD.

You can drag and drop the tracks to re-arrange the order in which they 

will appear on the disc. Once you’re happy with your tracklist, you can 

click the Write To Disc button in the toolbar to commence burning your music 

to an audio CD.  LXF

One of the other popular music players for Ubuntu is Banshee, which is 

not installed by default. To get Banshee, go to Applications > Add/

Remove and search for Banshee. Add/Remove Applications will also 

automatically install any other software that Banshee requires.

Banshee is a lightweight music player that allows you to use the 

metadata embedded in your ripped fi les to search and group music 

together. In common with RhythmBox, you can create smart playlists allowing 

you to easily group multiple tracks into a playlist according to your criteria.

1 2

3 4

5 6

Step by step: Banshee and Synaptic
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Disc burning

M
aking regular backups is something we all intend 

to do, but sometimes we forget or we’re simply 

too busy with other things. However, it’s still a 

wise idea to keep crucial documents safely 

stored on CD-Rs or DVD-Rs for emergencies – in case 

something goes wrong with your hard drive, or your laptop is 

stolen. With the right backups, you can get back on your feet 

quickly and easily (financial hassles aside!).

Of course, disc burning isn’t just limited to backups. Often 

you’ll want to make a CD-R or DVD-R of files to give to a friend 

or colleague, such as work-related documents or family 

photos. Ubuntu Linux makes this easy: disc burning support is 

built right into the system, so you don’t have to splash out on 

expensive third-party software or wrestle with time-limited 

shareware tools. On page 76’s guide you’ve seen how to burn 

discs for media files; here we’ll show you how to back up any 

kind of data. Naturally, your PC will need some form of disc 

burner, internal or external, if you’re going to follow this guide.

Going further
The disc burning software supplied with Ubuntu Linux, as 

explained in these steps, is very straightforward and light on 

features. If you want more versatility and power, though, we 

recommend installing a program called Brasero, which is 

available via Ubuntu Linux’s online package repositories. Click 

on System Menu > Administration > Synaptic Package 

Manager, then search for ‘brasero’ and install it. The package 

will be downloaded from the internet and installed on to your 

system. With a fast (ADSL) internet connection, this shouldn’t 

take more than a couple of minutes.

When it’s done, you’ll find Brasero in the Applications menu 

under the Sound & Video category. Brasero initially displays a 

window letting you choose the type of disc to create: in our 

case, we want a ‘Data Project’ disc, so click on that button. You 

can then drag files into the Brasero window, change the type of 

disc with the bottom-left button, and click on Burn to start the 

disc-writing process. Brasero lets you add files on to existing 

CD-RW/DVD-RW discs, and shows a useful bar chart of how 

much disc space is remaining, so it’s a good alternative to the 

standard Linux tools.

Burning CDs and     
Want to back up your documents or copy files for a friend? Here are the simple 
steps you need to follow...

From the desktop, click on the Places menu at the top of the screen, 

then click on CD/DVD Creator in the menu.1

Step by step: Burning a CD-R or DVD-R

This window will open: it’s a blank fi le manager window into which you 

can drag and drop fi les to be copied to the disc.2

 If you find the file manager-based system too limiting, 

Brasero provides a more featureful disc burning tool. 
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   DVDs

Now open another fi le browser window (such as Places Menu > Home 

Folder), and resize the windows so that you can drag fi les over.3
Select fi les or documents and drag them over into the CD/DVD 

Creator window – they will be copied, not moved, so you don’t have to 

worry about losing the contents.

4

Insert a blank CD/DVD, then Click on the Write To Disc button in the 

top-right of the CD/DVD Creator window and this dialog will appear. 

You can select the write speed at the bottom.

5
Your fi les will be copied to the CD/DVD: this may take a while if you’re 

copying many hundreds of megabytes (this is the appropriate time to 

put the kettle on). When it’s fi nished, you can eject the disc.

6

If you don’t have a blank CD/DVD to hand, you can make an ISO 

image (a fi le representing a disc) for later burning. Click on Write To 

Disc and choose File image in the ‘Write Disc To’ list.

7
You’ll then be prompted to enter a fi lename for the disc image. Later, 

when you have a CD/DVD to hand, you can right-click on the ISO fi le 

in the fi le manager and select Write To Disc.  LXF

8
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Burn an audio CD 
and make a track inlay
Use the combined power of Linux apps to add some life to your party mixes.

E
ven though you may have a lot of music on your 

computer, tucked away on your iPod or elsewhere, 

there are still times when it is useful to have them in 

the universal format of the audio compact disc. 

Maybe you are going to the beach, and would rather take a 

semi-disposable ghetto blaster than risk getting sand in your 

sleek MP3 player, or maybe you need a CD for a long car 

Exploring the K3b interface

Directory tree panel.

Track listings with tag 

info, if available.

Tools for converting and creating 

different discs.

Click the Burn button 

when you are ready to 

toast a disc!

Listing of the available 

audio files.
Select a track and click to check for 

MusicBrainz data. 

The status bar shows how much of 

the disc you have filled.

Current directory – click 

for history.

journey. In any case, it is not so difficult to mix up your 

favourite audio on to a CD using Linux.

In this tutorial, we will be taking it a step further by showing 

you how to also create an inlay card for a CD case, and using 

some clever tricks, we can even generate the track listing 

automatically! You will need to have Inkscape and K3b 

installed for this tutorial.

Filter the files in the current 

directory by type.
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Adding tracks to your disc is pretty easy. The top half of the K3b window 

is split into two parts. On the left is a directory tree with folders from 

your local fi lesystem. The contents of the currently selected directory appears 

in the larger area of the window. 

To add the music tracks to your burn list, click on them and drag them 

down to the lower half of the window. When you release the button over 

the lower part of the window there will be a short pause as the fi les are 

scanned and the tag data is extracted. 

When you add tracks, the status bar along the bottom will start to fi ll 

with green. This indicates the amount of space on the CD you are using 

– if it goes red, you have added too much music and you will have to remove 

some. K3b is smart enough to make allowances for >650MB discs if you have 

them, though old CD players may have trouble with them.

Select the Burn button from the tab at the top of the lower panel, and 

the disc-burning window will pop up. You could just go with the defaults, 

but if you select the ‘Create Image’ option you’ll create the image on your hard 

drive fi rst, which may be useful if the burn fails and you have to try again. 

We’re going to start with the OGG fi les that you’ve ripped on to your 

machine. Most people agree it reproduces a better sound, and the fi le 

sizes are much smaller than mp3 fi les. If you do have mp3s, use the 

OggConvert tool to translate them into OGG fi les.

K3b is currently the best all-round disc burning software for Linux. It 

can handle a variety of different formats, supports plugins for adding 

extra functionality or fi letype support, and perhaps most importantly of all, it 

is pretty easy to use (see p100 to learn how to get K3b with Synaptic).

1 2

3 4

5 6

Step by step: Burn an audio CD
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If you missed out the script part earlier on, you can skip on to the next 

stage here as well. We have the text in a fi le, but it can be tricky to import 

a text fi le correctly into Inkscape on Ubuntu. The next best thing is to copy and 

paste it from some other application. Select Applications > Accessories > Text 

Editor to run a simple text editor. When the program runs, Click on the Open 

button and select the tracklist.txt fi le from the fi le requestor. The text should 

load in as shown in the picture, giving us a perfect track listing for the CD. To 

get it into Inkscape, we just have to copy and paste it. Select all the text 

(Control+A) and then copy it (Control+C). The text is now in the clipboard, 

ready to be placed into Inkscape. 

It would be nice to have some sort of background to the image. Use the 

square tool and drag out an area slightly bigger than the document. It 

will just be fi lled with the default options, so most likely it will come out black. 

You can play around with this easily though. Press Control+Shift+F to bring up 

the Fill and Stroke settings. Under Fill, you can choose a gradient fi ll, and edit 

the settings to create a nice swooshy shade of your choice. You could also use 

File > Import to import a bitmap graphic or photograph to use as the 

background image. The colours may be a bit strong for the tracklist to show 

through, but we will fi x that in the next step.

Now we have a list of the tracks in K3b, but how do we extract that? 

Well, you can either just type it in again, which is a pain, or you can do 

something a bit tricky. K3b doesn’t have a plugin to export track listings, but 

there is a simple console script we can type in to get this information. If you’re 

feeling brave (and there’s really nothing to be scared of) open a terminal and 

type:

for ((x=1; x<=`dcop k3b K3bProject-0 trackCount`;x++)); do echo “$x. “`dcop 

k3b K3bProject-0 trackArtist $x`” - “`dcop k3b K3bProject-0 trackTitle $x` >> 

tracklist.txt; done

Go to Applications > Graphics and choose Inkscape from the list. The 

program will open up and create a default document, which will be A4-

sized. We could just draw on the bit we want, but it’s much better to make the 

document the correct size to begin with. From the menu, choose File > 

Document properties. Now we can tap in the size that we want. If you have 

some pre-made inlays, the size may vary – you can always measure your CD 

case. The most common size is 117.5mm squared, so enter these numbers 

and make sure to select millimetres from the pop-up menu of unit types in 

the right of the box.

1 2

3 4

Step by step: Design your inlay card
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Make a compilation CD

If we want to have black text for our track listings, it would be better to 

have a light background. We can do this with a semi-transparent 

overlay in Inkscape. Drag out another, smaller square. In our example we have 

rounded the corners. You can do this by dragging the circle in the top-right of 

the box you drew, or entering values in the Rx and Ry boxes in the toolbar. With 

the rounded square selected, we can go back to the Fill and Stroke settings. 

This time we will make both solid white (R,G and B values of 255), but set the 

A value to 120. This makes the whole object semi-transparent. You could set 

the Stroke value to a higher number to give a border effect.

Now choose the text tool from the right-hand panel and drag out 

another rectangle inside the panel you just created. This will hold the 

text from our track listing. If you copied it from the text editor earlier, you can 

just do Control+V to paste it in, otherwise you will need to type it out. Don’t 

worry about the font and size until you have entered it all. When you’re done, 

click on the T icon in the top toolbar. This opens up the window for changing 

text – choose a font and size you like, or go crazy and use different fonts for 

each line if you like! When you are done, press Control+S to save the fi le and 

then choose File > Print to print it out.  LXF

5 6

Exploring the Inkscape interface

The pointer tool is used for 

selecting, moving and 

resizing objects.

Use these buttons to open 

and save files.

The text tool adds a text area object to 

your drawing.

You can use layers to organise 

complicated objects.

The magnify buttons quickly 

switch between zoom levels.
The Font and Style button is 

used to change text styles.

Click here to pick a colour for 

the object.
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Instant messaging 

W
ith more of us staying online for longer, and 

persistent always-on internet connections 

becoming increasingly common, instant 

messaging and online personal communication 

has become an essential desktop tool. Fortunately, Linux is 

well catered for by messaging software, especially if you’re 

used to the advertisement-crippled, costly and unfriendly 

messenger clients you typically find on Microsoft Windows. 

You’ll find that you can do everything you’re used to with the 

Linux versions of the software you’re used to. And you’ll find 

that you can still chat to people who choose to keep to their 

old operating system ways, bridging the divide between open 

source and proprietary software. 

Pidgin
The default instant messaging client for the Ubuntu desktop is 

called Pidgin. It’s better than it sounds. Pidgin is capable of 

communicating with all the main messaging services at the 

same time. This means that if you’ve got an account to use 

AOL Instant Messenger and an account to use Microsoft MSN 

messenger, you’ll be able to use both from the same client 

transparently. You can’t do that with either of those clients on 

the Windows platform, and Pidgin can communicate with 

plenty of other protocols too, including ICQ, Yahoo, Google Talk, 

Bonjour and IRC, all concurrently. It manages this because the 

developers behind Pidgin worked out how each client talks to 

one another, and have created their own library that brings all 

this functionality into one place. As a result, the Pidgin library is 

now used by several other high-profile instant messenger 

applications on both Microsoft Windows and Apple’s OS X. As 

Pidgin is open source, there’s nothing to stop any other open 

source developers using this library freely. 

Start Pidgin from the Applications > Internet menu. The first 

time you do this, you’ll be guided through a simple wizard that 

will get you up and running. Click on the ‘Add’ button to add a 

new account. To Pidgin, each messenger protocol is a new 

account. If you want to use MSN and AOL at the same time, 

you’ll need to create two accounts. Just choose the account 

you want to add from the drop-down protocol list. The one 

thing that Pidgin can’t do reliably from the main window is 

create accounts for each protocol if you don’t already have one. 

With MSN, for instance, you can only add your login details – 

you can’t create a new account. The only way around this 

problem is to either use the native version of the messenger 

protocol you want to use to create a new account, or use the 

website of the messenger protocol if it has the facility to create 

an account. Both AOL and MSN offer this as an option.

Getting started
When you have the data you need – which is normally just a 

username and passsword – enter those details into the Add 

Account window. In Pidgin terminology, ‘screen name’ is the 

username you use to log in to your account, while the alias is 

the name you want your contacts to see after you’ve 

connected. After clicking OK, Pidgin will attempt to make a 

connection to your account provider. A few moments later, you 

should see your list of contacts appear in the main window 

and you’re ready to chat. If you don’t see any of your contacts 

in the Buddy List window, you either haven’t made any friends 

yet, or none of your friends are online. By default, the Buddy 

List will only show friends that are currently connected to the 

network, hiding your offline contacts from view. If you want to 

make sure your contacts are registered, enable ‘Show Offline 

Buddies’ in the Buddies menu. That menu can also help you 

change the order of your buddies if you have too many to be 

easily manageable. 

Instant messaging
Communication is an integral part of the computer desktop, and Linux has 
some of the best applications in this class to choose from.

 Pidgin can 

communicate 

with nearly every 

other messaging 

protocol, bringing 

all your contacts 

from these 

services into 

one place – the 

Buddies List.

 You’ll need to create an account for AOL’s instant messenger 

and MSN Live using another client or the web interface. You 

can’t do it from within Pidgin. 

For MSN, point your 

browser at:

https://

accountservices.

passport.net/

ppnetworkhome.srf

For AOL, point your 

browser at:

https://

my.screenname.

aol.com

Quick tip
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 Changing your status is a nice way to keep your contacts up 

to date with what you’re up to without getting drawn in to a 

time-consuming conversation.

Google Talk
If you use Google’s email service, GMail, you will have 

come across Google Talk. It’s the integrated messaging 

client you can use from your browser while you’re 

checking email. But it’s also possible to connect to the 

Google Talk network with Pidgin. The only problem is 

that some of the settings in the default Google Talk 

configuration are wrong. To get it working, open the 

Accounts window (Accounts > Add/Edit menu), click 

on ‘Add’ and select the ‘Google Talk’ protocol from the 

drop-down list. In the Screen Name field, enter your 

GMail username without the @gmail.com or 

@googlemail.com part. For the domain field, enter the 

gmail.com or googlemail.com part of your username 

and switch to the Advanced tab. On this page you need 

to enable the top option (Force old (port 5223) SSL), 

and change the port to 5223 for good measure. The 

connect server field should also contain talk.google.

com. When you save the options, you’ll be asked for 

your password (unless you entered one into the 

password field), and you will find that you connect to 

All you need to do to initiate a chat is double click on one of 

your contacts. After doing so, the messenger window will 

open, and it’s from here that you can chat and see your 

contact’s messages. If you’ve used an instant messenger 

client before, this should feel familiar, and there really isn’t all 

that much to it. You type in the lower area and the message 

history scrolls through the top area. You can add smiley 

characters to your conversation (known as emoticons) using 

either the insert button, or the key combination if you happen 

to know it. Pidgin will also interpret emoticons used by your 

buddy, and you’ll see the images for those embedded within 

the conversation window. When you receive a message, the 

window will flash as a notification, as will the tiny Pidgin icon in 

your toolbar. If you’ve got speakers connected to your Linux 

box, you’ll also hear a jingle, and sound options can be 

changed from the Preferences window by switching to the 

‘Sounds’ tab. 

Tyop alert!
While typing your replies, misspelt words have a red 

underscore, and you can see the suggested correction by 

right-clicking on the offending work. 

With most protocols you can also 

format your conversation using the font 

button. You can change your font by 

selecting the ‘Font Face’ option, but you 

can also change the appearance of 

general text by selecting bold, italics, 

underline or strikethrough, as well as 

change the colour. 

If you’re connected to more than one 

account at the same time, contacts for 

each account are silently added to the 

buddies list. Pidgin keeps the protocol 

each contact is using hidden simply to 

keep the user interface clear. It 

shouldn’t make any difference to 

conversations, as most of the major 

protocols share the same core 

functionality such as sharing files and 

the use of emoticons. The only way you 

can tell which protocol each contact is 

using is by holding the mouse over your 

buddy and reading the information from 

the window that pops up. If you want to 

add buddies, you need to know their messenger ID for the 

protocol you’re both using. If you’d like to see which protocol 

everyone is connected to all the time, just select ‘Protocol 

Icons’ from the File > Show menu.

Status messages
You can see your current status in the drop-down list at the 

bottom of the buddies window. Most of the time it’s ‘Available’, 

but you an also change this from the same list. ‘Invisible’ is a 

useful choice, for example, because it enables you to see 

which contacts are online without them seeing you. Another 

important aspect to status messages is leaving your computer 

unattended. By default, Pidgin will wait a set period of time 

(configured in preferences) when there’s no activity on your 

computer and change your status to ‘Away’. Your contacts will 

then see this as your current status, and most messenger 

clients will also fade out your name in the contact list. But you 

can be more imaginative, and change your away message to 

something else. Many people like to say what they’re doing, 

and while you don’t have to be quite so zealous, a small 

message can be useful if someone is waiting to contact you. 

 You can change which set of emoticons are used from the 

Preferences window, and Pidgin can also download your 

contact’s custom emoticons when they use them.

 Google Talk works well with Pidgin – you just 

have to connect to the server manually.

Google Talk without further hassle. One thing to be 

wary of is that if you log messages in GMail, these will 

still be logged even if you’re using Pidgin. 
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T
here is a lot you can do to customise the Pidgin 

environment, but the first thing you should do is 

create an avatar for yourself. An avatar is an online 

representation of someone’s real-world character. 

These are seldom serious, and most people change them 

often to reflect their mood, adding some much-needed 

character to a world of text. It’s easy to create your own. First 

find an image you want to use – it needs to be square, and you 

might want to trim it slightly, as Pidgin offers no scaling 

options other than resizing. When you’ve found an image, click 

on the small icon in the bottom-right of the buddies list. This 

will open a file requester from where you can navigate to your 

image. After it’s selected, Pidgin will resize the image. Most 

protocols only use small images of 64x64 pixels, so your 

image needs to be easy to see. You can see it has replaced the 

original icon in the bottom-right of the buddies list, and it’s this 

image that people will see when they chat to you. 

Plugins
The best way to add things to Pidgin is through its wonderful 

plugin system. If you’ve not come across plugins before, 

they’re separate modules that can be enabled to add 

functionality to an application. They’re left optional so that 

users can pick and choose which ones they prefer. It’s a little 

like adding extensions to Firefox, for instance. The plugins 

window is opened by selecting ‘Plugins’ from the ‘Tools’ menu. 

This window lists each plugin with an enable box to the left of a 

short description. Clicking on the enable box will start the 

plugin. Here are a few of our favourites:

 Auto-accept If someone sends you a file, you normally have 

to switch to the message window and accept the request. This 

plugin does it for you, downloading the file automatically 

without you having to do anything. You don’t need to worry 

about getting spammed with files, as only your contacts can 

send them.

 Buddy ticker If the vertical Buddies List takes up too much 

room, try the Buddy Ticker. It creates a sideways scrolling 

equivalent that takes up less room – your contacts slide 

across a narrow window on your screen, and you can use this 

list exactly like the normal window for starting conversations.

 Contact availability This is a clever plugin. It monitors what 

time of day your contacts are online so that it can estimate 

when they’re likely to be available. This is great for people in 

your contacts list who are in a different time zone, or people 

who only connect to the internet at certain times of the day.

 History This is an essential tool if you’ve got a lot of 

contacts. It shows the end of your previous conversation 

when you start a new one, so you can remember what you 

were both talking about. Even if you haven’t chatted to your 

buddy in weeks, the greyed out section 

of the conversation will show you your 

last mutterings. 

 Psychic mode Pidgin knows when a 

contact starts to type a message to you. 

With this plugin enabled, it will open the 

message window before the message is 

even sent. You can tell when someone is 

typing because a small keyboard icon 

appears in the top-right of the chat 

window. This is essential when you’re 

both in full flow.

 Text replacement This plugin will 

replace certain strings you type in the 

message window with those you want 

them replaced with. This is useful for 

long words, or even for automatically 

correcting common mistakes. You might 

want to replace ‘youve’ with ‘you’ve’ for 

example, or replace a codeword with a 

long address.

Buddy Pounce, found in 

the tool menu, will send 

a message to a contact 

as soon as they appear 

online. 

Quick tip

Customising Pidgin
Now that you’ve got Pidgin working, it’s time to make it feel more like home.

IM troubleshooting
Most instant messaging and VoIP problems are 

caused by firewalls blocking the ports necessary for 

one client to talk to another. This is because file 

transfers and chat use different ports. Opening the 

correct ports on your firewall isn’t always an easy job. 

If you’re not using a firewall you should have no 

problem, but if you are, you need to open ports on the 

firewall for the protocols you’re having problems with. 

MSN uses TCP port 1863, but if you use the HTTP 

option in Pidgin, it will use port 80. This is the same 

port that web browsers use, so it should definitely 

work. AIM uses TCP and UDP port 5190. Ekiga uses 

many different ports, and installing Stun (as requested 

by the install wizard) solves most connection 

problems. Most firewalls will have the option to enable 

common VoIP/SIP/Video Conferencing ports, and you 

should do this if you’re having problems. 

If your machine is connected to the internet 

through more than one router, this can also cause NAT 

problems. Try to create a direct route to each machine 

 Many firewalls feature predefined rules for letting 

VoIP and instant messaging through.

 There are loads of plugins to choose from – our favourite 

translates one language to another in real time.

you want to use by creating static IP addresses and 

routes from one connection to the next. If your router 

has the facility, use NAT on your router to forward all 

VoIP ports to the machine you want to run Ekiga on. 
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T
he most popular voice and video conferencing 

application for Linux is called Ekiga, and it can be 

found hidden in the Applications > Internet menu. 

When first launched, Ekiga will ask you for your name 

as well as a username and password that will be used to create 

an account on ekiga.net, which is the portal through which 

people connect and disconnect. Ekiga.net is run by 

volunteers, and is entirely free to use. Other users of Ekiga 

need to do the same, and it’s through this portal you’ll be able 

to make calls to other people. If you already use an alternative 

SIP service, you can configure Ekiga to use this instead. 

Alternatives include users of Microsoft’s video conferencing 

software, which Ekiga can be configured to work with – in 

which case ignore the request for a username and password. 

Setup
After the Ekiga account setup, the configuration assistant will 

try to detect your NAT type. This sounds technical, but all it’s 

really doing is trying to work out how to reach your computer 

from the internet. If you have several machines sharing the 

same internet connection, and therefore the same IP address, 

the NAT type will be different from the type used by a direct 

connection. If your firewall is restrictive, you’ll also be asked to 

enable Stun support. 

After that, you’ll be asked for your sound configuration. If 

you’re using a microphone, you need to make sure the correct 

input is selected. Click on the ‘Test Settings’ button on page 7 

to open a window that shows the signal coming in from the 

selected audio input. If your microphone is working, you’ll see 

the volume meter bounce up and down and hear the output in 

your headphones or speakers. If you don’t see anything, you 

need to select a different input on your sound card. If you see 

something but don’t hear anything, you need to select a 

different output for your speakers or headphone output and 

check the volume settings. Most of the time, the default 

settings should be fine. Ekiga will then try to detect your 

webcam. Any Linux compatible webcam will work, and you 

shouldn’t need to change any of the default values. 

A good place to start is the echo test. Dial 500, and you’ll be 

connected to a computer that will echo everything it hears. 

This is a good way to make sure everything is working as it 

should be. For others to dial you, they can use your username 

followed by @ekiga.net. If you know the SIP address of the 

person you want to contact, you enter this directly into the top 

field of Ekiga. You can also use the Ekiga White Pages directory 

to find other Ekiga users. This is opened from the Tools menu, 

and with a total of over a 1/4 million registered Ekiga users, you 

need to use the ‘Find’ field to search for your contact. Video 

and voice calls will work automatically, and you can fine-tune 

the sound and video by switching tabs in the lower half of the 

screen. The Audio tab shows the volume for incoming and 

outgoing sound so that you can be sure the person on the 

other end is getting the data, and the video tab lets you change 

the brightness, contrast and colour of the incoming image.  LXF

VoIP and video conferencing
Sometimes, typing text just isn’t enough. Linux has several messaging 
clients that can manage voice and video.

Skype, the phone call 

replacement service 

owned by eBay, is a 

popular alternative to 

Ekiga. It’s a proprietary 

piece of software, but 

it’s free to use. You 

only pay to connect to 

landlines and mobile 

phones. There’s also a 

Linux client available 

from the Skype website. 

www.skype.com

Quick tip

 It’s essential you get audio working correctly from within 

Pidgin. As long as you can see both audio meters bouncing, you 

can be sure your configuration is working. 

 NAT problems account for most connection difficulties, but 

things have improved with the inclusion of the Stun package.

 The Ekiga White 

Pages is an online 

directory to find 

other users of 

Ekiga. You can 

also call anyone 

else with a SIP-

compatible client 

or phone.
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 The official 

BitTorrent site, 

www.bittorrent.

com, has lots of 

legal downloads of 

movies, TV shows 

and music, and 

even has free stuff!

BitTorrent

W
ith record companies suing their customers all 

too regularly, file sharing has gotten a bit of a 

bad name. But it’s not all illegal content – in 

fact, there’s a lot of great content you can get 

through BitTorrent, particularly if you’re interested in getting 

more open source software. 

Downloading files is, of course, what BitTorrent was 

designed to do, but when you’re downloading a file there are a 

few other things you should know about. First: you can pause 

BitTorrent downloads, then later on pick up where you left off. 

Unlike downloads from the web, this isn’t a hit-and-miss affair: 

as long as someone, somewhere is still active on that 

download swarm, you will always be able to pick up where you 

left off. This works because the BitTorrent protocol is designed 

to take very large files (even 4GB distro-sized files) and split 

them up into 4MB chunks that are then passed around the 

swarm. So if you pause your download, BitTorrent knows how 

many of those chunks you already have, and can just pick up 

from there when you resume – magic!

If you pause a download then reboot your computer, you 

need to take one of two steps to pick up your download from 

where you left off. If you downloaded the Torrent file rather 

than selecting ‘Open With BitTorrent’, the best thing for you to 

do is to run BitTorrent directly and ask it to use the Torrent file 

to resume. By default, BitTorrent doesn’t appear in the Ubuntu 

menu, so right-click on Applications, choose Edit Menus, select 

the Internet category and ensure the BitTorrent menu item is 

selected. Now you can go to Applications > Internet > 

BitTorrent – when it asks you for a meta file, just select the 

Torrent file you downloaded. If you didn’t download a Torrent, 

you need to go back to the website where you originally 

started the download, and click the download again. When 

BitTorrent starts up, it will recognise that you’ve partially 

downloaded the file, and will ask you whether you want to 

resume or start from scratch.

To set caps on your upload bandwidth, click the ‘Upload’ 

tab for any one of your downloads. You can set a cap on the 

total bandwidth used for uploads, the number of individual 

users you want to upload to, or both. In practice, the user cap 

isn’t very important, because if you want to restrict bandwidth 

by capping uploads to 10 user, those 10 users might have 

super-fast connections, in which case your upload speed will 

effectively be uncapped! Instead, stick to the bandwidth cap: 

the default of 20kB/s a second is quite generous, and should 

be more than enough to satisfy any tit-for-tat users. 

Leave it running
The second thing is that the BitTorrent window will stay open 

even after you have finished downloading a file. This is the 

same “leave it running” principle, but for a different reason: 

once you have finished downloading the file, you are one of the 

people in the swarm with a 100% pristine copy of the 

download, which means you’re able to help any other 

download get pieces they are missing. People with 100% of 

files are known as “seeders”, whereas people with less than 

100% are “leechers” – leaving your download active when 

you’re a seeder won’t chew up any download bandwidth, but it 

will let you contribute something back to everyone else in the 

swarm so that the download is propagated elsewhere. Think 

about it: the only reason you were able to download the file in 

the first place is because someone else left their download 

active and seeded the file for you, so it’s only fair for you to do 

the same for other people!

And that’s it: you’re all clued up on the power and magic of 

BitTorrent. Next stop: finding some cool stuff to download!

Downloading 
with BitTorrent
Get files the fast way, and help build a community at the same time!

BitTorrent and the law

Some people will tell you that BitTorrent is illegal, but that’s 

not true – BitTorrent has lots of legal uses, of which downloading 

distros is arguably the most popular. But BitTorrent is used a 

great deal for trading copyrighted software, music and movies, 

and that is illegal, so you ought to be very careful with what kind 

of files you download. Even though the BitTorrent protocol 

seems rather random and complex, it’s all traceable, which 

means if you try downloading movies illegally you may be caught 

and fined – or worse.
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Find something to download: BitTorrent works at its best with 

very large fi les, so we’ve gone right to the top – a nice big Linux 

distribution! But there are lots of other things around to download; sites 

like www.publicdomaintorrents.com are full of great content.

Step by step: Download with BitTorrent

Open the torrent: When you click on a Firefox link for a Torrent fi le, 

you’ll be asked whether you want to open it with BitTorrent or save it to 

disk. Chances are you want to open it straight away, so just click OK.

2

Choose a location: BitTorrent will start up and ask you where you 

want to save the download. Keep in mind that some torrents are made 

up of many fi les, so you probably want to save your torrent in a subdirectory 

somewhere.

3
Check your progress: This is the download screen, and the one you’ll 

be seeing most of the time. It shows you how much data has been 

transferred and how much time is remaining until the download completes. 

Note the Stop button – that’s for pausing downloads.

4

Cap your uploads: For any given torrent, you can set upload caps. 

These are disabled by default, meaning that BitTorrent will upload as 

much as it can without sacrifi cing too much download speed.

5
What’s going on?: The Events tab is important for times when your 

download isn’t working – if the tracker goes down, or if your network 

connection suffers problems, you’ll read about it here.  LXF

6

1
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Printing

Setting up 
your printer

Getting your printer to work with Ubuntu is simple; just follow this tutorial to get 
the inside information on how to do it.

The easiest way to set up a printer is simply to plug it into your 

computer. If Ubuntu detects that a printer has been connected, you’ll 

see a small icon appear in the taskbar with a magnifying glass, indicating that 

Ubuntu is searching for information and drivers about the printer.

Step by step: Print with Ubuntu

H
aving access to a printer is a crucial part of your 

desktop environment, especially in the age of 

digital photography, with many people purchasing 

printers for the sole use of printing out their 

photographs. However, whether you are producing simple 

epistles or high-quality newsletters that are distributed to a 

wide number of recipients, it’s important that you can 

successfully connect and configure your printer to get the best 

results. Ubuntu makes this whole process incredibly easy, and 

you should be up and running next to no time.

If you haven’t yet purchased your printer, it might be a good 

idea to do some preliminary research before you go out and 

buy one. Not only should you be interested in the quality and 

speed of printing, but also whether or not it is supported by 

Linux. Don’t worry too much, as a huge number of printers are 

either directly supported or supported through a generic 

driver. If in doubt, head on over to http://openprinting.org to 

search their database. As a rough rule, try to stick to printer-

only models; multi-function machines (scanners, fax machines 

etc) can prove tricky to configure and get working. Ubuntu 

supports a range of connection methods, so you may want to 

consider buying a network-enabled printer that will allow you 

to use it without it having to be tethered to a computer. Also 

included is USB support and the older parallel port 

connectivity. Ubuntu will even let you share printers among a 

number of workstations, allowing you to set up a printer once 

and connect to it easily from other clients.

In this walkthrough, you’ll see how Ubuntu can 

automatically detect and configure your printer. We’ll also 

cover some of the other printer-related options that you can 

set using the tools supplied with Ubuntu.

1 Ubuntu has detected and installed the correct drivers for the newly-

connected printer. It is now available for printing, so you can go ahead 

and start using it. Sometimes you might need to change some of the defaults, 

so click the Confi gure button to open up the Printer Confi guration tool.

2
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Access Control allows you to specify users who can or cannot use the 

printer. In our example, we’re keeping the printer to ourselves and not 

letting the rest of LXF Towers have access to it. This could come in useful if 

you want to prevent your kids from wasting valuable colour ink cartridges!

5 Printer Options lets you set page size, quality and whether or not you 

use double sided printing. Note that resolution, quality, ink type etc is 

controlled by the Printout Mode drop-down box, so if you choose High Quality 

your printer will automatically choose a higher resolution.

6

Job Options is the place where you can choose exactly how each 

submitted print job is handled. Here you can choose to print multiple 

copies or change the margins of the print out. Bear in mind that these options 

will override any that have been chosen when a user prints to that printer.

7

Ah the beauty of open source; Ubuntu’s printer confi guration tool is 

derived from system-confi g-printer, which is a tool created for Fedora, 

another Linux distro. In the opening screen you can change the Printer 

Description and also print a test page to check the confi guration.

3 Under the Policies tab you can quickly disable access to a printer 

should you need to carry out any maintenance on it. Also of use, 

especially in a corporate environment, are the starting and ending banners, 

which allow you to add additional pages before and after the main print job.

4

There may be occasions when Ubuntu just flat out refuses to recognise 

your printer. In these (rare) cases, your first step should be to Google the 

model of the printer along with the word Ubuntu or Ubuntu 7.10. It’s actually 

quite an effective way of finding information quickly and allows you to 

benefit from the experience of other people who may have been in the same 

situation as you.

If that provides no joy, then try some of the following sites:

www.openprinting.org Part of the Linux Foundation, you’ll find a 

comprehensive list of printers along with a breakdown of the level of 

compatibility that you can expect from Linux. 

http://hplip.sourceforge.net The official HP website dedicated to the 

HP laserjet and inkjet range of printers. You can find techical documentation, 

FAQs and other information that may be of help to you if you have an HP 

printer.

www.canon-europe.com/Support/software/linux An official Linux driver 

download area for a limited number of Canon Pixma printers. However, these 

are unsupported by Canon themselves. If you have a Canon printer and 

would like to register your interest in getting a Linux driver, then click the 

Other Printer Users hyperlink and let them know!

Printing resources on the web

 Where to go for more information
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First and foremost, open up Ubuntu’s printer confi guration tool by 

going to System > Administration and choosing Printing.

Step by step: Setting up a networked printer

S
o that’s the initial plug and play installation of a 

printer, as well as some of the configuration options 

that you can set. In this next section we’re going to 

show you how to set up a printer that uses a network 

interface, something which is becoming more and more 

common. We’ll also take a look at sharing printers with other 

computers; after all, what’s the use of a printer if only one 

computer out of several can access it? Finishing off this 

tutorial, we’ll examine how you can use the CUPS web 

interface to configure your printers, neatly bypassing the GUI 

printer configuration. 

So you’re in the position where you need to add a network 

printer to your Ubuntu installation. By a network printer, we 

mean any printer that is accessed via an Ethernet interface, 

either directly connected to a network or connected via a 

network print server. In this tutorial we’ll assume that you are 

using an HP JetDirect card – these are the most common 

printers found in corporate environments, but you can tailor 

the instructions to your specific circumstances.

1 You’ll see the blank printer confi g window; to get started, click the New 

Printer button in the toolbar. Ubuntu will automatically try to search for 

new printers that it might have missed. If it doesn’t fi nd one, then you’ll be 

asked for the connection type.

2

Earlier we mentioned CUPS (the Common Unix 

Printing System), which forms a major part of the 

whole printing environment for Linux, not to 

mention Apple OS X and other Unix-based 

operating systems. CUPS is present on Ubuntu, 

although you tend to use the printer configuration 

tool to write the information that CUPS needs. It 

actually has a web-based interface that you can 

use if you want to, which is accessible by opening 

up your web browser and entering the address: 

http://localhost:631. Port 631 is the port that 

CUPS listens on for any requests, so when you 

enter this you’ll see the CUPS welcome page. 

Because it is the foundation for the printer 

configuration tool, you’ll find it very similar to what 

we covered earlier. Just click the Add Printer button 

on the front page to begin; all the questions you are 

asked are the same as the ones that we covered 

earlier with the only real difference being that 

CUPS begins by asking you to name the printer 

right at the start rather than at the end as with the 

printer configuration tool. As CUPS is integrated 

with the printer configuration tool, any changes you 

make within CUPS will be reflected in the printer 

configuration tool, and vice versa. 

The CUPS way

 Doing it over the Web.

 The CUPS web-based configuration tool is at 

http://localhost:631.
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Now you’ve chosen the manufacturer, it’s time to choose the specifi c 

model of printer that you have. You may see a couple of drivers available 

for a particular printer; we’d strongly suggest sticking with the 

recommendation, unless you have a specifi c reason to use another one. Once 

you’ve selected your printer model and driver, click Next to continue.

5 Next up is the screen that allows you to provide some descriptive 

naming for the printer in question. This will help you if you have to share 

the printer with other people, as it provides a way to identify it. We’d 

recommend fi lling all three of these fi elds as they may come in use in future. 

The location is a must in a large corporate environment! 

6

We want to share this printer with other systems, so we need to tick the 

Share Published printers check box. Don’t tick the ‘Allow Printing From 

The Internet’ box, as this may leave your system open to possible attack from 

outside. Make sure to click the Apply button to make the changes.

7

If you’re setting up a network printer, we’d recommend assigning static 

IP addresses; make sure and consult your printer documentation for 

more information on how to do this. Meanwhile, click Forward to continue.

3 The next screen that is shown allows you to select a Printer 

Manufacturer, in order to fi lter the sheer number of printers available. 

Scroll through the list and select the correct manufacturer for your printer 

and click the Forward button.

4

Provided you’ve got the Show printers shared by other systems box 

ticked on the printer Server Settings of the client that you want to share 

the printer with, you should see something similar to the above screenshot 

where a Remote Printers section appears and the printer that was shared is 

shown as an entry.   LXF

8
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N
o matter what type of computing environment 

you’re in, it takes only a minor slip to allow potential 

hackers access to your system. Fortunately, 

Ubuntu is a fairly secure system, benefiting from 

swift security updates and bugfixes where necessary to ensure 

that your system remains in a safe and secure state.

While some would argue that security is best implemented 

with a myriad of tools, it’s also fair to say that security is also a 

state of mind, a way of thinking about how you work that 

enhances the security available to you. In this tutorial we’ll take 

a look at some of the ways in which you can minimise any 

security risks by doing some very simple things.

Password protection
One of the simplest, yet most common forms of security is 

the common password. You will have been asked to create 

one when you installed Ubuntu and it’s likely that you haven’t 

changed it since. However, is your password secure? Let’s 

take a look at some of the more common pitfalls that 

passwords can encounter.

First of all there is the mistake of choosing something too 

simplistic, like the infamous password which is simply 

‘password’. Believe it or not, but there are people, many 

people out there who choose this word as their password, 

because it’s easy to remember. The trouble is, it’s also easy to 

guess, and quite frankly if you’ve used it then you deserve to 

have your system hacked into and trashed. Another common 

password choice is the name of a spouse or child – again, if 

the would-be hacker knows you then it’s not a bad guess to try 

the first names of all your relatives that they know in an 

attempt to gain access to your system.

So what is a good choice of password? Well, it’s time to 

learn a very simple method of creating a good password that 

is also easy to remember, a common problem in our 

password-oriented lives. First of all, think of a phrase that you 

know well. It could be something as simple as Every Good Boy 

Deserves Football, a phrase we learned while being taught to 

play the piano. Take the first character of each of the words to 

give you egbdf – seemingly gibberish, but easy to remember if 

you’re a musical person. Because passwords are case 

sensitive, we’re going to capitalise the first and last character 

to make EgbdF. Just to make it more difficult to guess, we’re 

going to add 123 to the end of it, to end up with EgbdF123 

giving us an eight-character password with some complexity 

(capital letters and numbers).

Make it more complicated
The other classic example is using a modified phrase, for 

example, ‘This is a good choice of password’ would give us 

tiagcop. You could then capitalise the t and the p, use an 

exclamation mark in place of the i and use a zero in place of 

the o, leaving us with T!agc0P, giving us the added complexity 

of using punctuation as well as capitalisation and numbers. 

Obviously the longer the password, the better, especially if you 

include capitalisation, punctuation and numbers.

Creating a single password is not the sole answer though – 

in order to keep it as secure as possible, you need to change it 

on a regular basis, such as every couple of months or so. 

Ubuntu makes this process easy to do, and you can get 

started by going to System > Preferences > About Me. You’re 

asked to authenticate yourself first of all by entering your 

existing password and clicking on the Authenticate button. 

When you’ve done this, the additional two fields below the 

Current Password field become active, allowing you to enter 

Secure your distro
Linux is inherently a secure operating system, but it’s not all done for you…

 Enter your current password and click the Authenticate 

button

 The About Me 

utility can be used 

to change your 

password.

Once it’s open, 

simply click the 

Change Password 

button and a new 

window will pop up.
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your new password in and re-type it in case you made a 

mistake. Ubuntu will keep you on the straight and narrow, 

letting you know if the two passwords don’t match. After 

entering your new password twice, you’ll be prompted to click 

the Change password button to formally change your 

password, so do so. Finish off by clicking the Close button.

Perimeter security
Of course, passwords aren’t the be-all and end-all for security 

in Ubuntu. In fact, by default Ubuntu doesn’t listen on any 

network ports at all, meaning that if a remote user tries to 

access your system, they won’t be able to see it on the 

network. This is a good thing, but you shouldn’t get it confused 

with having a firewall in place, as a firewall does something 

slightly different. 

The only issue with not listening on ports is that when you 

install services that use network ports for access, these ports 

then become active. For instance, if you install Apache (the 

web server) for Ubuntu, it automatically starts to listen on port 

80, which is the standard port for HTTP traffic. Therefore your 

computer is now open to attack on port 80, something that 

you need to be aware of. The same holds true if you install any 

other services, such as SSH or FTP servers. This is where a 

firewall comes in, especially if you only want to have local 

access to these services while you’re learning about them. But 

first and foremost, it’s a simple rule: only install software that 

you actually are going to use. Keeping software on a system 

and leaving network ports open is never a good idea!

So to the firewall then. First the good news: Ubuntu doesn’t 

come with a firewall enabled by default, because it relies on 

not listening on any ports. This doesn’t mean that there isn’t a 

firewall installed, as Iptables is present on every Ubuntu 

installation. What it does mean is that the firewall does not 

control any of the traffic coming into or out of the system. So 

we need to find some way of configuring and activating this 

firewall, and to do this we’re going to install a package called 

Firestarter. Head on over to System > Administration > 

Synaptic Package Manager and search for and install the 

package named firestarter. Once this has completed, you’ll 

find it under Applications > Internet > Firestarter.

User security
Another security feature that Ubuntu offers is the ability to 

restrict access to files and directories depending on 

permissions. A full discussion on file and directory 

permissions is outside the scope of this tutorial, but we can 

look at some of the basic principles to get you familiar with 

the concept.

Every user on the system has a numeric user ID. Ubuntu 

starts these at 1000, and for every new user this number is 

incremented by 1. Each user can also belong to one or more 

groups, depending on how you manage them. By default a 

group is created with the same name as the user, and they 

If you need to share information with another user, then you 

can add them to your group by going to System > 

Administration > Users and Groups. In the tool that appears, 

click the Manage Groups button on the right-hand side and 

scroll down until you see the group that corresponds to your 

username. Double-click this group to edit the properties, and 

select the users that you want to become members of this 

group. Click on the OK button to apply the changes, and give 

read-only access to your home directory.

A user can be a member of many different groups, and you 

may find it more useful to create specialist groups rather than 

using the groups created as part of the user account creation 

process. The only exception to all of this is the root user, who 

has access to anything on the system at any time. By default 

Ubuntu disables the root account, instead relying on the sudo 

command to carry out administration tasks. As the primary 

user you have access to the root user powers, and can activate 

this at the terminal by issuing the command:

sudo -i
You’ll be prompted for your password, and once you’ve entered 

this, the prompt will change to a hash mark (#) to denote the 

fact that you are working as root. From here you can navigate 

through the entire system if you want, or you can fire up a file 

manager window by entering the command:

nautilus &
Be very careful when working as root – you have the absolute 

power to destroy everything, and Ubuntu won’t stop you.

The power of root

 The Permissions 

tab under Home 

> Properties is 

the place to be to 

define who can do 

what to your files.
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The fi nal screen prompts you to save your options and start the 

fi rewall. If for some reason you don’t wish to start the fi rewall at this 

point, un-tick the Start Firewall Now check box and click the Save button.

Step by step: Confi gure a fi rewall

In Ubuntu, the user details are 

usually stored in /etc/passwd along 

with the numeric User ID and Group 

ID. The actual password is not stored 

here – instead you’ll see a small x 

when looking at this file, which 

denotes that there is a password 

present. The actual passwords are 

stored in an encrypted format within 

/etc/shadow, which will look like 

gibberish if you try to view it and will 

not resemble your true password. 

However, if an outsider manages to 

get a hold of this file then they can 

use a number of freely available tools 

to try to extract this password 

information. Usually these tools rely 

on what are known as dictionary-

based tools, in that they have a large 

collection of dictionary words that 

they use to try and unlock your 

password information. The tools will 

literally cycle through all the words 

available, as well as common mis-

spellings, in an attempt to match one 

of them with your password. By 

using the technique that we showed 

you to create a strong password, you 

will minimise the risk of any 

dictionary-based attack as your 

password will not be based on a 

dictionary word.

Password hacking

 How outsiders get your passwords

After a brief introductory screen, you should click Forward to move to 

the Network Device setup. In the Detected Devices drop-down box, 

select the network interface that is connected to the internet – this is 

commonly eth0. If you know that your IP address is assigned dynamically by 

your internet router, then check the IP address is assigned by DHCP box. Click 

Forward to continue.

1
You’re probably using a router to connect to the internet, so you won’t 

need to enable connection sharing. However, if you are using your 

computer as the gateway to the internet, you should enable this setting and 

choose the network device that is connected to the local network. You can 

also choose to use DHCP to assign addresses dynamically to the local 

network, but you will need to have installed the dhcp3-server package prior 

to starting the Firestarter confi guration. 

2

3

also share the same numeric ID although they are for the User 

ID (UID) and Group ID (GID). Your home directory is 

automatically set to allow you full access as a user, and to 

allow read access only to members of your group. This isn’t 

particularly secure, so to start off with we’d suggest changing 

the permissions on your home directory so that access is 

denied to Others. To do this, go to Places > Computer, and 

navigate into the Home directory. Right-click on your user 

home directory and select properties. In the window that 

appears, click the Permissions tab and change the Folder 

Access drop-down menu for Others so that it reads None. Then 

click the Apply permissions to enclosed files to ensure that 

they are locked down. Once you’ve done this, click the Close 

button to make sure that your home directory is protected 

from the snooping eyes of other users local to your machine.
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Firestarter has now activated the fi rewall – you can see in the Active 

Connections area that there is a current connection from the local 

machine to a remote NFS server. Firestarter also keeps track of the amount of 

data that has been sent and received, as well as the current data transfer rate.

To defi ne our fi rewall policy, click the Policy tab in the Firestarter 

window. You can either allow all traffi c for a specifi ed network address 

or address range, or you can allow specifi c services. We’d recommend 

allowing specifi c services where necessary, as this minimises the chances of 

attack from a local machine.

You can either select from the list of services using the drop-down 

menu, or you can manually enter the port number. Firestarter does a 

lookup against the /etc/services fi le to give the port its related service name. 

You are also able to defi ne exactly who can access that particular port.

The last step is to apply the new policy, which you do by clicking the 

Apply Policy button in the toolbar. Firestarter will restart the fi rewall and 

you will now be able to connect to your machine on that port.  LXF

4 5

6 7
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I
f you’ve made it this far in the magazine, you’ll have learnt 

by now that Linux offers you a great deal of choice for 

what program you want for a given task. Take web 

browsers, for example: on Linux you can get Firefox, 

Opera, Konqueror, Epiphany, Lynx, Links, Amaya, Mozilla, 

Kazehakase, Galeon, Dillo, Chimera and more. To be clear, all 

those are real, working web browsers that are being actively 

developed, which means you can try them all and find the one 

that works best for you.

Of course, the problem with all this choice is that your 

menu bars can get very cluttered, which is why Ubuntu ships 

with one application per task – you get one web browser, one 

text editor, one spreadsheet, and so on. If you’ve tried these 

apps and find they don’t work for you, it’s time to stretch 

beyond the Ubuntu sandbox and see what the rest of the free 

software world has to offer you: it’s time to install some new 

software! One last word before we get started: software on 

Linux is bundled into what we call a “package” – that’s the 

software itself, plus any configuration files, documentation, etc. 

These packages are traditionally managed by a package 

manager, which has the advantage that all your programs are 

available from one central place, meaning that they can be 

easily installed and easily updated, that they can be removed 

in the same way they were installed, and that they are 

guaranteed to work.

What’s on the menu?
Go to Applications > Add/Remove to bring up the Add/

Remove Applications dialog. This is split into four main parts: 

at the top you can search for applications; down the left is a list 

of categories by which you can filter, top-middle is the list of 

applications that match the filters, and bottom-middle is a 

description of the currently selected package.

You’ll notice that each application has a check box to its left 

and a star rating to its right: if it is installed currently, the check 

box is checked, and the star rating shows how many people 

have that particular program installed. You’ll 

find that all the packages that are installed by 

default in Ubuntu (eg Gimp image editor) all 

get five stars for popularity, but there are 

quite a few others with five stars too – these 

are the ones that are worth investigating!

From the top bar of the window, first make 

sure that the “Show” option is set to 

“Supported applications”. There are five 

possible options that can be set to:

1   All available applications Shows 

everything.
2   All open source applications Shows 

everything that is free software (as 

opposed to proprietary software).
3   Supported applications Programs that 

the team behind Ubuntu provide official 

support for.
4   Third party applications Programs from 

anyone outside of the free software 

community.
5   Installed applications The programs you 

have installed currently; generally used 

when you want to uninstall something.

As you can see, the ‘Supported 

Applications’ category is the best for new 

users because all the applications in that 

Add new software 
– free of charge!
The default selection of Ubuntu software is useful enough, but there are 
actually thousands more waiting to be installed. We show you how…

 Using a package 

manager means 

that you can install 

nearly everything 

that Ubuntu has 

to offer with one 

simple program.
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category are officially supported by the Ubuntu team – that 

means they will issue patches and upgrades for you as they 

become available. If you want to expand your horizons a little, 

try changing this option to ‘All Open Source applications’. Note 

that this option includes lots of apps that are not officially 

supported by Ubuntu, but that only means you’re not 

guaranteed to have updates issued – you almost certainly will 

get patches and updates, because that’s the nature of free 

software, but you’re not guaranteed them.

Now, let’s get down to the business of installing software. 

Let’s say you’ve decided that OpenOffice.org is too slow for 

your needs, and want something a little faster. You would 

normally use the search box to look for terms such as “word 

processor”, but here I’m just going to give you a tip-off: the very 

first item in the list, AbiWord, is a screamingly fast word 

processor with lots of features, and, along with the Gnumeric 

spreadsheet, makes a great replacement for OpenOffice.org. 

So, select the check box to the left of AbiWord, then click on 

the Apply Changes button at the bottom of the window.

You’ll now be prompted to confirm the list of changes to be 

made – this is because you can add and remove lots of 

programs all at once, and also because sometimes installing 

one program requires that another be removed because they 

clash. Read through the list of changes that will be made (in 

this case, AbiWord will be added), then click Apply. The 

AbiWord packages will be downloaded and installed in a 

matter of minutes, and when it’s finished you’ll see a list of the 

new programs that were installed. Because AbiWord is an 

office program, it will appear under the Applications > Office 

Submitting statistics
The Add/Remove Applications dialog gets its popularity 

information from a program known as Popcon, which is short for 

‘popularity contest’. This program scans your system to see 

which packages you have installed, then uploads it to the central 

Ubuntu server so that they can figure out which packages 

people use and which they don’t, using that to guide their 

decisions as to which software people really want to see 

supported. By default, Popcon is installed but not enabled, which 

means the packages you choose won’t have any effect on the 

overall popularity of all the Ubuntu packages, but if you want to 

take part all you have to do is go to the Software Sources 

window, choose the last tab (Statistics), and check the box 

marked ‘Submit Statistical Information’.

Once you’ve selected what you want and clicked Apply Changes, 

Ubuntu will ask you to confi rm the changes before it makes them.1

The login screen

Ubuntu downloads its software from the internet, so it will take a few 

seconds to download and install the packages you chose.2

Ubuntu will show you a list of all the programs that have been installed. 

Double-click any of them to run them. 3

 If you’re looking for an alternative word  processor to 

OpenOffice.org’s Writer, AbiWord is an excellent choice.
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menu, but you can just double-click on AbiWord in the “New 

application has been installed” box to start it immediately. If 

you ever want to remove a program, just reverse the method: 

uncheck the box and click Apply. 

Using the Add/Remove Applications system is a great way 

to get started managing the software on your computer, but 

more experienced users favour a program known as Synaptic. 

This is less pretty, less streamlined, and more feature-heavy – 

but feature-heavy is a good thing for power users, because it 

means we can get exactly what we want without having to 

struggle around for esoteric options. You’ll find Synaptic 

hidden under the System > Administration > Synaptic 

Package Manager menu item. At first glance, you’ll notice it’s 

not entirely dissimilar to the Add/Remove Applications 

window – there are few icons, sure, but it retains the category 

filters for apps, as well as the description pane that shows 

more information about programs when you click on them. 

Advanced package selection
Now that you’re straying into advanced user territory, 

this is a good time for you to check out the incredible amount 

of software available to you. Go to Settings > Repositories, 

which is where the list of all software sources is kept. Ubuntu 

breaks its package choices up into repositories so that people 

can choose what kind of software they want – as with the 

Add/Remove Applications window, these choice are whether 

you want Ubuntu-supported packages, third-party packages, 

and so on.

For now, we’re going to enable everything, so make sure the 

top four check boxes are checked in the Software Sources 

window that appears. That is, “Canonical supported”, 

“Community maintained”, “Proprietary drivers” and “Software 

restricted by copyright”. With these selected, click Close, and 

Synaptic will warn you that the repository selection has 

changed, which means you need to click the Refresh button to 

download all the software available in that repository.

Once the software selection information has been 

downloaded, you’ll see lots of categories down the left. You can 

use these if you want to, but we generally find that having 

Synaptic search for you is a faster and easier option – press 

Ctrl+F, make sure ‘Look in’ is changed to ‘Description and 

Name’, then type in something you’d like to install, eg “3D 

game”. With all the repositories enabled, it may take a few 

seconds for the search to complete, but when it does you’ll be 

able to scroll through the list of results to find software to 

install.

Dependencies
As with Add/Remove Applications, there is a check box next to 

each package that allows you to mark it for installation, but it’s 

a little more complicated than that – when you click it, a menu 

will appear that lets you 

choose exactly what you 

want to do with the 

package. As it’s not 

currently installed, the 

only option available to 

you will be “Mark for 

installation”, so choose 

that. Whenever you 

choose a package that 

has dependencies (other 

pieces of software that 

are needed for it to run), 

Synaptic will ask you to 

confirm you want to 

continue with those 

dependencies. As you 

become more 

accustomed to Linux, 

you’ll find this particularly 

useful, because it ensures 

you know exactly what’s 

going on to your 

computer.

As we said previously, 

using a package manager 

to install your software 

 Ubuntu’s Update Manager automatically selects all the available 

updates, so all you need to do to stay up to date is to click that 

button marked Install Updates.

 Synaptic gives 

you more control 

over package 

installation, but 

takes a little longer 

to learn.
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means that it can also keep track of software updates and 

prompt you to install patches as they become available. On 

Ubuntu, this is done using Update Manager from the System 

> Administration menu. When run, this will scan all the 

software you have installed and compare it to the latest 

versions that are available for install, and then let you know if 

any updates are available. If there are updates, they are 

selected for you by default, so all you need to do is click Install 

Updates to have Ubuntu download and patch all applicable 

programs on your computer.

As you might imagine, given its advanced user target, 

Synaptic can also upgrade packages. In fact, just next to the 

Refresh button that you click when repositories are enabled or 

disabled is the “Mark All Upgrades” button, which does exactly 

the same thing as Update Manager does – click that, then 

click Apply to have Synaptic update all your software to the 

latest available versions.

Automatic updates
After you’ve spent a few weeks using Ubuntu, you will almost 

certainly encounter the automatic update notification system. 

Behind the scenes, Ubuntu checks the internet for new 

software every day, and if it finds any updates are available it 

will pop up a balloon in the top-right of your desktop to 

encourage you to update. This might seem a bit annoying, 

particularly if the balloon appears while you’re trying to work, 

but trust us: it’s all for a good cause! You see, it doesn’t matter 

how fast Ubuntu gets out security patches – if you don’t know 

about them and don’t install them, they are useless. Having 

the balloon pop up to prompt you means that you can get 

yourself patched as soon as problems are fixed, ensuring that 

your system remains as safe as possible.

This whole auto-update system is configured through the 

Software Sources window from Synaptic, although you can get 

straight to it by going to System > Administration > Software 

Sources. From this window, click on the third tab (‘Updates’), 

and you’ll see that Ubuntu is configured to provide access to 

security and non-security updates, and will notify you when 

they become available. You would be wise not to alter the top 

options – the proposed and unsupported updates may cause 

problems with your otherwise-pristine system, and so are best 

avoided. But you can change the lower option: what do you 

want Ubuntu to do when it finds security updates are 

available? If you have your computer on 24/7, you’ll probably 

find it better to choose the middle option, which causes 

Ubuntu to download any available updates without actually 

installing them.

One last thing: Ubuntu makes it very easy for you to 

upgrade from one version of the distro to a newer version. You 

see, Ubuntu works on a six-month lifecycle: every six months, 

a new version is released, and that new version updates all the 

software to the very latest version. Although these kinds of 

software updates always bring lots of great new features and 

often also some new programs to try, it’s important that you 

remember that this magazine was written to accompany the 

exact Ubuntu version provided on the included disc. If you 

upgrade to a newer version of Ubuntu, some things may have 

changed, so you’re on your own!  LXF

 Whenever there 

are security fixes 

or other patches 

available for your 

software, Ubuntu 

will let you know. 

Click the orange 

icon to start the 

update process.

Synaptic’s menu options
Rather than just a simple “install or don’t install”, Synaptic 

gives you more control over what it does with packages. 

When you click a check box next to a package, you can 

choose from the following options:

   Unmark

If this file was selected for change, deselect it.

  Mark for Installation

Add this package to the list to be installed.

  Mark for Reinstallation

Take a fresh copy of this application and its 

configuration files, and use them to overwrite the 

existing data – great if you break a program.

  Mark for Upgrade

Download and install the latest version of this package.

   Mark for Removal

Removes the programs that come with this package.

  Mark for Complete Removal

Removes the programs that come with this package, 

along with any associated configuration files.

 Confused by all the options in Synaptic? The Preferences window 

lets you customise the colours for easier reading.

LXFS13.software   103 15/4/08   15:56:04



104     Linux starter pack

20 top apps

D
espite this book being full to the brim with open 

source software, there are still plenty of 

applications we haven’t mentioned. This is our 

opportunity to cover just a few we think are the 

most useful. But this doesn’t mean we’ve exhausted all the 

tools we’re interested in either. One of the best things 

about Linux is choice, and there is just so much software to 

choose from. If you take a look at the Synaptic package 

manager, the tool used for installing extra stuff, you’ll find it 

The best of open 
source software
This book is full of exceptional open source software, but that’s just the tip of a 
large iceberg. Here are some highlights awaiting the open source adventurer. 

contains thousands of tools, utilities, applications and 

games. You could spend weeks trawling through them all. 

But there are many more projects than those with official 

recognition from Ubuntu. If you look at a site such as 

Sourceforge.net, a hub for open source projects, you’ll find 

over 173,000 registered projects, most of which will work 

with Linux. There’s no quality control, but it just goes to 

show how active the open source community is and why 

Linux is a portal to a whole new way of thinking. 

Kino
The tool to use when you want to edit your 
own movies for YouTube and even DVD.

T
hanks to digital cameras usually having the ability to 

record movies as well as take photos, video editing is a 

prerequisite for a desktop computer. Both Apple’s OS X 

and Microsoft’s Windows bundle video editing applications, 

and this has helped make video editing technology 

mainstream. Websites like YouTube and MySpace wouldn’t be 

half as popular if you couldn’t watch something. Kino is the 

Linux equivalent to the video editing applications you find 

bundled with other operating systems. It attempts to be easy 

enough for the beginner to use while still being powerful 

enough to create professional results. 

After installation, 

Kino can be found 

lurking in the Sound & 

Video menu. The first 

thing you need to do is 

get video into the 

application. Kino’s 

native format is DV – 

the raw stream of video 

that many digital video 

recorders generate. You 

can import your video 

directly from your 

FireWire device by 

switching to the 

‘Capture’ page and 

pressing record. Most 

devices will work. If you’d rather import your movies by hand, 

you can add video content from the File > Open requester, 

after which all imported video will appear in the timeline 

window. This is where you can re-order each sequence, placing 

clips into the correct order. If you need to edit larger segments, 

then the ‘Trim’ window can be used to create cut points, 

putting new clips back into the timeline. You can also add 

effects in the FX window, examples include blurring video or 

forcing a sepia colour on everything. The FX window is also 

where you find transitions that can be used to fade from one 

clip to another. Just select the transition from the drop-down 

menu, followed by the start and end point in your movie for the 

transition and click ‘Render’. When you finish editing your 

masterpiece, the Export window can send your movie to your 

digital video recorder, a raw DV file or an MPEG that can be 

burned on to a DVD.

 After you’ve 

imported your 

videos, the timeline 

is the place where 

you can edit their 

order.

Importing videos
One of the main problems you’re likely to encounter while 

dealing with audio and video files within Linux is compatibility. 

You may find that files you pull on to your machine from other 

systems don’t work. Windows Media is the main culprit, but 

Apple’s QuickTime can also cause problems, as can any of the 

plethora of formats commonly used online. Even MP3 playback 

can cause problems. This is because all these formats are 

proprietary, and decoding them so that they work on Linux is a 

legal grey area in some parts of the world. You can avoid these 

problems by using open formats such as Ogg Vorbis for audio 

and Ogg Theora for video, but sooner or later you’ll need to work 

with a proprietary format. For video, the answer is to install a 

package called FFMPEG from the Synaptic package manager. 

Applications such as Kino will then be able to convert most of 

your files to an open format when you open them. This is the 

next best thing to a native solution.
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Audacity
Professional-grade audio editing on your Linux desktop.

Y
ou may have come across Audacity before. It’s an 

audio file editor that’s as adept at trimming your latest 

podcast as it is adding fade-outs to an MP3. Like its 

proprietary counterparts, it can be used to add real-time 

effects, mix audio, record from your soundcard’s inputs and 

analyse audio. It’s a tool box for audio editing, and it should be 

the first app you try if you need to do anything with sound files. 

Audacity is launched from the Applications > Sound & 

Video menu. By default, Audacity will configure itself to use 

your sound card for input and output. This means you can 

make a recording by pressing the large red record button, and 

Audacity will record whatever is connected to your sound card. 

If you need to change the input, switching from line-in to a 

microphone for instance, this can be changed from the Edit > 

Preferences > Audio I/O window. If there is sound entering 

Audacity, the level meters above the small microphone icon 

will start to bounce, and it’s this sound that will be recorded.  

Audacity can load WAV, AIFF, MPEG, Ogg Vorbis and Flac file 

formats from the File > Open requester, and you can load 

more than one at the same time by using the Ctrl key to select 

those you want to load. Each file will load into a separate 

instance of the editor. 

Close to the edit
The main area of the Audacity editor displays an amplitude 

waveform for the current section of audio. This is exactly the 

same as many other audio editors. The peaks and troughs in 

the image represent high and low amplitude in the audio, with 

the two tracks representing the left and right channel of a 

stereo recording. If your audio is mono, you’ll only see a single 

track. Press the green Play button in the toolbar to hear the 

sound your audio makes. The level meters above the tiny 

speaker icon in the toolbar will start to bounce, and a cursor 

will scroll across the waveform view to show you which part of 

the image is creating the sound you can hear. You can zoom 

into and out of the waveform using the magnifying glass in the 

toolbar, and when you want to stop playback, either hit the 

space bar or press the stop button. To do any editing, you first 

need to select a region of the file to edit. Just left click and drag 

your mouse across the area you want to edit. If you want to 

trim the beginning of an audio file, for example, left click and 

drag the mouse across the area you want to trim and select 

‘Cut’ from the edit menu. You can add effects to any selected 

region from the Effects menu. If you want to mix two files 

together, add a stereo track from the Tracks > Add New menu 

and use Import from the File menu to add a new audio file to 

those tracks. Pressing Play now will mix all the tracks together, 

and you can save a copy of the mix from the File > Export 

menu. Finally, if you want to change the volume of your audio 

file over time, use the Envelope Tool from the toolbar. This lets 

you draw a curve across the waveform that will be used to 

either amplify or decrease the volume of the audio at that 

point. When you’ve finished editing, save your audio file into 

your favourite format. 

 Audacity can run on Windows and OS X, and is the best free 

tool you can find for audio editing.

Step by step: Make music louder

Select waveform Load the audio fi le you 

want to boost, and select the entire fi le 

either by double-clicking on the waveform or 

pressing Ctrl+A on your keyboard.

1
Squeeze the sounds The effect used to 

boost audio is called compression. Select 

this from the Effect menu, move the threshold to 

-20dB and click on OK.

2
Save output Compression differs from 

normalisation because it only boosts the 

quiet parts of the signal. When you’re happy with 

the results, save the louder fi le.

3

You can install 

hundreds of other 

effects by searching 

for ‘LADSPA plugin’ 

in the Synaptic 

package manager. 

These are compatible 

with all Linux audio 

applications and cover 

everything from chorus 

effects to reverb.

Quick tip
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Blender
3D modelling and rendering environments normally cost a fortune – 
Blender is free and can compete on quality and specification.

T
he story behind Blender’s open source renaissance is a 

good one. It started life as a proprietary piece of 

software designed to compete with the likes of 

SoftImage, LightWave and 3D Studio. The company that 

developed Blender went bankrupt in 2002, but the creditors 

agreed to release the source code in return for ¤100,000. In 

mid-July of that year a campaign was started, asking people to 

donate funds to free Blender. Two months later Blender was 

saved, and the source code was released under the terms of 

the GPL – free for all to use and modify. Since then, Blender 

has gone from strength to strength. Thanks to its open licence, 

many people now contribute to its development, and the 

massive community flocks to blender.org with each new 

release. Blender has many advanced functions for the CGI 

artist, including Nurbs, Bezier curves, metaballs, particles and 

digital sculpting. The ray tracing element responsible for 

generating the final image can be replaced, and many people 

use the photo-realistic Yafray as a substitute. The images that 

can be produced are breathtaking.

My first render
But there is a cost, and that’s complexity. Blender has one of 

the most convoluted and complex user interfaces we’ve ever 

come across. This is a real shame, because you don’t 

necessarily need to be a CGI expert to get usable results. It just 

takes a little effort to learn the basics. When you first launch 

Blender from the Applications > Graphics menu, the window 

that appears is confusing. The main view is split into two, with 

the top area showing a top-down view of the scene, and the 

lower area dedicated to buttons and panels. 

Things become clearer if you select ‘Camera’ from the View 

menu. This will switch the main display to the view from the 

in-scene camera, and by default it’s looking at a cuboid in the 

centre of the scene. Press F12 and the scene is rendered. A 

window will appear with a properly lit rendition of the scene. 

Close the render and return to the main window. Make sure 

the cube is selected by looking for the pink coloured frame. If it 

isn’t, make sure Object Mode is selected on the toolbar in the 

middle of the screen, and right click on the cube. If you look 

closely at the cube in the middle of the window, you should be 

able to see three coloured arrows pointing in different 

directions. These arrows point in one of the three planes – 

green for the Y axis, blue for the Z axis and red for the X axis. 

You can move the cube in any of these axes by left-clicking the 

corresponding arrow and dragging your mouse. You can also 

move the cube freely in the visible axes with a right-click and a 

drag of the mouse. Press S to scale the cube; press R to rotate 

it. The axis of rotation is dependent on the current view. If you 

switch to the side view (press 3 on the number pad), for 

example, you can rotate the cube around the X axis. Switch to 

the top view (7 on the number pad) and you can rotate it 

around the Z axis. 

Textures
If you don’t like the grey colour our cube currently has, switch 

to the material view with the F5 key. Find three colour sliders in 

the middle panel, and you should be able to dial a more 

appropriate colour from here. Using textures, you can change 

how the surface of objects. With the cube selected, press F6 to 

open the Textures panel. Under the drop down menu labelled 

‘Texture Type’, select Stucci. The texture preview will fill with a 

texture that looks a little like the surface of the moon through a 

telescope. You can change the colour of the texture by 

switching to the ‘Colors’ tab and pressing on the Colorband 

button. Press F12 again and you’ll see this texture mapped 

onto the surface of the cube. There are hundreds of texture 

combinations, and you can layer one on top of another. If 

you’re after something realistic, try the Image texture type and 

use your own photos. You can also find texture libraries online 

so that you don’t need to recreate everything by hand. If all 

this seems a little overwhelming, don’t worry – if you’re able to 

persevere, the end results can be stunning.

 This frame is taken from an animated short film called 

‘Elephants Dream’, a movie created almost entirely using 

Blender and other open source software.

 The Blender user interface is bewildering, for beginners and 

experts alike, so don’t let that put you off using it.
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Ardour
Turn your Linux box into a multi-track recording studio.

A
rdour is a multi-track recording application that’s more 

than up to the task of recording live performances. 

Development of Ardour is part sponsored by the SAE 

Institute, one of the largest educators of audio engineers in the 

world. As a result, Ardour can be considered a professional-

grade solution, and is capable of recording and mixing large 

projects, as well satisfying modest home studio requirements. 

If you want to see what it’s capable of, why not invite your old 

bandmates over and give it a go?

If you’ve ever used an application such as Cubase or Logic, 

Ardour’s main window should look familiar. Audio tracks can 

be added to the empty section with the audio for each track 

stretching as blocks to the right. By default, there’s only one 

track, which is labelled ‘master’. This track represents the 

output on your sound card. To add further tracks, right-click on 

the light grey border to the left and below the master track, 

and select Stereo or Mono as a channel configuration. If you 

have a sound card with more than one input, you can change 

the input used for each track from the mixer window. From the 

Windows menu, select Show Mixer. This window mimics the 

functionality of a hardware mixing console typically found in 

recording studios. From the mixer view, you can change the 

volume of each track, as well as add effects and route the 

audio from one track to another. To change the input source 

for each of your new tracks, click on the small ‘input’ button 

underneath the track name. The popup menu will let you 

choose your sound card’s other inputs.

Go back to the main Ardour window. To record the sound 

coming into your sound card, record-enable each track you 

want to use by clicking on the red circle in each track before 

pressing the large red button at the top of the window. If you 

need a click track, press the Click button and adjust the tempo 

of the project by double-clicking on the Tempo strip. As you 

record, Ardour will generate blocks of waveform data that 

correspond to each track. If you’d rather use pre-recorded 

music than record your own, you can import music by right-

clicking in the track and selecting ‘Insert Existing Audio’. 

Choose the audio file you want from the file requester and 

Ardour will automatically add it to your project and insert it 

into the current position in the selected track.

If you want to add effects to your audio, make sure you’ve 

installed the LADSPA plugin packages from Synaptic then 

right-click on the black space above the channel in the mixer 

view. Select New Plugin from the pop-up menu, and you’ll be 

presented with the list of plugins. From here you can add any 

plugin with one click, and you’ll be returned to the mixer view. 

Double-click on the plugin to open the editing window, and 

click on ‘Bypass’ to enable it. You can change effect 

parameters as the audio plays, but you might want to click on 

S in the track view, as this solos the track, muting the others. 

When you’re happy with your mix, the final step is the 

mixdown. This is selected from the File > Export menu, and it 

will generate a final audio file that includes all the effects as 

well as your mix settings. Share this file to become famous. 

 Ardour is capable 

of recording and 

mixing dozens of 

tracks at once, 

which is a far cry 

from the simple 

days of four-track 

recording.

Step by step: Track automation

A is for auto Automation is the ability to 

record mixer slider movements, as well as 

other parameters, directly into your project. 

Automation options appear when you click on a 

track’s A button.

1
Drag the fader Select Fader from the 

automation menu. A track will appear for 

the fader data. Select Write from the top-right 

button, and any fader moves you make in the mixer 

will be recorded.

2
Draw a curve You can automate almost 

everything. Try adding an effects plugin to 

the track and select a parameter from the 

automation pop-up menu. Use manual mode 

to draw automation by hand.

3
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Stellarium
Thanks to Linux, you can gaze at the stars even without windows.

S
tellarium is a desktop planetarium. It’s the virtual 

equivalent of one of those domed theatres where the 

stars and constellations are projected on to the internal 

surface of the dome. Like the theatre, Stellarium is a projection 

of the night sky, but instead of using a dome it uses your 

screen. When you start Stellarium from the Applications > 

Education menu, the first thing you have to do is set your 

current location. After the application has loaded, and you’ve 

been suitably impressed by the super-realistic view, click on 

the small spanner icon in the bottom-left toolbar. This is the 

configuration panel, and you need to click on the Location tab. 

The window will now show a map of the world so you can 

locate your nearest city. This window hides one of Stellarium’s 

best features. Hold down the left mouse button and drag the 

cursor across the map. The Stellarium display in the 

background will update immediately with the local view. It’s 

fascinating to watch the sunlight and stars shift location as 

your mouse shuttles across the surface of the globe. It’s worth 

putting in your coordinates as any error in your location will be 

translated to time differences in the main view.

It’s full of stars
Close the configuration window to return to the main view. 

Depending in the time of day, you’ll either see a beautifully lit 

field with very few stars, or the night sky with strange 

silhouettes on the horizon. Stellarium uses a real image to 

draw the ground, as well as atmospheric effects that 

approximate overhead visibility. You can turn both of these 

features off from the bottom-left toolbar by clicking on the 

icon of the sky (labelled ‘atmosphere’), and a similar icon with 

an additional tree (labelled ‘ground’). Similarly, you can enable 

and disable other features from the same toolbar, including 

constellation lines and images, as well as labels for most 

objects in the night sky. The small toolbar in the bottom-right 

of the window accelerates time. This makes it easy to see the 

passage of time on the night sky, as well as switch from day to 

night without difficulty. 

Apart from displaying the view from your garden, Stellarium 

can also display many of the objects you’d typically find in a 

telescope. To find Saturn, for example, click on the magnifying 

glass in the toolbar. In the window that appears, type ‘saturn’. 

The display will then rotate and zoom into the yellow giant. The 

location of Saturn’s rings and moons are correct, and you can 

zoom in and out with the middle mouse button. You can also 

see the current phase of the moon in the same way, as well as 

all the other planets in the night sky with images for them all. 

Stellarium features accurate images of many nebulae, most of 

them freely provided by the Faulkes telescopes in Hawaii and 

Australia. Try a search for the Pleiades or M110 to see some 

great examples. Not only is Stellarium a great tool for 

discovering the night sky from your desktop, it’s also the 

perfect tool for planning a night’s viewing – just remember a 

blanket, in case it’s chilly out. 
 Stellarium is the best way of learning what all the 

constellations are without getting either frostbite or insomnia.

Solar Eclipse: Cornwall 11/08/99

Set the date To show off a little of 

Stellarium’s power, set your location to 

Plymouth on 11 September 1999 at 9:00 am, and 

switch back to the main view.

1
Zoom in Centre in on the moon using the 

search function. Click on the moon and 

press space to keep it centred, and zoom just 

enough to see both celestial bodies at once.

2
Forget the clouds Gradually move the time 

forward and watch the last total eclipse in 

the UK unfold before your eyes. Only this time, the 

weather doesn’t get in the way.

3

If you don’t know your 

longitude and latitude, 

many websites now 

offer a Google Maps 

modification that give 

you the details you 

need when you simply 

click on a map.

Quick tip
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Miro
If you have broadband, Miro lets you choose from hundreds of free 
online TV channels and download and store your videos in one place.

I
n a world where online entertainment is increasingly 

commercialised and locked down, Miro is a breath of fresh 

air. It’s an open source media player. But what makes Miro 

so different from most other media players is that it’s 

hardwired to the internet. In technical terms, Miro uses the 

same RSS feeds you use to keep up to date with the news, but 

instead of news, Miro subscribes to content tuned for video. If 

you’ve ever subscribed to a podcast in Apple’s iTunes software, 

you’ll already be familiar with the technology. Miro does the 

same for video. Miro needs to be installed through Synaptic, 

after which you can find tucked away in the Applications > 

Sound & Video menu. When first launched, Miro downloads 

the latest RSS feeds for all the channels its subscribed to by 

default. The front page that you see is the ‘Miro Guide’, an 

edited front-end to many of the new channels. It constantly 

updates with news from the Miro world – the internet TV 

equivalent to the electronic programme guide you find on 

many modern televisions. You can see each channel listed on 

the left panel sorted into categories. The blue number to the 

right of each channel is the number of new videos posted on 

that channel. Green numbers are the number of new and 

downloaded videos that area ready to watch.

BitTorrent
Clicking on one of the channels will open the list of videos 

currently available. Along with the title, there’s normally a brief 

synopsis on what the video is about. If you find one that 

interests you, click on the blue down arrow near the video 

thumbnail. This will add the video to the download queue. The 

clever thing about Miro is that it uses the BitTorrent protocol to 

download the files. This is a great way to share the burden of 

hosting and downloading files, and is partly the reason why 

Miro and its content is free. When you download a file, you’re 

actually downloading the data from other Miro users, grabbing 

pieces from people who already have the same file. The Miro 

client is also uploading chunks of the file to other users 

without the same bits as you. It’s a process known as peer-to-

peer downloading, because the other Miro users you’re 

connected to are your ‘peers’. You may have heard of 

BitTorrent in reference to illegal software, but this is purely 

because the same protocol is used by people who share files 

they don’t have permission to share. With Miro, all the content 

is perfectly legal, and BitTorrent is a legitimate and highly 

efficient method of getting the data to everyone.

Channel hopping
Depending on the speed of your internet connection, you may 

need to wait a short while for your selected videos to 

download. You can check on their progress from the 

‘Downloading’ channel on the left. When each download 

completes, it will be placed in the ‘New’ folder, and a green digit 

will show how many new videos there are to watch, as well as 

which channel the video originated from. Clicking on either of 

these green numbers will open the video list for that channel, 

and from there you can play your downloaded movie. 

The best part about Miro is that it can download videos 

according to your criteria, and do so automatically. If you find a 

channel or RSS feed you like, for instance, you can download 

all videos posted to that channel automatically. From the blue 

‘Auto Download’ bar at the top of the channel list, just select 

‘New – Get Only New Videos’, and Miro will do the downloading 

for you in the background. This is great if you want to leave 

Miro running overnight, because it means you’ll have 

everything ready to view when you log in to your machine in 

the morning. By default, videos will be removed automatically 

after ten days. If you want to keep a video, press on the ‘Keep’ 

button on the video strip after it has been downloaded. The 

video will then be appended to your Library, and you can also 

add any other video files you may have on your hard drive and 

use Miro as an all-encompassing media player.  LXF

 Miro is the gateway to a world of online entertainment. There’s 

even a programme guide with reviews of popular downloads.

 You can search and download movies from YouTube, as well as 

many other online video sites.
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Answers
Because of the community that’s grown up around Linux, there are loads of 
places to get help with any problems you might have – including right here…

Too much software?

Q
When I first installed Ubuntu, I spent a lot of time 

downloading different servers and software to try 

them out. Now I’m worried that I’ve got too much 

installed and that this may be slowing down my system. What 

should I do?

A
Don’t worry; on the whole even if you have installed a wide 

variety of software, your system should still be running well. 

The only risk that you might have is that having more 

software on your system invariably increases your software profile 

which might leave you open to attack from the outside through 

some unknown security vulnerability. For this reason it’s wise to 

make sure you switch off any services that aren’t in use. The best 

way of doing this with Ubuntu is to use Boot Up Manager 

(shortened to the 

slightly unfortunate 

Bum), a simple 

editor that allows 

you to enable and 

disable services. It’s 

pretty 

straightforward to use; there is a long list of services and their 

descriptions. Simply either tick or clear the box to the left of the 

service to enable or disable it, and click the Apply button to put 

your changes into effect. On the whole Ubuntu tends to have only 

the essential services enabled by default, so don’t be tempted to 

tinker too much or you may get some unexpected results!

X/K/Ubuntu

Q
I’ve read on the internet that there are some other 

Ubuntu variants, one called Kubuntu and another 

called Xubuntu. I’d like to try them out; do I need to 

re-install using a different disc?

A
Yes, there are other variants on Ubuntu available as 

standalone CDs, but you don’t necessarily need to 

download and burn these images to a CD in order to try 

them out. All you need to do is install the kubuntu-desktop or 

xubuntu-desktop packages within Synaptic; they act as meta-

packages, which basically mean that by selecting one of these 

packages, all the 

necessary 

packages that form 

part of either 

Kubuntu or 

Xubuntu are 

automatically 

installed as a result. You won’t lose any data as a result of doing 

this, and it gives you an easy way to try different window 

managers.

 The unfortunately 

named Bum 

allows you to 

configure which 

services should 

and shouldn’t be 

running.

“Ubuntu tends to have only the 
essential services enabled by default, 
so don’t tinker too much.”
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What desktop?

Q
I tried doing what you suggested (installing kubuntu-

desktop and xubuntu-desktop) and now I’m a bit 

confused! When I boot up, I see a Kubuntu logo until I 

get to the login screen where I see the Xubuntu login window, 

then when I login I then end up in Ubuntu. What gives? Does 

my computer have multiple personality disorder?

A
No – you’re quite safe. All that has happened is that the two 

desktop packages have installed differing loading and login 

screens. Let’s deal with the login screen first. In Ubuntu, go 

to System > Administration > Login Window. You may be 

prompted for your password, as you are going to be making 

system-wide changes. Once the Login Window Preferences dialog 

has opened up, simply click on the Local tab and select the 

Human theme from the list of theme options available to you. Click 

the Close button to return to your desktop. Now for the loading 

screen – this is a little more involved. At the command line, enter 

the command:

sudo update-alternatives --config usplash-artwork.so

You’ll then see a list of options. If you want to revert to the 

default Ubuntu artwork, enter the number 1 and press the Enter 

key. Ubuntu will then rewrite the configuration file accordingly. 

However, there’s one final step to take. and that is to rebuild the 

initial RAM disk, which may still reference the alternative artwork. 

We need to do this by using the command:

sudo update-initramfs -u

Depending on your own preference, you might choose to have 

several different themes, alternating between then every so often. 

All you have to do is repeat these two commands each time you 

want to switch.

Go home Gnome

Q
Now that I’ve got Kubuntu/Xubuntu installed, how can 

I access the different environments? Every time I log 

in, it takes me straight to the Gnome desktop. What 

am I doing wrong?

A
You’re not doing anything wrong – Ubuntu is defaulting to 

the Gnome desktop, because that’s its standard. In order to 

access either Kubuntu (KDE) or Xubuntu (Xfce) you need 

to explicitly choose them. There are two main ways of doing this 

within Ubuntu. The first, and by far the simplest, is to click the 

Options button in the bottom left-hand corner of the login screen 

and choose Select Session. You’ll see a window pop up where you 

can select which window manager you would like to run. To use 

KDE, make sure the radio button is selected and click on the 

Change Session button. When you log in, you’ll be asked whether 

you want to make your choice the new default, or to just use it for 

this session (as a one-off). If you want to experiment, we’d suggest 

choosing Just For This Session. Keep doing this until you’ve made 

your mind up about the alternative environment, at which point 

you can choose to make it the default.

The other way to change this is to use the Login Window 

Preferences that we referred to earlier; on the opening screen you 

can choose the default session that you want to use. When you’ve 

decided what you want to do, click on the Close button and your 

settings will be saved, so the next time you log in you’ll be taken to 

your new choice of desktop environment.

Sound of silence

Q
I don’t hear any sound when I log in to Ubuntu, or 

when I try to play a game or listen to music. What’s 

happened, and can it be fixed?

 Make the 

switch to an 

alternative desktop 

environment, with 

the Login Manager 

preferences tool.

 Select either kubuntu-desktop or xubuntu-desktop to sample 

the other variants of Ubuntu.
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A
Don’t panic; it’s highly unlikely that your sound card just flat 

out refuses to work with Ubuntu. It’s true that some sound 

cards aren’t 100% supported under Linux, but this tends to 

be certain specialist features such as 3D sound. However, the vast 

majority of sound cards will provide simple playback functionality. 

First things first: check your speaker connections, such as the 

output jack from your computer as well as any power connections 

to your speakers. Once you’re happy that everything is plugged in 

and the speakers appear to have power, right-click on the speaker 

icon in the top task panel and select Open Volume Control. Check 

the various sliders to ensure that they are not turned all the way 

down, and also check the small speaker icons below each set of 

sliders to see if there is a red cross through any of the output ones. 

If there is a red cross through either the Master or the PCM 

channels, it means that those channels are muted. Simply click on 

the red cross to clear it, and try playing your music again.

Games

Q
My Ubuntu installation seems to be just fine, except 

for when I try to play games like PlanetPenguin Racer 

or Oolite. Every time one of these games loads, the 

graphics become really slow and jerky, making the games 

unplayable. What’s even more frustrating is that I know I have a 

good graphics card, and it should be able to handle these 

games without breaking a sweat. What am I doing wrong?

A
The simple answer to this is to say that graphics card 

drivers tend to be proprietary, and aren’t included with 

Ubuntu by default. That’s not to say that you can’t install 

and use them, as Ubuntu provides the excellent Restricted Drivers 

Manager (found under System > Administration > Restricted 

Drivers Manager) to make installing proprietary drivers a breeze. 

You’ll be prompted for your password, so enter it to take you to the 

main window. Simply tick the ‘enable’ box next to the driver that 

you need and Ubuntu will ask for confirmation before installing 

and enabling the driver. In order to make full use of the new driver, 

it’s necessary to restart your computer, something that Ubuntu 

will ask you to do once it has successfully installed the driver.

Data transfer

Q
I’m considering moving full-time to Linux, but am a 

little worried about the masses of documents and 

photos that I have stored under Windows. Will I be able 

to access these in Ubuntu, or do I need to keep hold of 

Windows to make sure I can still work with all my data?

A
Well, first and foremost, there are several packages 

available for Ubuntu that will handle pretty much any type 

of graphic file, be it JPEG, TIFF or Windows Bitmap, plus a 

few you may not have heard of. Other productivity packages such 

as OpenOffice.org are very good at handling Word documents and 

Excel spreadsheets with little or no fuss. The best course of action 

 The Restricted Drivers Manager allows you access to the 

proprietary 3D graphics card drivers for your card.

 Audio troubles 

are nearly 

always resolved 

by checking 

connections and 

the volume control.
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is to copy a broad sample of your documents to your new Ubuntu 

computer and try opening them. If you’re happy that they’ll work, 

then you can make the switch. Alternatively, you might want to 

consider saving them in a different format; for instance, you can 

save Word documents in RTF (Rich Text Format) which will open 

natively within OpenOffice.org.

Zip it up

Q
I send and receive a lot of ZIP files as part of my job; 

will I be able to open these under Ubuntu and even 

create new archives?

A
The answer to this one is most definitely yes! By default, if 

you download a ZIP file and double-click on it, you will open 

up File Roller. a program that handles archiving as part of 

Ubuntu. Not only does it support ZIP formats, but also a number 

of Unix/Linux specific formats such as TAR and GZIP. You’ll need 

to add File Roller to the menu by right-clicking on the Applications 

menu and selecting Edit Menu. In the window that appears, select 

Accessories in the left-hand pane and tick the box next to Archive 

Manager in the right-hand pane. Finally, click Close, and File Roller 

will be added to Applications > Accessories. Open it up and click 

on the New button in the toolbar to create a new archive file. It 

looks for a file extension, so enter something like archive.zip for 

File Roller to use ZIP compression. Click the New button to return 

to the main File Roller window and click on the Add Files or Add 

Folder button to add individual files or all files under a folder to 

your archive.

The choice is yours

Q
I’d like to install some more software, but don’t know 

what is out there. What’s the best way for me to 

browse what’s on offer?

A
Ubuntu offers a graphical package management tool called 

Synaptic (found under System > Administration > Synaptic 

Package Manager), which allows you to browse through all 

the available packages for Ubuntu. Helpfully, it breaks down the 

packages into groups according to their function, allowing you to 

browse each group separately. By selecting a package, you’ll get a 

helpful summary of what the package is, and what additional 

software might be needed. You can also click on the Search button 

in Synaptic to enter specific keywords; these will be checked 

against all the package names and their descriptions, and any that 

match will be shown.

 Creating and working with archive files is easy with Ubuntu’s 

File Roller application.

 If you want 

to take a stroll 

through the 

packages that 

are available 

in Ubuntu, you 

can’t go wrong 

with Synaptic.
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Dual booting

Q
My system dual boots between Windows and Ubuntu. 

Under Ubuntu I can see my Windows hard drive and all 

the files on it, though when I boot into Windows I can’t 

see the same information for my Ubuntu hard drive. I’d like to 

be able to transfer files back and forth between the two 

systems, but it only seems possible to do this while using 

Ubuntu. What do you recommend I do?

A
The simple answer is to create a folder on your Windows 

partition that you can use as a ‘drop box’ to transfer files 

across. Another alternative is to use a USB key, which are 

becoming increasingly cheap and offer increasingly larger storage 

capacities! As a side note, it was only recently that Ubuntu 

included support for NTFS, the filesystem used by Windows XP 

and Windows Vista. You are able to read and write to NTFS 

volumes, but unfortunately Windows XP and Vista cannot access 

ext3 volumes, the file system used by Ubuntu

What’s compilation?

Q
Occasionally when I’m looking for Linux software on 

the internet, I come across instructions asking me to 

compile things. What does that mean, and do I really 

have to do it?

A
In short, compiling a program means taking the building 

blocks (the source code) and letting the computer build the 

program for you using some automated tools. However, for 

new users this isn’t really recommended, as it can cause problems 

if your new program depends on a newer version of some library 

file than the one you currently have. Instead, you may actually find 

a pre-compiled version of the program (commonly known as a 

binary package) within Synaptic; Ubuntu has access to over 

23,000 packages, so the chances are quite good that you’ll find 

what you’re looking for. In the event that you absolutely need to 

compile something from source, then here is what you’ll need to 

do. First of all you’ll need to install the build-essential package, 

which automatically installs a suite of tools that are used during 

the compilation process. Then you’ll need to decompress the 

source code, which has more than likely arrived in the shape of 

what’s known as a tarball, or a TAR archive. To do this, execute the 

following command:

tar zxvf nameoftarball.tar.gz

Next, cd into the directory:

cd nameoftarball

Now, read the README file, as this may contain important 

information that you may want to be aware of before you start 

the compilation process. You might also notice an INSTALL file 

present; if so, make sure to read this too. Forewarned is fore-

armed! To read either the README file or the INSTALL file, enter 

the command:

less README

or

less INSTALL

Once you’ve checked these files (if available) you’re ready to 

being the compilation process. This is a straightforward command 

like so:

sudo ./configure && sudo make && sudo make install

You need to use the sudo command. as Ubuntu requires 

administrative rights in order to complete the compilation. The && 

symbols link these commands together, so that as one finishes, 

the next one starts, ensuring that they are all done one after the other.

Copy and paste

Q
I’m used to copying and pasting in Windows by using 

the Ctrl+C and Ctrl+V keyboard shortcuts. Can I use 

these with Ubuntu?

 No longer a 

closed book; you 

can read and write 

to your Windows 

partition while you 

use Ubuntu.
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A
By and large the answer is yes – pretty much all the Gnome 

application support doing these key shortcuts. There are a 

small handful that don’t provide clipboard support in this 

way, but Ubuntu has quite a nifty feature to get around this. Simply 

select and highlight the text that you wish to copy. Then, go to the 

application or window where you wish to place the text and press 

the Left and Right mouse buttons simultaneously. This will 

transfer what you have selected. You might find that it’s actually a 

lot quicker for you to copy and paste using this method!

What root folder?

Q
I’m a bit confused by the naming conventions in 

Ubuntu. People keep referring to the root directory, 

but every time I try to access it I get an error telling 

me that I don’t have the correct permissions. What gives?

A
We can understand your confusion! In Ubuntu, there are 

actually two directories that are known as root. The first 

one, commonly shown as just /, is the root directory, which 

is the root of your filesystem (or rather the top-most directory of 

your filesystem). Under the root (/) directory are all the many 

directories and files that make up your system. Your confusion 

isn’t helped by the fact that there is a root sub-directory called 

(/root) under the root directory (/), which is actually the second 

of the two directories. This belongs to the root user, and contains 

their system files and preferences. This directory is only accessible 

while working as the root user or by using the sudo command.

Disappearing menus

Q
I don’t know what I’ve done, but my menus seem to 

have disappeared from my desktop and I can’t access 

any of my programs or even log out of my system. Help!

A
You may have deleted the top panel that contains the 

standard menus as well as some notification icons and the 

clock. This sounds much worse than it is, and it’s fairly easy 

to get them back. First of all, right-click on the bottom taskbar and 

select New Panel to create a blank panel across the top. Right-click 

on this new panel and select Add To Panel. A window will open up 

that will allow you to choose from a range of applets. Scroll down 

to the bottom and look for the Menu Bar entry, left-clicking and 

dragging it to the top-left corner of the top panel. Let go of the 

mouse button and you’ll breathe a sigh of relief as the 

Applications, Places and System menus reappear. Do the same for 

the Clock applet, but this time drag it to the top-right corner of the 

top panel. You’ll also want to include the Notification Area applet, 

so any new events will be displayed where you can see them, and 

you’ll probably also want the Volume Control applet. While you’re 

here, you can add application shortcuts to Firefox, Evolution and 

any other entries in the Applications menu by clicking the 

Application Launcher button and selecting from the list.

Perfect PDFs

Q
Under Windows I had Adobe Acrobat Reader to help 

me work with PDFs, but I can’t seem to find anything 

like it under Ubuntu. I really like Acrobat, and would 

prefer to use it over the software that’s 

supplied with Ubuntu because I’m more 

familiar with Acrobat.

A
The PDF viewing tool that comes 

with Ubuntu (Evince) is a little basic 

compared with Adobe Acrobat, 

so the simple solution is to just go to 

www.adobe.com and download Acrobat 

yourself! The default download for Linux is 

an RPM file, which is typically used by 

Fedora and OpenSUSE, but not much 

good for Ubuntu. To get a package that’s 

suitable for Ubuntu, just click on the 

Different Language Or Operating System 

link, select ‘Linux - x86 (.deb)’ from the 

Installer drop-down menu and click 

Continue. Acrobat will then start to 

download (choose to save it to your local 

disk in the pop-up window that appears) 

and after a few seconds you’ll have a 

package on your desktop. Simply double-

click on the package and Ubuntu will ask 

you whether you want to install the  Use the Add To Panel dialog to create shortcuts and add monitors to your panels.

 Acrobat Reader 

is only a few clicks 

away under Ubuntu.
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package. Click the Install Package button to start the installation 

process, at which point Ubuntu will ask you for your password. 

Enter this and after about 20 seconds or so, Acrobat Reader will 

be installed and available under Applications > Office.

Joystick jiggling

Q
I have a joystick that I’d like to use to play games 

with on Ubuntu. Is it safe to use, and will Ubuntu 

recognise it?

A
Yes, your joystick should be safe to use. Before the days of 

USB ports, joysticks used a 15-pin port that was commonly 

found on sound cards. However, with the advent of USB, 

these ports are no longer included on sound cards, and joysticks 

have moved to using a USB interface. That said, if your sound card 

has a 15-pin socket and your joystick can plug into it, it should 

work with Ubuntu. If your joystick does have a USB interface, 

simply plug it into a spare USB port and Ubuntu should recognise 

it. You’ll find that individual games will have specific options that 

relate to all the buttons on your joystick; check each game for 

more details.

Free updates

Q
I’ve had a message appear on my desktop telling me 

that there’s a new version of Ubuntu – something 

called 8.04LTS. What should I do?

A
This is Ubuntu’s way of telling you that development has 

finished on a new version of Ubuntu – in this case, version 

8.04LTS. The clever thing about Ubuntu is that it allows you 

a seamless upgrade path between different versions, meaning that 

you can upgrade easily to the very latest version of Ubuntu. In this 

case, the only thing that you need to bear in mind is that it will take 

a fair amount of time to download and install all the software 

necessary to upgrade your system to the very latest set of 

packages, so you should allow a few hours to do this depending on 

the speed of your internet connection. Ubuntu itself provides 18 

months support for each release, with the exception of the LTS 

(Long Term Support) releases. In these cases, Ubuntu provides 

support for a total of three years for the desktop version and five 

years for the server version. 

You should also be aware that Ubuntu only supports version by 

version upgrading, so if you want to upgrade to 8.04LTS, you must 

first be running the previous version (7.10). Skipping a release is 

not allowed, so you can’t go from 7.04 to 8.04LTS – you’d have to 

first upgrade to 7.10 before moving to 8.04LTS. 

Help! I need somebody

Q
I need more help! Where can I turn to help me with my 

problems?

A
Well it depends what kind of problem you have. If it’s a Linux-

based one, why not try our forums at www.linuxformat.

co.uk/forums – our readers are a helpful bunch and you’re 

likely to get an answer there. If not, then why not try the hugely 

popular Ubuntu Forums, found at http://ubuntuforums.org,  

where you’ll have access not only to the Ubuntu community at large, 

but also sometimes the actual developers who are involved in 

creating Ubuntu.

Code it!

Q
A few years ago I started to learn to program, but 

didn’t get very far and I’d like to give it another go. 

What programming tools are available for Ubuntu, and 

which languages can I learn?

A
I’ve got good news for you: Ubuntu offers you the 

opportunity to learn a wide variety of programming 

languages. The choice can be somewhat overwhelming as 

there are loads to choose from. For example, you could start off 

with some simple shell scripting, and then maybe move toward 

Perl, or you might prefer to go down the Object-Oriented route and 

learn Java or C++. Not only that, but if you need to learn .Net, 

Ubuntu allows you access to Mono, a free and open source 

implementation of the .Net technologies. Moving on to the web, 

you can program in PHP, JavaScript, or even learn simple HTML. 

The possibilities are endless. Keep an eye out for programming 

tutorials in regular issues of Linux Format to learn more.

 Crack Attack 

can become an 

addiction – you 

have been warned!

 Because it’s aimed at making Linux accessible, Ubuntu has 

some of the friendliest, most useful forums out there.
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Get gaming!

Q
I’m bored with playing Same Gnome, Mines and 

Chess. Are there any other decent games available 

for Ubuntu?

A
Yes! Ubuntu includes a handful of simple games with the 

default installation, but these are by no means the limit. 

Other games that you can access through Ubuntu include 

Battle for Wesnoth, a turn-based strategy game set in a fantasy 

world, SuperTuxKart, a game similar to Super Mario Kart, Vega 

Strike, a space trading game, and our personal favourite: Crack 

Attack. You can add these by going to Applications > Add Remove 

and choosing to see all available applications. Then click on the 

Games group on the left-hand side and you’ll see a big long list of 

games that you can choose from. Simply select one or more and 

click on the Apply Changes button to be prompted for your 

password prior to Ubuntu downloading and installing the games. 

Be aware that some games, such as Vega Strike and Open Arena 

have some very large downloads, so be patient while they’re 

downloading; Ubuntu will keep you up to date with how it’s doing 

and give you an ETA for finishing the download.

Photography 

Q
I’ve just bought a digital camera. Will Ubuntu allow 

me to me import my photographs and help me 

manage my photo collection?

A
It depends on whether your camera supports mass storage 

or not. Mass storage is when a computer treats a camera 

or USB key like just another disk, which is automatically 

mounted and made available for Ubuntu. If your camera does 

support this, then you can simply link it up using the USB interface 

that is commonly supplied with every camera. Ubuntu will 

automatically acknowledge the presence of a camera and attempt 

to import the pictures into GThumb, which is a picture-handling 

utility within Ubuntu. However, there is a better option called 

F-Spot (found under Applications > Graphics) that allows you to 

import pictures into a library ordered by time. You’ll need to 

disable GThumb’s automatic import though, by going to System > 

Preferences > Removable Drives And Media and unticking the 

option under the Cameras tab. F-Spot is pretty easy to use, and 

you’ll be able to perform some minor editing with it. You can even 

export your photographs to Picasa Web or Flickr.  LXF

Hang around any number of Linux geeks and it 

won’t be long before they descend into a weird 

world of uttering words without meaning. Things 

like cd or ls, or even the more exotic-sounding grep 

may mean nothing to you now, but take the time to 

learn about the terminal and you too can harness 

the power of the command line.

At its most basic, the command line is a way to 

enter one or more commands that will interact in a 

low level with the Linux operating system. You can 

access the terminal (or command line) by one of 

two ways; you can go to Applications > Accessories 

> Terminal to open up a terminal as part of your 

desktop, or you can press Ctrl+Alt plus any key 

from F1 to F6 to access one of six different terminal 

windows. If you do it the Ctrl+Alt way then you’ll 

need to login with your username and password, 

and if you need to return to your desktop just press 

Alt+F7. Don’t worry about logging in multiple times; 

Ubuntu allows this, and it can come in handy if you 

need to run a command in the background while 

you’re working on something else.

The first command you’ll learn is ls, which lists 

the contents of the current directory. If you want 

to see more information, you can use the command 

like so:

ls -al

which will give you a more detailed listing of all the 

files and directories, including the hidden ones, that 

are located in the current directory. But how do you 

know which directory you’re currently in? Look at 

the following example:

andrew@teletran:~/Documents$

The first part (before the @ sign) tells me that I 

am logged on as the user andrew. The name of the 

machine is teletran (the part after the @ sign) and I 

am currently working in the Documents directory 

which is a sub-directory of my home directory 

(denoted by the tilde (~) character). As you move 

through the file system using the terminal, the bit 

after the colon in the prompt will tell you exactly 

where you are.

Wading around
Moving to and fro within your filesystem is pretty 

easy to do and relies on the cd (change directory) 

command. Just typing it by itself and pressing the 

Enter key will automatically move you back to your 

home directory (~). The same effect can be had by 

entering the command:

cd ~

The cd command is relatively simple to use and 

relies on you entering the details of the directory 

that you want to move into. For example:

cd ~/Music

would move me into the Music directory under my 

home directory. If you wanted to move up a 

directory, then you could enter the command:

cd ..

and Ubuntu would understand this. A single period 

(.) stands for the current directory, while a double 

period (..) stands for the immediate parent 

directory. It’s not inconceivable that you might one 

day enter a command like this one:

cd ../../../..

that would move you up four levels in your 

directory hierarchy.

Putting it together
One of the strengths of the command line is the 

ability to string several commands together in order 

to accomplish multiple tasks. Here at LXF Towers, 

we like to use the command line as it can be 

quicker, and a good example of this is when we 

update our Ubuntu installation. To do this, we enter 

the command:

sudo apt-get update && sudo apt-get upgrade -y && 

sudo apt-get dist-upgrade -y

which will update the software repository 

information, install any upgrades and also install 

any more complicated upgrades. All we will have 

to do is enter our password in once, as we have 

chained the commands together using the two 

&& signs. 

An alternative to this, using the ls command, 

might look like this:

ls -al | less

Instead of simply running the commands in 

order, this actually sends the output of the ls -al 

command to the less command, allowing you to 

easily scroll up and down using the cursor keys to 

see your directory contents. When you’re finished, 

tap the Q key to return to the command line.

 F-Spot takes the pain out of organising your photos.

Using the terminal
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ACPI Advanced Configuration & 

Power Interface. Allows Linux to 

control power management on 

laptops and desktop machines. If 

ACPI is properly configured, Linux 

can power off your machine for you 

when shutting it down.

ALSA Advanced Linux Sound 

Architecture. This library provides 

support for a number of soundcards, 

enabling a Linux system to give 

multimedia feedback.

Amarok The preferred KDE media 

player. Amarok can locate and 

manage your songs, playlists, album 

art and song lyrics, and of course 

play music! Most distros also come 

with Juk, an alternative media player 

for KDE.

Apache The most popular web 

server on the internet, behind nearly 

70% of all web domains. The name 

comes from its original moniker, 

A Patchy Web Server, so named 

because it was built up from a 

number of modifications.

Appletalk A common file- and print-

sharing protocol used by older 

Macintosh computers. On Linux, you 

can allow Macs to connect to your 

machine with Appletalk support by 

using the Netatalk library.

APT Advanced Packaging Tool, a 

suite of utilities authored by the 

Debian team that handles package 

installation and maintenance.

Bash The Bourne-Again SHell is the 

predominant command-line 

interpreter for Linux. It is based on 

the original Bourne Shell, created by 

Stephen Bourne for AT&T, and 

includes job control, scripting and 

aliases.

Boot A general term for starting 

your computer. Rebooting means to 

restart, and the boot process is the 

initial set of procedures through 

which Linux starts.

BSD Berkeley Software Distribution, 

a variant of Unix (and close relation 

Get to grips with all the Linux lingo used by the open source community.

of Linux) that is both free software 

and freely licensed using the BSD 

licence. The BSD licence allows 

inclusion of code into proprietary 

software without the release of 

modifications.

Command line The most common 

name for the text-only teletype input 

system for Linux. The command-line 

interpreter of choice on Linux is 

traditionally Bash.

Compile The process of turning 

source code (human-readable 

programming language) into a binary 

executable (a program that can be 

run by Linux) is known as 

compilation.

Console Another term for the 

command line.

Debian Popular Linux distro with an 

emphasis on software freedom and 

stability, named after its founder, Ian 

Murdock, and his then-girlfriend 

Deborah. The Debian Project is 

known for its very long release cycles.

Display manager A session manager 

for X that handles user login and 

choosing your preferred desktop. 

The original desktop manager is xdm 

(the X Display Manager), but Gnome 

and KDE have produced gdm and  

kdm respectively.

Distro Short for distribution, which is 

a custom release of the Linux kernel 

plus a selection of packages and 

additional scripts and programs. 

Fedora, Mandriva Linux, Mepis, 

Debian and Ubuntu are all popular 

Linux distros. 

Ekiga Video conferencing tool for 

Gnome that uses the H.323 protocol 

and tunnelling to provide high-speed 

chats between attendees. Formerly 

known as GnomeMeeting.

Emacs At its core, this is merely a 

text editor (the name comes from 

Editing Macros), but Emacs has 

many extensions and add-ons that 

allow you to compile and debug code, 

read your email, play games and 

more. Several clones of Emacs exist, 

including the innovative XEmacs.

 

Evolution Gnome-based personal 

information manager that handles 

email, calendaring and contacts. For 

KDE, the equivalent is Kontact.

ext3 The standard Linux filesystem. 

Its journalling capability allows your 

system to recover safely from an 

unexpected shutdown or other 

mishap. You do not need to 

defragment ext3 disks.

Fedora Popular Linux distro 

sponsored and primarily developed 

Glossary

 Emacs: text editor, operating system or something much more powerful? 

It has legions of fans arguing that it’s a way of life – you decide!

by Red Hat. The Fedora Project aims 

to release a new ‘Core’ update twice a 

year, and the distro is well known for 

incorporating cutting-edge features 

ahead of the pack.

Firefox Successful open-source web 

browser produced as a spin-off from 

Mozilla. Firefox uses the same HTML 

rendering system as Mozilla (known 

as Gecko), but wraps it inside an 

intuitive and well-designed user 

interface. You can also try Konqueror, 

Mozilla or the proprietary, (but free to 

download) Opera.

FSF The Free Software Foundation 

was founded in 1985 as a non-profit 

organisation dedicated to promoting 

the freedom of software. The group 

is still the primary sponsor of the 

GNU Project.

FTP The File Transfer Protocol is a 

client–server architecture that 

enables users to upload and 

download files quickly and efficiently. 

FTP has long been preferred to HTTP 

for file distribution in this manner, as 

it allows easy authentication, quota 

management, and download 

resumption.

GConf The closest that Linux gets to 

an equivalent of the Windows 

registry. It is designed to store user 

preferences for the Gnome desktop 

and its applications, and you will find 

there are options that can be set in 

GConf that cannot be set in the 

applications!

Gentoo The most popular source-

based Linux distro. A source-based 

distro downloads all its packages as 

compressed source code, then 

extracts and compiles it according to 

your system preferences. Because of 

this, Gentoo is highly customisable. 

Gimp The GNU Image Manipulation 

Program is the most prevalent and 

powerful image editor on Linux. 

Although modelled loosely on the 

user interface of Adobe Photoshop, 

Gimp is harder to use, and lacks 

some more advanced features such 

as high-quality colour matching.
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Gnome The GNU Network Object 

Model Environment was created as 

an alternative graphical desktop to 

KDE, back when the Qt graphical 

library used by KDE wasn’t available 

under the GPL. Gnome’s primary 

focus is on usability, eschewing 

features that have long been 

incorporated into KDE.

GNU The GNU Project was founded 

in 1984 to develop a complete, free 

Unix-like operating system. Every 

Linux distro depends heavily on the 

work of the GNU project, for 

everything from basic command-line 

programs to the compilers and the 

Gnome desktop environment.

GnuCash Open-source accounting 

system for the Gnome desktop 

environment. It can import Quicken 

files, create balance-sheet reports, 

manage your income, and even print 

out cheques.

GPL GNU General Public License. 

This is the foundation of free 

software, allowing programmers to 

access, modify, redistribute and even 

sell source code with this licence 

under the condition that they grant 

others the same rights. Unlike the 

BSD licence, any program that uses 

GPL code must itself be licensed 

under the GPL (or compatible 

licence).

Grub GRand Unified Bootloader. 

Grub is similar to the Lilo bootloader, 

in that they both allow you to choose 

which operating system you would 

like to boot. However, Grub has many 

more features than Lilo, including 

the ability to edit the menu as the 

machine boots.

GTK The Gimp Toolkit. This is a set of 

GUI controls that enable developers 

to build advanced user interfaces 

quickly and easily. As you can guess 

by the full name, GTK made its debut 

as part of Gimp development, but it 

has since outgrown that program to 

be used as the general GUI toolkit for 

the Gnome environment.

GUI Graphical user interface, also 

known by the phrase Windows, Icons, 

Menus and Pointing devices (WIMP). 

A GUI represents your programs and 

documents using high-colour 

graphics and icons on-screen.

Home directory Each user on a Linux 

system has a home directory, usually 

contained in /home. For example, a 

user called Richard will have 

/home/richard, and user Ralph will 

have /home/ralph. Most 

distributions automatically create a 

home directory for each user, but 

some do not.

HTTP Hypertext Transfer Protocol is 

used as the primary method for 

requesting and sending web pages 

and their content. An HTTP client – 

usually a web browser – requests an 

item from a server using a Uniform 

Resource Locator (URL), and the 

server sends the content back.

IEEE 1394 The technical name for 

the FireWire technology for 

connecting devices together. 

Sometimes known as iLINK on many 

Sony devices. FireWire has roughly 

the same bandwidth as USB 2.0; 

however, it is faster for transferring 

large files.

IRC Internet Relay Chat is an 

interactive discussion protocol to 

handle groups of people chatting in 

virtual rooms (known as channels). 

IRC is often quite a seedy place to 

visit, and is a hive of illegal software, 

hacks and sci-fi fans.

Java Cross-platform language and 

graphical toolkit developed by 

Sun Microsystems to power ‘smart’ 

devices. Java powers over 650 million 

PCs and 750 million smartcards, as 

well as everything from cars to 

set-top boxes.

Kate The KDE Advanced Text Editor 

is the most feature-rich GUI text 

editor you’ll find on any platform. 

Although it only handles text, it can 

colour code what you type if you’re 

programming, run scripts, handle 

projects, and it even embeds a 

command line into the window.

K3b The standard CD and DVD 

writing tool for KDE. K3b is generally 

acknowledged to be the easiest way 

to write to optical media, and you can 

use it to take backups and write ISO 

files to disc.

KDE The K Desktop Environment 

was originally known as the Kool 

Desktop Environment. KDE uses the 

Qt toolkit for drawing its interfaces, 

and the two teams work very closely 

together. KDE is known for having a 

strong focus on features, although 

increasingly developers are choosing 

to focus on its usability.

KDE Wallet The KDE standard way 

for storing user passwords and 

personal information needed by 

KDE applications. 

Kernel The core of any operating 

system is known as the kernel, and 

it’s this part that handles running 

programs, allocating resources, 

monitoring devices and receiving 

user input. Technically speaking, 

Linux is only the kernel of the 

operating system: everything else is 

taken from other projects.

Kicker The long control bar that, by 

default, runs along the bottom of 

your KDE desktop. The Kicker is an 

incredibly powerful tool that can hold 

quick launch icons, program lists and 

RSS feeds. Right-click on the Kicker 

to start learning.

KOffice The KDE-based office suite 

that comprises a generous group of 

applications: KWord, the word 

processor; KSpread, the 

spreadsheet; KPresenter, the 

presentation program; Kivio, the 

technical drawing package; Karbon14, 

the vector art application; Krita, the 

pixel-based art tool (like Gimp); 

Kugar, the report generator; KPlato, 

the project manager; and Kexi, the 

database management system. 

KOffice applications are smaller, 

faster but less functional than their 

OpenOffice.org equivalents.

Konqueror The default web browser 

and file management system for 

KDE. Konqueror, like Windows 

Explorer, works as a browser, a file 

manager and a file preview tool that 

can view many file types. Konqueror 

uses the same rendering engine as 

Apple’s Safari.

Kontact Integrated personal 

information manager (similar to 

Outlook) for KDE. 

Also consider Evolution.

 KDE’s advanced text editor Kate has a plethora of options.

 Gimp is the only real choice for professional 

graphics development on Linux. 
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Kopete Instant messaging tool for 

KDE that works with MSN 

Messenger, Yahoo, AIM, ICQ and 

Yahoo networks.

LGPL The GNU Lesser General Public 

License. This is a variant of the GPL 

that allows programs using so-

licensed code to be distributed as 

part of proprietary software without 

the need to license that software 

specially.

Lilo The LInux LOader, a bootloader 

that enables you to select which 

operating system you want to start 

each time your computer is turned 

on. Many distros allow you to use 

Grub for this instead.

Login Linux requires that a user with 

a valid password validate themselves 

to the system before using it. This 

process – logging in – requires you to 

enter your username and password 

at a login prompt.

Mandriva Linux One of the most 

popular Linux distros around, with a 

strong emphasis on usability and 

new features. Mandriva is largely 

funded by the community, through 

subscriptions to its Mandriva Club 

programme.

MCC Mandriva Control Center, the 

heart of the system configuration 

system on Mandriva Linux. All 

options to install and uninstall 

software, set up your hardware and 

configure your network access are 

stored here.

Mount To mount a device is to 

prepare it for reading and writing. For 

example, you need to mount a CD 

before you can use it. Some distros 

use a technique known as 

supermounting to automatically 

mount devices such as CDs and USB 

sticks as they are inserted.

Mozilla Cross-platform, open-source 

web browser and email client based 

on the open source release of the 

Netscape Communicator suite. The 

Mozilla HTML rendering system, 

Gecko, has since been incorporated 

into Firefox, Epiphany, Galeon and 

several other web browsers.

Nautilus The Gnome equivalent of 

Konqueror, with more emphasis on 

managing files and less on web 

browsing. Nautilus uses spatial-mode 

navigation, which means that each 

folder has its own Nautilus window, 

and it will remember the position and 

size of that window.

NFS The Network Filesystem is a 

fairly primitive way for Unix machines 

to share drive space with other Unix 

machines. It is insecure, slow and 

inefficient, and so best avoided.

NTFS New Technology Filesystem, 

developed by Microsoft for Windows 

NT, then extended in Windows 2000 

and Windows XP. Linux has some 

support for NTFS, but it is limited 

because Microsoft has not revealed 

the exact data structures.

OpenOffice.org The most powerful 

office suite available on Linux 

consists of Writer, the word 

processor; Math, the mathematics 

package; Calc, the spreadsheet; 

Impress, the presentation tool; and 

Draw, the vector art tool.

Package A discrete application 

container that can be installed into a 

Linux distro. There are several types 

of package, but the most common 

are RPM (for Fedora, SUSE and 

Mandriva Linux) and APT (for Debian, 

Ubuntu and Knoppix).

Package manager Application that 

tracks which packages are installed, 

allows you to install or configure 

more packages, and also cleans up 

the system when a package is 

uninstalled.

Pan Advanced Usenet newsreader 

for Gnome, with features like article 

header cacheing, filtering, multiple 

connections and easy binary 

decoding.

Partition One slice of your hard disk 

that is functionally separate from the 

rest. A hard disk may contain just one 

partition (where everything is stored), 

but in Linux it is common to create 

multiple partitions – one for the OS, 

one for personal files, one for swap 

space, and so on. This allows you to 

reformat the OS partition, leaving 

your personal files intact.

Perl Practical Extraction and 

Reporting Language (or 

Pathologically Eclectic Rubbish Lister, 

depending on whom you talk to) is a 

difficult but rewarding scripting 

language for Linux and other 

platforms.

Permissions Access rights for files 

and devices on your system. Normal 

users have permissions to read 

programs, but not to write to them, 

whereas the root user is able to read 

and write over programs.

PHP Recursive acronym that stands 

for PHP Hypertext Preprocessor. 

PHP is a web scripting language with 

tight links to databases and powerful 

XML processing.

PowerPC CPU architecture used by 

IBM and Freescale as part of their 

primary desktop line of chips. IBM 

has extended PowerPC to servers 

and even supercomputers.

Prompt Another term for the 

command line. There are many of 

these terms!

Proxy server Proxy servers cache 

web server responses locally so that 

a given website loads faster the next 

time you – or someone else with 

access to the proxy – loads it. The 

most popular proxy server on Linux 

is Squid.

Python Flexible, object-oriented 

programming language for Linux that 

is often used to create agile scripts in 

the minimum of time.

Qt Graphical user interface toolkit 

produced by Norway-based Trolltech. 

Qt’s most popular use is behind the 

scenes of KDE, but it is also available 

on Mac OS X and Windows.

Red Hat Arguably the most 

successful Linux company in the 

world, Red Hat’s main product is Red 

Hat Enterprise Linux. Its consumer-

level product, Red Hat Linux, was 

spun off in 2003 with the launch of 

Fedora.

ReiserFS Advanced journalling 

filesystem created by Hans Reiser 

and others. Its development has 

been sponsored by SUSE, Linspire 

and also the American Defense 

Advanced Research Projects Agency 

(DARPA). It is commonly thought to 

be the fastest Linux filesystem 

available.

Root The administrator user in Linux. 

The root user (often called the 

superuser) has full access to the 

system, and can even destroy all data 

on the hard drive with a single 

command. It is not recommended 

that you log in or run as root beyond 

what you need to do.

Root directory The top level in your 

Linux filesystem is called the root 

directory, or /. It is from this root 

directory that other subdirectories 

such as /etc and /home are 

mounted.

RPM The Red Hat Package Manager 

was one of the earliest attempts to 

ease the burden of installing, 

maintaining, and uninstalling 

packages. Created by Red Hat, RPM 

 Konqueror uses the same HTML rendering engine as Mac OS X’s Safari.

 GNU is a recursive acronym 

for GNU’s Not Unix, and is 

pronounced “Guh-noo”.
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is now the core of both SUSE and 

Mandriva Linux, as well as many 

other distros. The leading alternative 

to RPM is Debian’s APT.

Runlevel Linux has different modes, 

or levels, of operation, which are 

defined by runlevels. Runlevel 0, for 

example, is a halted system, runlevel 

1 is single-user mode, runlevel 3 is 

multi-user mode, runlevel 5 is 

multi-user with graphical interface, 

and so on. Each runlevel defines a list 

of services and programs that should 

be run as part of the runlevel.

Samba A free software suite in 

development since 1992 that 

provides access to Microsoft file- and 

print-sharing using the SMB/CIFS 

protocol.

SaX2 The SUSE X Windows 

configuration application.

Scribus Desktop publishing (DTP) 

application with support for PDF 

export, Python scripting, separation 

previews, and right-to-left typography 

for languages like Hebrew and Arabic.

Session Each user accessing a 

graphical desktop on your Linux box 

has a session, which stores 

information about the user and what 

they are doing. You can log out of 

your desktop, terminating your 

session, or you can switch off the 

computer, terminating everyone’s 

sessions.

Shade The default action in many 

distros for when you double-click the 

title bar of a window is to ‘shade’ the 

window. This hides the contents of 

the window, showing only its title bar. 

To unshade a window, just double-

click on the bar again.

Shell Another term for the 

command line.

SSH Secure SHell. This allows you to 

log in to a remote Unix server and 

gain full command-line access to 

your account. It also adds very strong 

encryption and compression so that 

no one can spy on your movements.

Superuser The root user account in 

Unix, sometimes called the 

administrator account.

Tab completion The name for the 

filename completion offered on the 

command line when you press the 

Tab key. Press Tab twice to see a list 

of all matches.

Tarball Common name for a gzip-

compressed tar file. Tarballs usually 

end with the file extension .tar.gz, but 

you may also come across .tgz.

Telnet An early internet protocol for 

logging in to remote Unix machines. 

Largely superseded by SSH. 

Terminal Another term for the 

command line. This is the last one, 

we promise!

Ubuntu Relatively new Debian-based 

distro that has become exceedingly 

popular due to its focus on freedom 

and vibrant user community. 

Founded and sponsored by South 

African millionaire Mark 

Shuttleworth.

Unmount The process of removing a 

device or media from your computer. 

Distros with supermount will 

unmount devices for you as you 

remove them.

URPMI User Red Hat Package 

Manager Install, the standard 

Mandriva Linux tool for installing 

RPM files on to your system. URPMI 

also intelligently handles RPM 

dependencies and uninstallation.

User An account on your Linux 

box. Each user has a username and 

a password.

VESA Video Electronics Standards 

Association; also the X graphics 

driver that works as the lowest 

common denominator no matter 

what graphics card you have in your 

machine. On the downside, the VESA 

driver is very slow, and not capable of 

3D acceleration.

Vim The Vi Improved text editor is 

the most widespread Linux text 

editor and, despite being quite unlike 

most other text editors in the world, 

is quite easy to learn. Some systems 

use the command vi to launch Vim.

Virtual desktop Linux allows you to 

have multiple logical views of your 

graphical desktop, known as virtual 

desktops. Each desktop can have its 

own windows, icons and wallpaper to 

distinguish it, and you can move 

windows between desktops by 

right-clicking on their title bar.

VNC Virtual Network Computing is a 

simple remote control system for 

GUIs. In some distros it has been 

superseded by NX, but you will 

usually be able to install it.

Widget A graphical user interface 

item, such as a button, a text entry 

box or a scrollbar.

Window decorations The graphical 

elements that surround the title bar 

of a window. Window decorations can 

be customised to look like the 

Minimize, Maximize and Close 

buttons unique to Windows.

Window manager Lightweight 

graphical component that controls 

the look and behaviour of windows, 

and manages user input to those 

windows.

Wine Recursive acronym for Wine Is 

Not an Emulator. Wine is a port of 

various Windows libraries to Linux so 

that native Windows applications can 

run on Linux without modification. 

There are two forks of Wine, known 

as WineX (for DirectX-based games) 

and CrossOver Office (for Microsoft 

Office and Photoshop).

x86, x86-64 x86 is the standard PC 

architecture made popular by Intel. 

From the 386 onwards, x86 chips 

have been capable of 32-bit 

processing, but newer chips use the 

x86-64 architecture invented by AMD 

to provide 64-bit computing with 

backwards compatibility.

X11 The standard graphical desktop 

system for Linux and many other 

operating systems. X11’s enduring 

popularity is largely down to its 

flexibility: it does not dictate how 

windows should look (that’s left to 

the window manager) or how 

applications should look (that’s left to 

the GUI toolkit).

X.org The standard Linux 

implementation of the X11 X Window 

System. Some older distros use 

XFree86, an earlier and less-popular 

implementation of X.

Yast Yet Another Setup Tool is the 

standard installation and 

configuration system for SUSE. It is 

largely equivalent to Mandriva Linux’s 

Control Center.

Yum Yellow dog Updater, Modified is 

a recent addition to the world of 

package managers, and works as a 

cross between APT and URPMI. At 

the time of writing, Yum is only 

available through Fedora and Yellow 

Dog Linux.

Zip Standard method for 

compressing files into a single 

archive, made popular via Phil Katz’s 

PKZip suite.  Type commands directly to the computer by using the command line.

 SUSE is just one of many popular 

Linux distributions, each with its 

own mission to achieve.
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Switching to another operating system is no easy task, but before you shout 
“Heeeeeeeeeeelp!”, read this…

F
or most people, the hardest part of 

installing Linux is stepping out of their 

comfort zone and trying new things. If it 

were just a matter of learning a new office suite 

the problem would be small enough to cope 

with, but Linux gives you a new web browser, a 

new desktop environment, a new filesystem 

and a new configuration panel – in short, it’s 

faster to count the things that have stayed the 

same than the things that have changed. It’s 

because of all these changes that lots of people 

install Linux with the best intentions only to find 

themselves frustrated and upset two weeks 

later, ready to reformat their hard disks, install 

Windows and pretend it was all just a bad 

dream.

We don’t want that to happen, naturally. 

Linux is as easy as Windows once you get over 

the initial differences, and as long as you know 

where to find help we think you’ll be a pro in no 

time. Because Linux is a much larger and more 

complex system than Windows, if you want to 

learn all of it the key to understanding lies not in 

knowing it all yourself but knowing where to 

look.

If you have a question, work your way 

through this list of possible resources, trying 

each one until you get the answer you need. 

Good luck!

Help, I need somebody!
Linux is packed with documentation of all types; 

you just have to know where to look for it. Help 

files can be broadly split into two types – 

command line and GUI – but there is some 

crossover between them. The most basic help 

system is the manual page (usually called man 

page), which is a plain text system designed for 

command-line use. To try this out, open up a 

terminal window and type man ls to bring up 

the manual page for the ls command. You might 

think that ls is quite a simple command, but as 

you will see from the manual page it includes 

many options that enable you to format and 

filter the output.

You can also view manual pages using 

Konqueror, the KDE web browser, by typing 

man:/ in the location bar followed by the 

manual page you’re interested in. For example, 

loading man:/ls would bring up the same ls 

manual page as before, but this time it would be 

formatted nicely for viewing in a graphical 

environment.

A step up from man pages are info pages, 

which are man pages with hyperlinks inside. 

This is useful for complex topics, such as how to 

use Bash. Accessing an info page is much the 

command by using | less, eg ls --help | less or 

cd --help | less. The pipe key, |, is usually 

Shift+\, but this depends on what type of 

keybiard you’re using.

For graphical user interface programs, which 

account for the majority of programs on Linux, 

there is usually a Help menu where you can get 

started. More often than not, pressing F1 on 

your keyboard will bring up the program help. If 

not, or if there is no Help menu for some reason, 

you can try looking in the KDE Help Centre. This 

is usually on the K menu somewhere 

(Documentation or More Applications > More 

Applications) are the most common places to 

find it), or you can run it. manually by entering 

the command khelpcenter. This contains links 

to all the help files inside KDE, along with 

shortcuts to the Unix man and info pages.

Reading treeware
Although there are thousands of 

documentation writers out there, help files 

generally serve as reference guides for a given 

program – they aren’t very easy to use if you 

want to learn something from scratch. If this is 

your goal, your best bet is to either read 

same as accessing a man page: just type info 

yourtopic at the command line and you will 

load up the index page. If your documentation 

has more than one page, use the cursor keys to 

highlight a link to jump to, and press Enter to 

browse to it. You can also use the N key to flip to 

the next page, the P key to flip back to the 

previous page and U to go up a level. 

As with man pages, you can view info pages 

inside Konqueror by using the protocol info:/. 

For example, info:/bash would load the Bash 

info page nicely formatted inside Konqueror. 

This has the added benefit that you can just 

click links to read topics rather than having to 

memorise a load of tricky keypresses.

If there’s a particular command you’re 

interested in, chances are it will have a special 

--help switch that prints out usage information. 

This is nearly always just a list of all the 

parameters you can use with a command, but 

because certain commands accept many 

parameters the output from this can be quite 

long. For example, ls --help lists all the ways you 

can use the ls command, which happens to be 

about three screens of information. To solve this 

problem, pipe the output through the less 

 The Firefox help system is hugely comprehensive and contains hints and tips about every aspect of 

the program. If you don’t find what you’re looking for here, search the web.

Help and resources
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If you buy your copy of Linux you may be 

entitled to technical support from the distro 

maker. Most versions of Linux are free (or cost 

only a little, to pay for media and shipping), and 

therefore don’t come with technical support. 

However, some distros offer a few months of 

telephone support, and business-targeted 

distros (such as Red Hat Enterprise Linux, 

Mandriva Corporate Server and SUSE Linux 

Enterprise Server) come with at least one year 

of technical support. Commercial support is the 

fastest, easiest and most precise way to get 

answers to your questions. If you are looking to 

deploy Linux on mission-critical systems, 

purchasing a maintenance contract is a vital 

addition – you can get four-hour priority 

turnaround, level 3 support (where the kernel 

developers themselves are assigned to fixing 

your problem), easy maintenance and more by 

using an enterprise distro.

Commercial 
support

“If you’ve read all you can and are still 
drawing a blank, it’s time to reach out to 
the community and ask for help.”

magazines or buy books. This special edition of 

Linux Format contains 100 pages or so of 

tutorial content on a wide variety of topics, but 

we print a magazine every month that usually 

contains 20 or more pages of tutorials to help 

you get more from Linux, along with subject 

introductions, interviews, product and distro 

reviews, and features. The advantage to reading 

the monthly editions is that you can slowly build 

up your collection, following tutorial series that 

interest you, and over time you’ll find yourself 

the master of your new Linux box.

Aside from Linux Format, several other 

magazines regularly print Linux tutorials, guides 

and news stories that the fledgling Linux user is 

likely to find interesting. PC Plus prints at least 

one Linux tutorial each month, along with a 

great selection of news and reviews. For a less 

experienced audience, PC Answers prints 

beginners’ tutorials, as does PC Format 

magazine.

If you’re looking for more immediate 

coverage of a specific topic, it’s time to invest in 

a book or two. Four major publishers sell books 

on Linux:

 Apress sells technical books for technical 

readers that cover a wide range of highly niche 

topics. This is not necessarily a bad thing – in 

fact, Apress has made quite a name for itself in 

finding new markets. Unless you’re already a 

well-seasoned veteran, Apress books probably 

aren’t the best choice. 

www.apress.com

 For mastering Emacs and 

many other esoteric topics, 

O’Reilly books are best.

 O’Reilly mainly sells highly technical books on 

niche topics, such as how to build your own 

compiler, how to master Emacs and how to 

program PHP. If you want accurate, well-written 

books on a single Linux topic, O’Reilly simply 

cannot be beaten. 

www.oreilly.com

 Sams sells books primarily aimed at 

newcomers to Linux. It prints the Fedora 

Unleashed and the Teach Yourself series’, as well 

as more complex books such as Advanced Unix 

Programming. If you’re looking to move from 

absolute beginner to intermediate level, look for 

Sams books. 

www.samspublishing.com

 Wiley sells a mix of intermediate and very 

technical books, primarily aimed at existing 

users who want to know more. Wiley publishes 

the Bible series, aimed at more experienced 

users, and the Dummies series, which is aimed 

at people who have little experience with 

computers, whatever the operating system. 

www.wiley.com

The cost of an average ‘small’ Linux book 

that covers a single topic is usually around £15 

from an online book store, and that rises to 

about £25 for a ‘cover everything’ book that can 

teach you a lot more. What you choose really 

depends on how much you want to learn, and 

most people find a mix of books and magazines 

satisfies their craving for knowledge.

Getting in touch
If you’ve read the documentation, checked with 

magazines and books and are still drawing a 

blank, it’s time to reach out to other members 

of the open source community and ask for help. 

Very few people are naturally good at asking 

for help online – most of us ask the teenage kid 

next door, the son-in-law, or someone else 

stereotypically well-trained in the secrets of 

computers. It’s a shame, as the forums that 

have grown up around the open source 

community is a great place to get answers to 

your questions. 

But it’s important to remember that these 

people in the community aren’t paid to help, 

they aren’t trained to help and they aren’t 

related to you: any help they offer comes from 

goodwill, so it’s important you do your best to 

be nice to them. If you want to ask a question, 

follow these seven simple guidelines and you’ll 

give yourself the best chance of it being 

answered:

1  Read the manuals first, and if that fails, 

search the web. If your question has a very 

obvious answer that you could have found in 

the man page or by running the most basic 

query on Google, you can expect the rather 

abrupt answers “RTFM” (Read The Fine 

Manual) or “STFW” (Search The Flipping Web). 

These are meant to be a little insulting, as the 

person clearly thinks you haven’t actually tried 

to answer the question yourself. Keep in mind 

that a lot of these people are naturally very 

blunt-spoken, and don’t mean to hurt your 

feelings.

2  Don’t ask to ask your question, just ask. That 

is, rather than saying, “Is this the right place to 

ask a question about Perl?”, just go ahead and 

ask the question. If you’re in the wrong place, 

you will be told.

3  If your question starts with “can I…?” it’s 

probably best you don’t continue. If you want to 

know whether something is possible, the 

answer is “try it”. If it doesn’t work, then either 
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If all else fails...

If you’ve tried the forums, tried IRC, called your 

commercial support line, searched the web, read 

the manual, bought the O’Reilly book and still have 

problems, clearly it’s something quite serious! 

When you get to this dire state, there is still one 

option left open to you: write in to Linux Format. 

Each issue we print (and solve!) the trickiest of 

reader questions to guide readers through 

installation, configuration and maintenance of their 

Linux computers.  Our team of experts tackle all 

sorts of questions, such as how to install modems, 

how to configure your mail server and how to set 

up a secure virtual private network to 

communicate from home to office. If you have a 

general Linux question, drop us a line at 

lxf.answers@futurenet.co.uk.

If your question is 

specifically about system 

administrations 

(databases, web servers, 

and so on), email 

sysadminqa

@rackspace.co.uk to 

ask your question direct 

to our on-hand expert 

from Rackspace. All the 

same tips for asking 

questions on IRC and message 

board apply here: the more 

information you provide, the 

more easily we can help you 

solve your problem.

“If you are using a laptop and have a 
question, the best thing you can do is take 
it to your local Linux user group.”

it isn’t possible (in which case you’ve saved 

everyone’s time) or if it is possible at least you 

can show some effort on your behalf when 

asking the question.

4  Don’t force people to prise information out 

of you like a clam. Let them know your problem, 

what software you’re using, what hardware 

you’re using,  what you expect to happen and 

what has actually happened. If you’re running 

an unusual Linux distro or a very old computer, 

say so. If the problem only appears now and 

then, say so. No one can help you if you simply 

say “KDE crashes” – they need to know whether 

you compiled KDE yourself, what made it crash, 

whether it crashes by itself or whether you 

clicked a button, and so on. It’s also very helpful 

if you can tell people what manual pages you 

have read and what search results you got 

when you tried looking up your problem on 

Google.

 IRC is a good place to find experts waiting 

to help with your questions, but it’s best to 

go online after 5 pm New York time so that 

everyone is awake and talking.

5  Be grateful when they help, and grateful if 

they can’t. If you’re writing an email to a mailing 

list, “thanks in advance” goes a long way to 

showing that you’re a polite person.

6  If you get an answer you don’t understand, 

go back to Step 1 by looking up the parts that 

confuse you, both in the manual pages and on 

Google. Usually you’ll be fine, but if not it’s OK 

to ask for clarification – as long as you can 

show that you have done your homework.

 7  If you don’t get an answer, the people you 

are asking may not know it. In this case, it’s 

pointless to ask again and again until someone 

responds with an angry comment; instead, take 

your question elsewhere.

Now you know how to ask questions, it’s 

time to look at where to ask them. There are 

three places you can usually find help: message 

boards, mailing lists and IRC. 

Amateur experts
Message boards – often called forums – are 

websites where you post questions for others to 

respond. Usually you will be asked to register 

first, primarily to discourage troublemakers. 

More often than not you will get responses back 

from several people, sometimes providing 

complementary answers but sometimes 

offering different solutions to your problem. The 

Linux Format forums (at 

www.linuxformat.co.uk) are full of people who 

are capable of answering questions of all types, 

including real beginner problems. Another great 

site is www.linuxquestions.org, which also has 

a number of people ready and willing to help at 

all difficulty levels.

Usually it takes about a day to get sufficient 

response to your question that you’ll be able to 

do what you want, but if you want a more 

immediate answer you can try Internet Relay 

Chat (IRC). This is an interactive text chat 

environment where you can join ‘channels’ of 

users who focus on specific topics, ask 

questions and get immediate answers. However, 

getting the best answers from IRC requires a bit 

of thought as to which IRC network to connect 

to (there are several, and usually have 

overlapping channel content), and also the time 

of your connection. IRC networks are large 

groups of interconnected servers that allow 

people to connect to a chat server near them.

There are also several different network 

groups, such as Dalnet, Efnet, Freenode, 

Undernet and more. Of them all, Efnet is usually 

the best place to check for general questions, 

but it’s also one of the hardest networks to 

connect to because its servers frequently go 

down. Freenode hosts a number of official IRC 

channels for various Linux projects, such as 

#KDE, #Gnome, #WineHQ and #Bash, but with 

all of these networks your best bet is just to 

take a guess at the name of the channel, such 

as #linux, #linuxhelp or #php.

The last place to look is on mailing lists. 

These are project-specific group emails where 

you can email your question to the group and 

have them answer it. Mailing lists are somewhat 

tricky to use, because they invariably have very 

rigid guidelines (be sure that you’re not sending 

your email in HTML format!), and you often 

need to subscribe to the mailing list to get an 

answer back. Subscribing is usually easy, but it 

means you can expect to receive everyone 

else’s questions and answers along with your 

own. If there is a Digest option, we recommend 

you use it. This will group all the emails together 

and send them en masse, either once a day or 

once a week depending on how popular the list 

is. You should be aware that many lists – 

particularly the general user lists – are 

extremely popular, and may receive thousands 

of messages each day.

Many mailing lists actually have archives of 

their emails stored online, which you can search 

for questions similar to yours. Unless you’re 

encountering a real corner case that no one has 

come across before, the chances are that 

somebody somewhere will have already solved 

a similar problem.

Face-to-face help
Everything covered so far has been possible 

without leaving your computer chair. You can 

subscribe to Linux Format, you can buy books 

from Amazon, send email, all without really 

lifting a finger. Now it’s time to go outside and 

greet the wider world by visiting a Linux user 

group (LUG). These are independent groups of 
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Report a bug

No software is perfect, even if it is open source. 

Sometimes a coding error can cause problems, or 

sometimes you manage to find something the 

developers hadn’t thought of that causes a 

program to crash. But we cannot say enough times 

that the chances of you finding a legitimate bug 

are exceedingly small: some of the Linux software 

has been in continuous development for more 

than 20 years, tested by time and hundreds of 

thousands of people again and again until any 

bugs that remain are exceedingly obscure. 

That said, if you think you have found a bug you 

should do the right thing and try to report it – 

hopefully someone will look into it and be able to 

fix it for others. If it is determined that the bug isn’t 

real, at least you tried.

The first thing to do if you think you’ve found a 

bug is to figure out how to reproduce it as simply 

as possible. If you can get Firefox to crash on a 

given site every single time, that’s great; if you 

need to go to several sites in sequence, press a 

certain key combination, hold down Ctrl+Alt+Shift 

and sing the part of Susanna from the Marriage of 

Figaro the chances are the developers won’t be 

able to help you. 

Once you have a reproducible test case, discuss 

it with others on IRC, mailing lists, message boards 

or wherever you feel appropriate. It is important 

that others be able to verify the bug so that you 

know it’s not a problem with 

your configuration.

Finally, once others have 

verified your bug and you 

have made the test case as 

simple as possible, it’s time 

to submit it to the 

developers. Most open 

source projects have an 

obvious way to submit 

bugs, such as 

http://bugzilla.mozilla.

org for Mozilla and Firefox 

and http://bugs.php.

net for PHP. Once you 

are on there, search for 

bugs like yours to make 

sure someone hasn’t 

submitted it already. If 

you pass that final test, 

submit your bug. Let 

the developers know 

what software and 

hardware you are using, 

what you tried to do, what you expected to happen, 

what actually happened and which other people if 

any have verified the bug. Be sure to include your 

email address so that the developers can get in 

touch with you if needed. 

 Each issue of Linux 

Format prints a full list 

of Linux user groups 

 If you can’t write documentation or code, 

you can still help out by submitting helpful 

bug reports.

Linux users that meet up in universities and 

pubs across the world to chat about open 

source software, offer training and exchange 

ideas. If you are using a laptop and have a 

question, the best thing you can do is take that 

laptop to your local LUG and ask them to have a 

look – we can almost guarantee that they will 

be happy to help solve your problem right there.

Many towns and cities in the world have their 

own LUG – the UK alone has more than 80 at 

the time of writing (see Linux Format for 

locations) – and you can find a good list at 

www.linux.org/groups. If you’re based in the 

UK, there’s a better list of UK LUGs available at 

www.lug.org.uk.  LXF
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ESSENTIAL READING FOR
EVERY ISSUE OF LINUX FORMAT BRINGS YOU:

  A DVD packed with the best software   Detailed, expert advice

  Wide-ranging tutorials for all ability levels   In-depth reviews  

  News and comment from the community   Open source features
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LOG IN NOW!

ALL LINUX USERS...

Linux Format isn’t just a magazine – you’ll find us online 
too at www.linuxformat.co.uk. Join us at one of the 
friendliest Linux websites on the net for: 

 Forums – tips, help and discussion from other readers
 Exclusive newsletters, wiki and LXF Team blog 
 Magazine archives – download LXF articles and tutorials

www.linuxformat.co.uk

AVAILABLE 
FROM ALL GOOD 

NEWSAGENTS 
OR SUBSCRIBE 

ON PAGE 118

ESSENTIAL VIEWING FOR ALL LINUX USERS:
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The light-speed guide 
to learning Linux

Hate Vista? Bored with XP? Linux is the future: it’s faster,

has more features, and is completely free!

Step-by-step walkthroughs
 Installation  Web and email  OpenOffice.org

 Photo editing  Instant messaging  Games

 Watching DVDs  Troubleshooting and more!

DVD INSIDE!
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